To our customers,

Old Company Name in Catalogs and Other Documents

On April 1!, 2010, NEC Electronics Corporation merged with Renesas Technology
Corporation, and Renesas Electronics Corporation took over all the business of both
companies. Therefore, although the old company name remains in this document, it is a valid
Renesas Electronics document. We appreciate your understanding.
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Issued by: Renesas Electronics Corporation (http://www.renesas.com)
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Notice

All information included in this document is current as of the date this document is issued. Such information, however, is
subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please
confirm the latest product information with a Renesas Electronics sales office. Also, please pay regular and careful attention to
additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website.

Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights
of third parties by or arising from the use of Renesas Electronics products or technical information described in this document.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights
of Renesas Electronics or others.

You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of
semiconductor products and application examples. You are fully responsible for the incorporation of these circuits, software,
and information in the design of your equipment. Renesas Electronics assumes no responsibility for any losses incurred by
you or third parties arising from the use of these circuits, software, or information.

When exporting the products or technology described in this document, you should comply with the applicable export control
laws and regulations and follow the procedures required by such laws and regulations. You should not use Renesas
Electronics products or the technology described in this document for any purpose relating to military applications or use by
the military, including but not limited to the development of weapons of mass destruction. Renesas Electronics products and
technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited
under any applicable domestic or foreign laws or regulations.

Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics
does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever for any damages
incurred by you resulting from errors in or omissions from the information included herein.

Renesas Electronics products are classified according to the following three quality grades: “Standard”, “High Quality”, and
“Specific”. The recommended applications for each Renesas Electronics product depends on the product’s quality grade, as
indicated below. You must check the quality grade of each Renesas Electronics product before using it in a particular
application. You may not use any Renesas Electronics product for any application categorized as “Specific” without the prior
written consent of Renesas Electronics. Further, you may not use any Renesas Electronics product for any application for
which it is not intended without the prior written consent of Renesas Electronics. Renesas Electronics shall not be in any way
liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an
application categorized as “Specific” or for which the product is not intended where you have failed to obtain the prior written
consent of Renesas Electronics. The quality grade of each Renesas Electronics product is “Standard” unless otherwise
expressly specified in a Renesas Electronics data sheets or data books, etc.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual
equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots.

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support.

“Specific”: Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or healthcare
intervention (e.g. excision, etc.), and any other applications or purposes that pose a direct threat to human life.

You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics,

especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or
damages arising out of the use of Renesas Electronics products beyond such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further,
Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a
Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because
the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system
manufactured by you.

Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all applicable
laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS
Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with
applicable laws and regulations.

This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas
Electronics.

Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this
document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-

owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.
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PM+ (0 H 45 #E2%) /] DLL 34 hn#k CC78KO0S, ‘& 1] LLE Windows 98/Me/2000/XP X, Windows NT
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AFAY T CCT8KOS MU 2B I IT A (LA IRLRE, LAA A TF AR5 vh BB 7
2.1 EHREERNEAN
C ik >R 2-1 A BT R 3RS

F2-1. CHBFMRM SN FLFAF K

B BAERS PSS AR
PC-9800 %71 H 3 Windows CD-ROM | 37#F Windows ki 2225 7730
(98/Me/2000/XP/NT 4.0)*
IBM PC/AT™ K FHe 7ML H 3¢ Windows
(98/Me/2000/XP/NT 4.0)*
P Windows
(98/Me/2000/XP/NT 4.0)*
HP9000 #5%1 700™ HP-UX™ (Rel. 10.10 and later) CD-ROM | cp @4
SPARCstation™ ) Sun0S™ (Rel. 4.1.4 and later)

Solaris™ (Rel. 2.5.1 and later)

W WREELE Windows SEE AT C gwidds, WAUEH PM+. WIRAEH PM+, i LI{E DOS 7R
£F(Windows 98/Me) F a3, miar 242377 (Windows NT 4.0/2000/XP) F 25 C 4niF s,
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2.2 %k

2.2.1 Windows 4 223
BN A () CCT8KOS U2 B MUK A W fn R .

1) JA 3) Windows
J EHURANE v A HL I 5 3 Windows.

(2 W B IR

¥ CC78KO0S MM AR AN T HLH BK 5 #%(CD-ROM Bz #8) b . 3R ¥ B3l R 3. MR B
NS Y

AL N REETRRRE A3hEE), AT CC78K0S Itk i SETUP.EXE 04t

(3) SCAEHIA

14 1] Windows % VB T 8845, 7% CC78KO0S HEM ik i s b2 5 B4 3 8 T4 F .

BRIV S R, B9 2.4.1 Windows JiiAs H 451 .

2.2.2 UNIX MRAH)Z3:
223 UNIX A B R R o 3223 H 5% i /nectools.

(1) Hx
FxEN.

) H ki #%
HEN 2 H %o

%cd /nectools

(3) FITF AL R AR
¥ CD-ROM Ji\ CD-ROM I 58 356 FHFEHE

(4)  XSCAFHAT cp 4, I CD-ROM A & HISCHF(iE 6 IA CD-ROM L2 3] CD-ROM YK Z) 25 H1)

F¥t/nectools/bin 8 IR E AL H AR
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2.3 AR

2.3.1 %3 Windows RAE
A 2 SR EAT W 8 S I 2238 . e e 36U RN CC78KOS [R] I 422

2.3.2 &I UNIX fRAE

-y JEIU (f]: -y/nectools/dev) 572 d# SCAFII H 3%, k35 DLgn B s BT 4% 203 S &2 1 3 A B
Fd (#: /nectools/bin) .
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2.4 HFEH

2.4.1 Windows KA B R4
Windows FR 458 B AR TE H s J2“NECToo01s32", 2238 H s I SCR SR, 1 mire e 72
HT LR IR 2 A 22 H e AT PM+HAT MAKE $R4ERT, AHICIH T H(CC78K0S, RA78KOS)tH#
WAL R XA YRS A H .
AT B E AR iE F St 2 “NECTo0ls32”, X ZBRINIREF G FR, 2 223 I BA B 1%
Kl 2-1. B4

NECTools32\
bin\
ccT8k0s. cxe, SRS T BATIE LA
cc78k0sp. d11, etc, PMJMTES 1LHDLL
inc78k0s\
* h BAAERE s S
Lib78k0s\ P2 (4 )
cl0s#. 1ib B (A i R s EE)
s0s*, rel MBI H el
sre\ecT8k0s\
— bat\ "
mkstup. bat R S BRRFTI S SSAT AR S A S A
%, bat
E— src\
cstart*. asm KSR PR o
Tom. asm ROM{E AP0 ST A
*, asm SR ERHE Sh Ak Mk sc
— Tib\PE2 (Gl 550
clOs*. lib P GBAT I MR SRR
s0s*. rel JaY-ipcladar s
— smp78k0s\CC7BKOsY
prime. ¢ AT P I
sample. bat Bl G Atk 2L T
readme. doc
1k78k0s. dr SR E B
hlp\
cc78k0s*. hip AR

" 1. XA ESCAEAEYE PM+r AT . LR SCfF L BEAE DOS #2754 (Window 98/Me) sy 412
ZRFF(WindowsNT 4.0/2000/XP) iz 4T .
2. Lib78k0s HtH it sh I RERZFA sre/cc78k0s H 3w (1 )8 S FE AT e L e 4 MR Rl (o Gt SR A
BPIFREAE R T, WISCE srelec78k0s H i ISR F o BT HE AL B SCA A3 20 R0 G S A7 IRAE
src/cc78k0s, il lib78k0s HstHE T4 .
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bin/
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ineTBkOs/
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s0s#. 1ib B H B AT
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— bat/
mkstup. sh AR SR ARAF I IR St Ak £ S
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s0s#*, rel VSRR T s s
— smpT8k0s/cc78k0s/
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sample. sh BTG R AN B
readme. doc
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Lib78k0s H 3% 11 J5 S5 B A ZE AT sre/cc78k0s H 3 (1) IR sh g BN 22 & 52 e AH R o 4n S )3 sh 1)
MBS T, WA src/cc78k0s H sk b HIVEFE o H T b A # SO 15 30 BV G SC A A7 A
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2.5 HERE

2.5.1 ## Windows R4
TN S EI RO FE UL AR o

(1) JA 3 Windows
H EHUFIANT v 2%t HL I JE 3 Windows .

2) FIIF<EEHIAR> % X
s Taa] v, vePE (B[R], 7T < HIm >

(3)  FIIT <IN ImE R >
AE <P T 1 [ I s ER R P B RS, 3T OT<iS I sl SR A e Jes > 11

(4) MK CC78KOS

M <% 0 s B AR T M > IR << MR e B 10 R T >> WO K BOpE e 3 B K Tk B “NEC
CC78K0S/78K/0S C Compiler Vx.xx” , [ SUMBRIEHM . M<RERELL>% 5, Hii[Yes]
L

(5) A S
{fH Windows PR BIASSE, MHINZEERIEN X OEBMER. ST, 5% 2.4.1
Windows iz A H 3k £5 14

2.5.2 #HI#E UNIX i
A rm ar MR AE 2.3.2 223 UNIX B H &2 Hl i SoE
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2.6 HIEEE

2.6.1 FEHL (PC-9800 Z&FIFI IBM PC/AT 3&HL.)
CC78KO0S 1 LLbFE 32 £, FF HAFHLE i386™CPU Sy HE mi A (B [i54T
T H DOS ¥ g #s52 ik 32 M ab B, B A& &7 UL N EE R4 LigdT.

Windows 98/Me/2000/XP/NT 4.0
Windows 98/Me R DOS #7474
Windows 2000/XP/NT 4.0 F 6y &3R4

2.6.2 HELE
3 EWS Fll DOS $#/R%F (Windows 98/Me) it & HE/R T (Windows 2000/XP/NT 4.0) #AFE LT
B .

F2-2. HERE
PATH ot 58 G PR K T AT SCAF TR H 3% e
T™P e G I i SCPRRR H sk
H% PC-9800 R IBM PCIAT #EHA ).
LANG78K RS R e DU AR (2 AR .

sjis  Shift JIS (Ekik PC-9800 %741, IBM PC/AT #%¥, #l HP9000 %% 700)
euc EUC (IRilk SPARCstation)
none R T i

INC78KO0S FRE IR bRE L R H S (RS EWS ZRTHD .
LIB78KO0S e H X (X EWS Z20FHERD .
SE i B

£%} PC-9800 711 IBM PC/AT %

PATH = %PATH%;C:\NECTools32\bin
set TMP = C:\
set LANG78K = sjis

£%F HP9000 %7%1 700 #1 SPARCstation

i i csh (1451 1
set path = ($path /nectools/bin)
setenv LANG78K euc
setenv INC78K0S  /nectools/inc78k0s
setenv LIB78K0S  /nectools/lib78k0s

1# ] sh (K411

PATH = $PATH:/nectools/bin

LANG78K = euc

INC78KO0S = /nectools/inc78k0s

LIB78K0S = /nectools/lib78k0s

export PATH LANG78K INC78K0S LIB78K0S

2.6.3 CRY4ER
TR TN EHFEMNE. U T 46 PC-9800 Z 4111 IBM PCIAT FRZNUKI SO . 222t it
C& T H x5 MR STR 4148,
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TR S A AT UNIX AN o

R2-3. AHMHURGEH( = TRETRT)

Hzx4 i i
BIN¥ cc78k0s.exe ey
crsosmsg | felscre
| wwpscee ]
ar | pLL ot
INC78KO0S¥ xhE? PRAEFR 7 R B Sk S
SRC¥CC78KOSY¥BATY® 2 mkstup.bat JA BB TR R S b Ak B S A
reprombat | 98 romasm ]
ebat®c | R AR S Gy
SRC¥CC78KOS¥SRC cstart*.asm % * JA SRR Y5 S
rom.asm ROMization 12 A5 SC A4
*asm ™ ° PRl B B IR S G4
HLP * hip TEERH B S

WE S R 10.2 L3CH(UL6655E).

FI S5 P AR B SCAEASBEAE PM+FR A o A 0 U5 S 20 16 5 A PR B S S04
2#% 8-1 BAT BRNE.

*=B|E|N (B: $REMXE, E: FREWNAEXE, N RAEHPERTIE) .

Z#3% 8-2 SRC HFEAE.

a s wbnhe

P FM U16654CALVOUM 32



B2 AR 2

2.6.4 FESCH

33

SREESCAF bR AERE . IBAT I Z AR Sh B RE ALK

R2-4 7 T HRA T

F2-4. BFEH

Hx4

BEiES

SCHEAEI

LIB78K0S¥

clOs.lib

clOsr.lib
clOss.lib
closf.lib

P GEfrm PR = !

sOs.rel
sOsl.rel
sOss.rel
sOssl.rel

S B BIRL IR F b S 2

HFA U16654CA1VOUM




025 7 BBA R

E L mAREPERAIAT.

lib78k0s\clOs<float><pascal><model>.lib

<float>
None ARifEFEFZATIN ZIPE (B3R 5T H2 7 I i A Al H)
f IF R R

<pascal>
None i FH % 3d ik £ 4% 11
r £ pascal BEEHE D (FBEHmIFIEI -ZR)

<model>
None % if f5i7iy
s A A Y

T2 aARshBIREK R .

[ lib78kos\sos<model><lib>.rel

<model>
None % if f5i7iy
sm PRSI

<lib>
None  AAf FHARAEZE R %k
I 1 FH BR U JEE R KL
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AFFH CC78KOS Fil RA78KOS I g F Fp (i At SR ik s 135 B e X AN i e o

bR b, % prime.c' IXAMFEGIRR 7% A T IR (0 5 AT e B BE A IR, AR AT LGRS
g AER: (WM A FEBIREFRIOAROCTERL)

18 T 7 PC H1 9800 F41F1 IBM PC/AT RAFKANL EWTHAT PM+. =T HARTL S KNS, kT
WA Ay AT R IAT i PR B R (5 RS 2.2 &75K).

3.1 PM+

AR T 7 PM+ CC78K0S B 821, PM+ LG 7E RA7T8KOS VL4 FE /7 22 30/, IR 7E PM+
HH a3l CC78K0S, 45| CC78K0S H ) CC78KOSP.DLL &) A& % 3t

3.1.1 CC78KOSP.DLL (47 & (T EzhasdERE M)
IR T B I Bh AR S, et CC78KOSP.DLL, 57 . WINDOWS 98/Me/2000/XP 5% Windows
NT 4.0 &% FI{) PM+91iz4T 78K0S %71 C 4ifids (CC78K0S) .

3.1.2 PATHIFABE

XA PM+3RGE .
SRR CE PR, ARIHERAE RS A B ORI . (SESCRRIH SCRR WINDOWS).
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3.1.3 CC78KO0S ¥k EEH

(1) B®IWKHLEHE
CC78K0S C % 1% 28 2340 h ) 1L B Bh 23 82 30 DLL SCAEEAE PM+Hh R [Tools]3E #h 3 in“Compiler
Options..." i,

(2) <Compiler Options > XI{EHE
15 PM+t, 1E$%[Tools] T fI[Compiler Options... ]38k % DLL T i 50 ¥ B I fg .
< Compiler Options ¥ iHHEM T FT 7R

Compiler Options

| MemoryModel | DataAssign | Optimize | Debug | Ouput |
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(3) <Browse for Folder >X{iEFHE
#i.< Compiler Options > X iFHEH, 4 #iiH{ Browse.. el BB E 7RI, £ TR FARHEHE. 7EAXE
HE T RSP

o WHIIHIRIE

o HARBRE O H A%

o CGRSCIERBRIC A i A
o HHIRIIR IOt S

o A RS ik A
o TRALBBIZSCIFA 4%
o i SCiR AR

Browse for Folder |

Include Search Path

C:AMECT ools3@hwark

1 Inc7Ekd 4]
(] Lib78k0
{23 Lib78k0s

----- 1 Lib7gka

I:I Setup
-2 Smp
F- Smp7aki
F-C0 Smp7akis

-0 Smp7akd
=-{3 Src

{Ed57E S HOCIR it Browse... | L, £ B FHIXHFHE.
XU AE R G
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HH % T H Sc H 3
A S (*.pec)

ParamaterFile

Loak, i I |

wiark,

File narme:

I

Open

Filez af twpe: IF'arameter files [*.poc)

[

Cancel
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3.1.4 <Compiler Options>¥iEHE i B &%
i <Compiler Options> i TEHE 54N 45 o

Compiler Dptions Ed |

Extend | Others I Startup Routing
Preprocessar | tdemony b odel I [iata Azsign | Optimize I Drebug I Cutput

Define b acral-d] :

! =

Undefine i acraf-u] :

=~

Include Search Path[-] :

j Erowse... |

Command Line Ophions

| =
/ I
/ IEIK I lEanu:eI | &plply | H%Ip |
(IR e diedl IVRTEE il IAREE il 5 Bhi et

[OK] #:4
B2 A ARHE TR BB LI, IF H 4k H<Compiler Options>XJilKE . T B e Y5FL S 2 i %
T —ANESCME, A XSGR U & R IX AN SO BT BEE Y . R B B Hh e I, TR A I L ik
TR A PSR e SCE T

[Cancel]#4
BB FIEIA S AR, I RMIXANIEHE. ESC M [Cancel[#HA & FIFE/EM, A& HRrEmA
W TEAE

[Apply] #4l
NGRS 1% A SR X AN 2 A R
I P o A5 HE Hh B R P 25, <Compiler Options> 3t 1 HE 4k 48 75

[Help]#&
FITFRA A UAE )35 B 34T
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o AT
SRR I Ao
{E<Others> 3 A <Other Options>+fiy A I 544 1 LI ) S 1K
fESURMC BB EERTR . BME CCTBKOS MBI CHE IR (I, EFHHER
i, ), ERAORR AR B AR, g
MR AU P LR DR BRI, P LI RAATA o Sl

o GiFARIEIN B E
G P A L BRI LUR (19 ANFRRE DO SR B L o ot U HE_E TR N PR B 28 0 n] DA ZR R — A
BE S

RUSEE N E NN
Al A R
Kl ) 73 i
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(1) #EF“Preprocessor” i IR H

Compiler Options

| MemoryModel | DataAssign | Optimize | Debug | Ouput |

o EE[]:
i B -D METURAR SE IR A ARAE 4%, AL HERT )
XKL, FTRAS, 7RI 2 AN E e

o AREE[-U]:
i N2 A HE PR 22 SCHI P -U SR THORAR AE
T RARRRUL, FTRAS, "R 7 2 A% E o

o WEARBI[H]
RIS HE N ) P9 P R - T 2 D A 3 SRR H 3
FTELS, oA E 2 H Ko
A mT AT [0 S LR i H %
ARESR AT AE N B2
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(2) #EFEEMemory Model” B f R

Compiler Options

arratl ezl |

o A [-sm]:
e P AT IRAE S N A IR IR s — AN ET T U A

o JREEASHIC
WERFEE T-SM LT, TR Y ISR, IR RIEHE,
SRTTIE A e F L, BT DA RS ORI AR B (K A7 A DX
JUESENE LR ARIE IR, B LIS B R AT LLERAT

o XIS
O KR4 1E _ pascal JER, K& T Varargs[-zr]
RS IEHER TR E-ZR LI,
P FEIRAE [-zd]
e EAE KA 5 -ZD LT
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®

43

% Data Assign” IS TH

Compiler Options

Frhh kA By il £ SADDR [X ik
JEH % IERE R R 2 -RD 1ETH .

FHER 42 B T LAE 53 I ) saddr DA g A AR B A

KA 2 2] SADDR X,
3P Z R IR HE R AR 2 -RS I,

FH B3 2T AT LA PR 43 C 21 saddr DX A AR B2

¥ JR AR i3 i #1) SADDR XX A 5 2]
T HZ SR HE RS 2 -RK 2B

FHER 42 L T AR $E53 iE 2] saddr DR Jy s A BRI

M MSB FFih 5 Bifr ik [-rb]
JEH % ERE R R 2 -RB IE T

SERE AR D3 FT L [-rc)
e %S ERE R R 2 -RC LT,
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4)

EFE“ Optimize” I I S TH

(@) 7E[Group:] Ttk Integrated Recommendable Optimizing Option” it L4 T :

Compiler Options E3 |

Extend I Others | Startup Routine I
Preproceszor I termon todel I [ ata Azzign Dptimize | Debug I Output

Giroup

Inteqrated Becormmendable Dptimizing O ption

Integrated Recommendable Optimizing Option
) Erec Timelrg1]

£ MefaulEaea]

€ Code Sizeltaed]

Carmmand Line Options

I

] Caricel [ | Help

LR A AL I

“Integrated Recommendable Optimizing Option" 25 &AL IE THEAR i B SR BEATH0AL, 1 JG 7 Sl
ZHRE, XA SEETTERE . A=A ED: “Exec Time [-gx1]", “Default [-gx2]"#
“Code Size

[-gx3]". & B IME X r:

Exec Time[-gx1]:  -QX1 &I, FEPSTHEHEN, HIEEZI,

Default[-gx2]: -QX2 BT, MPATRCRFNNS B IID i R AR T BN, kR AN E T,
Code Size[-gx3]:  -QX3 M. HEXNZEWLHE, HEFZIN.

M P FH U16654CALVOUM 44



O 3 E GRIERNERIE R

(b) FE[Group:] Fhr3gH %R Char Expression Behavior, Automatic Allocation” BFHIEHE U T

Compiler Options E3 |
Extend I Others | Startup Routine I

Preproceszor I termon todel I [ ata Azzign Dptimize | Debug I Output

(E{I B | E=prezsion Behavior, Automatic Allocation

— Char Expreszzion Behavior

v fzzign char without Sign Expand
% “ariable[-qc1] " Varable+Constant-go?)

[~ Change Plain char to unsigned char-qu]

—Automnatic Allocation
[T Use SADDR Area for norec+Register Yariable[-gr]

[~ Use Register for &uto W ariable[-gv]

¥ Jump Optimization[-gj]

Carmmand Line Options

I

] Caricel [ | Help

o TRIRIEABIE
TR TR AT SV
HrPZILIEMERSR E-QC L. (APATEAMIRTHID
T A T L R AE AN AT AT A 10 P AP R
K Joks s A5 RSN TEAT 5 74T R -qu]
1 H i S IERER R E -QU I

o Az
Norec %+ 37 {7 a8 &= LM H SADDR X3
SR NE R R E-QR £,
H h AR Al 25 A7 2 A% 8 [-qv]
TEHIZ S EHE R 1 B -QV LT

o BREALIL[-q]]
1 FPZ SR HEA SR € -QJ 1L
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(c) 7E[Group:| FH3EHFi%EFE" Optimize Object Size by Calling Library” BFf RIS E T :

Compiler Options E3 |

Extend I Others | Startup Routine I
Preproceszor I termon todel I [ ata Azzign Dptimize | Debug I Output

(E1G a0 L1 mtimize: Olbject Size by Calling Library

¥ Optimize Object Size by Calling Libraries
™ Dan't Calling Libraries[-gl1]
™ Preprocessing fior Function Only[-gl2]
¢ .glZ+Loading/Storing of long tvpe and deshl Crozs Feference Code]-gl3]

" gl3+1 Inztuction Unit-qld]

[ Pattern for 1hyte datal-gl3 Onl)[-qq]

Carmmand Line Options

I

] Caricel [ | Help

o RN HARFE S RN AT AL
M IZ B REHER T E-QL 3BT, I sl ik 4 HIR R E H AR IS5 20 . 4-QLn %Y n
K, HARRE AR 0B, ) I AT 2 it .

o I (I3 Only) (-qa)
o SR H5E-QQ M
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a7

(d) FE[Group:] P M HiEF Others” FHHIAEIIN T :

Compiler Options E3 |

Extend I Others | Startup Routine I
Preproceszor I termon todel I [ ata Azzign Dptimize | Debug I Output

W &ggressive Optimization

% Depend on Order of Expression Ewaluation[-qw]

" fior Speed Assumed a SADDR Amay is in 256 bytes[-qw?2]
" for Speed Azsumed an Aray of Al iz in 256 bytes]-gw3]
" for Size Azsumed a SADDE Aray iz in 256 bytes[-qwd]
" for Size Azsumed an Array of Al iz in 256 bytes]-qwE]

Carmmand Line Options

I

] Caricel [ | Help

o BB
P SRR 2-QW BT, I ELZE DU e L1 s — RIS AR AN (R 524
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(5) #EFF“Debug” KA T:

Compiler Options

o fmHiHRAER
% S EHERAR -G BT, JF HLIE i o S F A AP0 1l Hh A5 B ST iR PM+
¥ [Debug)’kak, HSHATT GEAE<Debug>Xf i HE BEATREA, I HARA it 6T
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(6) #EFE“Output” I FIFTE

(@) FE[Group:] Fhr3EH g %" Object Module File, Assembler Source Module File" B HI R EHU T -

Compiler Options E3 |

Extend I Others I Startup Routing |
Preproceszor I termon todel I [ ata Azzign I Optimize I Debug Output

b

Group ect Module File, Azsembler Source Module File

— Object Module File

Output Path j Browsze... |

1 Create fizsembler Source Module File
Output Path I j BroEe

£ without [ Sounzelal
i with B Sourcelwithout nelude]=a]
5 with B Soureelwith Ineladel ka0

Azembler I phens

Carmmand Line Options

I

] Caricel [ | Help

49

H AR B SCA

N THRE BRSSO i i kA, R4l S HER i AR AR BR 2. T LLAE AT [Browse. . 4L IR SR E -
75 PM+HURE TSN, SURBOABUE B2 4 D4R E .

T8 TG, WA ARSI AE, WL OB AR A RIEAT AL B R BRI AN A, I
MOCAT A K AT AR B

VI g PR RS

T PEEA S EHERALHE-A-SA/-LI LET, T LLIEFE BN ZAEI G P Pl R BRSCA 5 AN
CURES, Wl LLEHE C YR F R &AL, X =i LA X B Bk 4l o AEAL 7
HE L AT R P SR RSO it A, m] LU [Browse. . JHCHUR R € R AR O A4 7K

7 PM+HLURE TIEHIESIN, SOEBOABUE B4 D AR E .

FRE TWSCAFIR, WREXABRARR A A, WHEIROX AN R AR A OREAT A B WUR AR AN AL, Mg
MO E AR IEAT AL BE
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e [Assembler Options[H]] #z41l
R G IR AR R S A48 5 T 4 1B 10
WARB AT TR, WA T8 E T FrA B4 s e WOk 3 T AL B

e <Assembler Options>XTifiHE

7E:<Compiler Options>*} i HE H [f]<Output>15%: H i [Assembler Options[HI[#%# I, 23 HIBLLLTR
X IEHE o

Aszzembler Oplions [ x| |

¥ sze Azzembler commaon ophion

Azzembler Sorce Options

| =

5

Ok I Cancel |

Command Line Options :

o I g AR L I
BEPEXANSTIEMNE, KA e T <Assembler Options> 1f HE H ) 1 i

o LgMARIESCFIE T
A RE 20 1 4% ARV H T GBSO 0T, AR AL L N PR AT R e AL R T4 R
B A AREAIAN = SRHDRERE LTS 2 A L 5 S
BE AEERTAREUEH O « WEIXMHUHA Y MSHOCHERRA (F) , BRAEMIMIAS)
SRR

o AT AATIEIN:
L BT TR S BN TR AE .
LR R X T () 3 435 5 S s 2 i AR B0 -
WA PTG, BEgmR S TEAETC IR A, AT Ll RS =] KREFE.
JITA 0 oL s o F2 A B 2 5 LN 1 7 5 o A 2 7 B S s £ B A X EAE .
PTG 38 TGURN A H V1 0 S TR FCAR I T — o DL 34 R B s
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51

(b) ZE[Group:] T hikfE Error List File, Cross-reference List File” i f S H W0 T :

Compiler Options E3 |

Extend I Others I Startup Routing |
Preproceszor I termon todel I [ ata Azzign I Optimize I Debug Output

E1(I0 /RO tF rror List File, Cross-reference List File

T Create Emor List File

Dutput Path I j Brovse,.. |

= without [ Souneele]
5 with & Sounze]ee]

1 Create Cross Feference List File[-+]

Output Path j Browee,. |

Carmmand Line Options

I

] Caricel [ | Help

o QUEHT RIS

9 FIZ MR AR R -E/-SE KB, ] LUIE R E#E 1 5 (1 LI L HDRIEFZ 18 C SRR P I A 1251
TEALAHE B N R ARBR AR A 2 BHR SR SO AR %42, T LLE R [Browse. .. HE ALK S 5 -
7 PM+HURE TIHIETIN, SOEBOAMBUE R4 DA IE .

FRE TUSCAT G, RIS BRI AL, WHE IO A AR A R UEAT AL B W BR AR AN AE, A
OO A K AT AR B

BRI FIER S [X]

P IZ IR HESR S B -X BT 7141 HE B N AR BR A2 R 48 78 A8 X5 | FIFN SR s g A, ]
PLiE it [Browse... #8036 & -

75 PM+HLEE T FE iy, S BABUE Bk ie 4 Ca R e .

feE TS, WX PRI ST, R BN AR 2 R I T AL B, A RBP4
EE1 O QU St GEL
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(c) 7E[Group:] T thikfE Preprocess List File, List Format” i i A H0 T -

Compiler Options E3 |
Eutend I Others I Startup Routing |
Freproceszsar I b emony Model I [rata Ag=ign I Optimize I [rebug Output

1 Create Preprocess List Fila

Dutput Path I j Erowee... |

=1 elete Eammenthe] ™| Evecute finclidelki

™| Execute fdefinelhd] | Evecute Hineltkl

| Evecute i, Hifder Hinderki | &dd e Wiz and Pagnaltkn]
™ Add Form Feed at End of List File[-If] Columnz per Line[-ha] ; 132 =
Lines per Page[-l] : I BB ﬂ Expand TAB Character[-It] : IE;

Command Line Options ;

(] I Cancel ] | Help |

o QUETIALBEA L ST
AR SEME RS E-P IEI,  FFARURE S B iy ZER Y TRAR BRSO ) R AU A

MBI RE[-ke]

S EE K F 5 -KC HE I
PAT #define[-kd]

WIS IEAE SR B -KD 1.
PAT #if, #ifdef, #ifndef[-kf]

e Z B AE SR A 52 -KF TR
AT #include[-ki]

A %A IR HE K FR 5 -KI AT
AT #line[-KI]

S EAE K F o -KL BT
ISIAT 5 9153 1L [-kn]

IR S IEAE SR B -KN T

TEAL A HE B N R AR BR AR AR 8 FAC BRSO i th i A, thm] LU Id [Browse. . i HIR IR E «
75 PM+HURE TIEHESIN, SUEBOABUE B4 D AR E .

FRE TUSCAF )G, RIS BRI S AFAE, WHE IR A AR A R IEAT AR B W BR AR AN AE, U4
IO AR IEAT AL BE
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53

FEBN SO IR B3 S s 48 DA [-1f]

3 % S EME RS 52 -LF JE I

TIRBCE

RN PIRIEIB B L )5, A& PR e ks Ut o1& .

FHATISEL [-w]:
P -LW S UG AT TR RSO . O T AR TEHE L AT EOH ﬂ?ﬁ%ﬂo

BEUCHIATH [-N]:
A -LL SR TORAR E — U AT H. D 7 S8/ B et 1HE B A5 A H %ﬂ?ﬂfﬁ%ﬂo

¥ TAB 4 [-Ht):
fEH-LT EIHE € tab AT IS B O T S8R EHE A4 08 H , s ﬂ Al
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(7) #F “Extend” NHIHRTHE

Compiler Options

|
|
|
|
|
|

o RSO AL

LY (A ANSI FRifE)[-za)
T L IR HE KT 52 -ZA T T
LA R0 A T I A R I b 3 [z
e Z S ERE R S e -Z1 BT
AR R SR AL B [-21)
JEHIZ SRR SR -ZL M.
TEA TR AE AR L BRI IE T
JaH C++ FRITR, WG TE BT AR 1 P BB B RE [-2p]
EHZ S IEHE R G i -ZP LT .
R LU £E[-zc]
e X EHER R T -ZC I,
A RS HAIR {E[-zb]
JEH %A EME KSR i -ZB LT .
TSP BT
TS IV (6 F TR FR 7 26 PR SO A T R s I T i 2R

JAP T U16654CA1VOUM
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(8) i&F“Others” IHFFTH

Compiler Options

o JURGRIFEAE R[]
HEHZ S HER S 32 -V 2RI

L4 %%ﬁ%ﬂ[—w]:
ﬂ%i T B -W B IR (1 55
i

o ISR H SR
FY =T S I50H 28 HE RN (14 H SR 58 0 I N SCAF A7t H o

o UM
FI -F 3 IO 2 E N (0 48 BR R 2 0 S HOCIE R
HADIRAEI AL o] SHDRER DTS A K

o LAt

D B RIS H 2 ARG AR T, R T A AL S HE
LA AR 2] SRR AT AR LM A 1S
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[Reset] 41l
BT I AN P o BRI T

[Option file read...] %4l
BT IX AL N AL I T (R I T R S

[Option file save...] #4H

A R [OK] S [Apply % 2 Ja X AMZHIA AT R LI B BRI N IEIUE B

GRS E

XA EHE, REIUT AT Hmtox fi  B i SRR, BT ATE 5 DL I AT S IR . AN B AE

R HRE -

HFA U16654CA1VOUM
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(9) #F “Startup Routine” il

Compiler Options

B BAAN SRR IS E g RS HUN, <Startup Routine> X T HE LI &

o MEHIRBhHIRE
PEXAN LR T ] C G AR R AL RIARE R Sh 1L .

o AEPARAEE ) [ 52 X4k
T ST IEME RS RE B P2 A £ [ 5 X Ao

o JAZNBIRE:
SR R BB RE ST 44

o fHAIE
M AIEHER A ] C g s B I bRvEE A
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£ sprintf,sscanf, printf,scanf,vprintf,vsprintf -8 % &

WEHRIXANSLIEHEAE sprintf, sscanf, printf, scanf, vprintf FI vsprintf BRI 2

wFe e T [EASEEA[-sm]:] 5 [Regard All Function as _ _pascal Except Varargs[-zr]] &5, H54
sprintf, sscanf, printf, scanf, vprintf 1 vsprintf 53 A8 48 FH V7 55 S FF U BE .

JE s
R E IS4
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3.2 MGmiFFNEZKIE

3.2.1 M PM+H MAKE
1& PC-9800 I IBM PC/AT 3t &ML Iz 4T 1) PM+H AT MAKE 7 VR I F .
PM+E—ANRAEREE, VBRI RO R T T RMERE R ] PM+AERSIE N R AR
BB E TRERAL B, v DU mdE A . VRSO R, iR AR — RDP R QIR R T .

3.2.2 A3 PM+

TFRIN T AR G2 5, 76| T |[SELI BT LT (P) "h &G NECTools32]5 4, Jf [l PM+
FIFCABFR P27 M BI[NECTools32]3 5 T .

1 Horp HiE [PM plus]at 23 )5 8 PM+.

323 fIgEITE

M LR E B PM+BET— RBTT R 3845

WM TR, EeAE TSN TIEX. T TEX PSR, #iE5% PM+ 510 fR4& B/
F (U16569E).

3.2.4 ZHIFREBMERBIEIEE
T REME TN A SL[Build], 7R LRGN gt 4 A 3h7E MAKE SCFh e T A K s e 1. LR
SE PR IR AE T S AR e
i [Tools] =5 K [Compiler Options... J#%iEkH, 4 HiBl<Compiler Options>X} i AE .
AR AL TR I -QCILW] U ARG K [-oxa]itil 7

Bl 3-1. eIk ks

Compiler Options [ x| |
Eutend | Others | Startup Routine
Preproceszor | temary kodel | [ata Aszign Dptimize I Debug | Output

Group: IIntegrated Recommendable Optimizing Option j

v |nteqrated Recommendable Optimizing O ption

" Exec Time[-gx1]

" Default-q2]

Command Line Options :

-qxa

S

ak. I Cancel Apply | Help |
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S AE<Compiler Options>*1FHE fJ<<Startup Routine>>##48 7T ik $¢ T “Using Startup Routine”&
TEAE, 225 (MR AL B B R R A0 TG I SO 2 BT AT . CRE7R$] <Linker Options>% HHEH )

EMZERETEO T, WA E SR P TG EZ )G

WA E CEBFIRRET, EERS AERE-S I, A5 BN,

JB BN IFR SCRF IR 24 R AS 23 5 W I AR S 1) 44 B

Bl 3-2. FEHABIETNIHHE

Linker Options

N R
I

¥ | Create atack Symboll-s]
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3.25 ZEV[BUILD]TE

TR A B W IR A T

KEFE[Build] 352 T (W [Build] #tnT LASE B3 TREII ST, 83 i T A B .%. Fieill . PM+1) MAKE
IS i B3R MAKE SCHHE 30

B SERUE, S AME B IEHE . R A IS T AE T DA N R A A R S A

2 I BoRE<Output>FH O PR EH RBEEI TEERT, BB « TEXHLK
+.plg”.
3.2.6 MWHMATREFER Gf DOS #7RFFM EWS)
(1) BHERSHCCR

NI IR B CCT8KOS, VLG MERAAE A 24T H 5. WIR C PSCIF ATt f0, W
AT G o AEIXFIEOL R, R C giikds /ER HARBIRICE. (A 5 H%).

>[path name]CC78KO0S[ A option] AC source name[Aoption]
>[path name]RA78K0S[Aoption] Aassembler source name[Aoption]
>[path name]LK78K0S object module nhame[ A option]

4 A TEBRPARME, —EBERESIRKIREIAGEERS MR ERNE R E.
Eik sprintf, sscanf, printf, scanf, vprintf 1 vsprintf STRFZ R IhRE, IS €5
AR M VR R BE A S R MY B R
Eik sprintf, sscanf, printf, scanf, vprintf Fl vsprintf Rz 2 SR, #IRFHEE
HERPREFRZE, 18E C miFSRRWHESIGRE. TR MRS B ARER
USRI BN .

(PESTHEHI BB IR )

4 sprintf, sscanf, printf, scanf, vprintf Fl vsprintf AN3Z &% S ThRERT
1. APREPEE (A-BIETiEE)
2. C 4uiEaR B EESCM (HH-B TidEE)
3. C gk Mt r 1% RUBESCHE (FA-B TR TR SE)

4 using sprintf, sscanf, printf, scanf, vprintf, H vsprin X2 HIh6EE
1. HPRFECH (H-B @&hifse)
2. C SmiEag M MiE A (FI-B IR E)D
3. C fmikss MBI SC (FI-B LT &)

(FEAB ST BB B IR

1. CC78KO0S My# K8 shBlIFEr B A7 301
2. FPREFH B SRR
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R AN ER C UL s1.c LA FE PR ICH s2.asm 111 (15 12 0 i Bl o

#iE

C>cc78k0s -c9024 sl.c -e -a -iC:\nectools32\inc78k0s —yC:\nectools32\dev -sm16
C>ra78k0s -c9024 s2.asm -e -yC:\nectools32\dev

C>Ik78Kk0s sOssl.rel s1.rel s2.rel -bC:\nectools32\lib78k0s\cl0ss.lib -s
-osample.Imf -yC:\nectools32\dev

e ZAgPEIE N, R . KSR CKNEABUR « HEAERIES NI
i1 3 LB G R T

-V BT, b IR AR -y BB AT DRSS AF T A0 . PEANME RIE S WA 5 EmEdit
Tifl RA7T8KOS L4mfR /AR /EH - FM (U16656E).
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(2) BEHZSHCU

TEJR BN GRS« TG BB RL S I N T 2 AT, R A A

[F) PR KA i W Al e R 2 IR
MAEHZECCE, AEfr AT E S EOUH I BOE IE I

EE SE A RS PM+ I E RKIEE -

NGRS ORI s g LR AIE R T

AT A A R s TR R R, A

>[path name]CC78K0S A-F parameter file name
>[path name]RA78K0S A-F parameter file name
>[path name]LK78K0S A-F parameter file name

N AME R

BilF C>cc78k0s -Fpara.pcc
C>ra78k0s -Fpara.pra
C>lk78k0s -Fpara.plk

FEFF 03 A S HOCIE . BRI AZAE i AT o8 I ORI ST R8T LS NS HOCA T

TR R QIS HOE I — A S

(para.pcc [ %)

-c9024 sl.c -e -a -iC:\nectools32\inc78k0s -yC:\nectools32\dev -sm16

(para.pra [ A Z%)

-c9024 s2.asm -e -yC:\nectools32\dev

(para.plk [N Z)

sOssl.rel sl.rel s2.rel -bC:\nectools32\lib78k0s\cl0ss.lib -s -osample.Imf

-yC:\nectools32\dev

-SRI, - AR U IR —y S AT DR 26 PFIEAT g . PR RIIE S ILAR5 R ZRiRAHIETI

FRA78K0S ILHAEFSHA I FM #AER(UL6656E).
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3.3 C HmiFsspsmN/md ik

CC78KOS I NI C W E 'S MBS, XSSO ML 5 PR o H AR B

G

G 1 i o> i VR PSR RS, TP AT BOGHE G 5 W AT R A 2. MRS Pk g e 1, 4%
B EL 0T IS () 51 SCA A PREAR BESC A,  AZ ST SCAF IR S ST
WARAT R DG, XMEEOE B W e R G, IF i BURRR IR R AR, AR
BRI A Z A I S F

CC78KOS %y N/t SCAF sty o

R3-1. CHRFBRIIOE

et X4 Eipa BRAIAST
C J5FR i s A o JH C 5905 o C
o A S
< ([Tee'eis o M C PEBEHSC A5  H SC H
o < 11 C WSS I
& o AR P ST
ST o M T ER R IABLLLE C AT Tk M AT | PCC
24N, BATRIR S
H A s pk o THHRIBUE SR EHLEE S E R HLESES ok | REL
ENREE, DS E R
WG PR RSO o W EEAs 11 H ARCRS ASCH WG ST ASM
FE4b 3 1) 5 S « {4#include SCAF—FE I TRAR B i 4 77 A 1 51 36 SO PPL
g *ASCII W%
E X AFN RS AUFE C PFALER ST P A 1) R B FR RS T A R B AR | XRF
& S
BHRA RSO ALY SR PR AT IR B AR SO AF ECC
CER
HER
ERNOIE
X 15 B S o 7 AR IR v ) ST A $nn
o 3 UG IE R AR, SO A S I B RR . IR AT RS, | (S 4)
= VO3 s S
¥ DL DO Fofr SCA AR5 15 41 3R SCAF R A 24 o

CER: L5*.C H—E3 A C R RIIZR I (hgem-SE i )
HER: L*H tfF—E80FA C IR R IR M (e e r-SE &)
ER: 5 CER fl HER Z#MWHABSCAF— Ut C AT IANRSIR O (Hhfe 2 -SE I

LR
ECC: HRIIRSTIAI A EATIESCIA N C IR CHhidig o2 (K-SE 2L 1t D

HFA U16654CA1VOUM

64




O 3 E GRIERNERIE R

B 3-3. C gri¥IS M A/ S fF

SHCCE C IR P BC I

TR BN SCAT

CC78K0S

TGRS AT H bR RS HRSIRICAF A AN SCAF

& WARAT R R, IS4 L Rek A IR SR SO X5 ST
MG VIR GTRBOA SRR RN, I SO ey BB O IS A T RIS, AT
AN I SCAE IR 2 BN ER o
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3.4 PATTFEERMESHLE B

(1) PSTHHBRFER
2 CC78KO0S Jaahh), FFinfs B BnfEihls L.

78K/0S Series C Compiler VXXX [XX XXX XXXX]
Copyright (C) NEC Electronics Corporation XxXxx,XXXx

(2 WITERFR
WERAEG PR RE R AR R, IS A L AE 2 5 J ) DU BOR R, IR AU Ml A R 4

Target chip : uPD789xxx
Device file : VX.xx

Compilation complete, 0 error(s) and 0 warning(s) found.

U RAEGR R RE P R B TR, A g RS A T B i e DU RS IR, PRI
AL A R G

PRIME.C(18) : W745 Expected function prototype
PRIME.C(20) : W745 Expected function prototype
PRIME.C(26) : W622 No return value
PRIME.C(37) : W622 No return value
PRIME.C(44) : W622 No return value

Target chip : uPD789xxx
Device file : VXx.xx

Compilation complete, 0 error(s) and 5 warning(s) found.

WRAEG PRI R R AL — A B ROH R, JOVEAREE 1E, I A ik dsati th —ME B RS G, 105
BEIPRE IR IR R ST
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PR AN A A5 2 ]

C>cc78k0s —c9024 -e prime.c -m

78K/0S Series C Compiler VX.XX [XX XXX XXXX]
Copyright (C) NEC Electronics Corporation Xxxx,XXXx

A018 Option is not recognized -m'
Please enter * CC78K0S --‘, if you want help messages.
Program aborted.

67

FEREABIF T, PO T — DAFAERI G, LS B 1 g s -
DRGSR T RS RO AR T g, ALERE 9 FARRME B P AT LUK B SRR R AT
1o
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4.1 AT

& 43 CC78K0S Fi

£ CCT8KOS L tbmt it o 1 G R ) HARKEER I AF . 3R 4-1 RALTTHESI T RIS Rr AL T

R 4-1. RALFHEL/2)

B Bt Wz Bl
<1>| RSP AT a=3*5; — a=15;
= | <o> | TEIRAERMAS WARTLIFEE | 088 (allb) >0
] 1| (a&&b)—1
BE | ags | dEE, SR RASE Eg PR P RS .
<4> | FAEAEHH TR A7 -
g [<5>| M HER CPU H ks HkR 4 a=a+1; > inc 5% .
E i move 84 kB CFE Vi 1 .
% <6> | M4 WRTERR PR A 154 nT DL I FE A, A P s R 4 4
~ mov a, #0 Ik xora,a ( FEHAR D
<7> | KRB Ao R Bk iR 4 T A BE A R (RIS
<8> | MiBRFIEA M A5 a=b+c; —a=b+c;
d=b+c+e; d=a+e;
<9> | BB AR BRI S for (i=0; i<10; i++)
{
a=b+c;
}
N
a=b+c;
ES for (i=0; i<10; i++)
= {
=
}
<10>| MIBRAAE T4 a=a; — B
1t a=b;iEA) 2 G, a&ATHsI L - Mgk
(a2 — A3t )
<11>| MER$E I a=b;
c=a+d; — c=b+d;
a RE#sIH (a 2P a3 E ) .
<12>| BURRIEAH T EHADT AT Z 00, TR T A A P 45 B 2
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3% 4 % CC78KO0S ¥

# 4-1. AL E(212)

B A {17
<13> | AEABRS B (K3 e (I A ) JRIH AL H O 5 A7 0% o
<14>| sl PR TR
i a*l—>a, a+t0 —»a
§ <15>| PRI AR #illn  a*2 — a+a, a<< 1
L |<16>| 1fitias & 15 Bl (5 17 ae s i) KO W B AP A% 2% o
fltn: 25474%, saddr K38 (I04465E T-QR ML)
<17>| BEEEAAL (-QJ 1EIN) ESEE S AL A — %164
<18>| A1 HE(-QV/-QR/-RD/-RK/-RS 3 J7i) A5 QB LG AT -
TE TSR AT &, <1> 3 <7>IHaPIT.
<8> F|<13>Ll Je<17> F<18>HHATLLSEE T X M AL IR 4 29047
<8> F|<13>I LA AT A e s 4k 8 adk
TR T 3, <14> 3| <15>IRFHAT.
HAETE CWRRT A AR I E N N A S PUT<16>T0. HE, RATEHE T-QR EIK A
Aefd F saddr X35,
KTRACIETIE R, S0 5 & REFERTEI.
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3% 4 % CC78KO0S ¥

4.2 ROM #E#

ROM LM WIIAEAFIAE ROM H1, LIS WIaa (E I/ E R . 7 R GUSAT RIX SEHT IR (E R 5
RAM 1,

CC78K0S &4t T Jash AR yu s, n] LLALERAFAETE ROM HIFR)F . XFF ROM {bkit, 7 ROM i
FJA ShBIFE T LA AT HER 3 S B2 () ROM A4 4 3 5

KT RBIRNELR, SuE20 8.3 Bz,

T I A AR R A7 i 4 ROM

JEENIFE S sOss.rel (4] 1 HHR (A 75 2 ROM AL AL PRI FEIS, mtas il XA rel SCfF; niids
SE T S U A AR HE ) -

421 ##E
TR, S shBIRE . B AR SO AR T e . A sh I RE St B ARFE P A TR 4R Ak Ak
T,

(1) sOsl.rel:  JEEIFIFECHAETE ROM H)
AREARIR LIS VUSRI sy i i s i k.
PR35 _@cstart (7754 242 TTdh .
(2) clos*lib: CC78KO0S ff/mE. CC78KO0S FEI{FAuif LA T #fl,
<1> BiTH %] (Runtime) JE
TEIBAT I R E LA S i L@@, * TR EELLan estart, FF5 BT 2N F_@%4r
o

<2> FRAfEE
_ CTFRIZD SR InBbRUE R 2 FR 0755 S5 Tl

(3) *lib: HI QIR . FERRUERE A FRATAR I CRRIZR) #nid.

ER CC78KOS &Mt T %M B SBIEME. XTRIFIENAT, FHSHE 8 & RIFIR. XT
PERIA0E, W2 2.6.4 FEXCHF.
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B 5 E HmIFEM

MRS C IR ET, LR R, S (S TN R R RIS &, IR AT R AR
AT B

PRIV AT PR 0T AR 2 A P T LR S5 7 S PR DL T O 40 B,
O ELIE 24 (1 5 PR 50T L A R4 55

5.1 ZFEIIIEE
SRk I n] LUE L BA R LR O VAT R R
(1) 4 C iR E B P AT R E .
(2 £ PM+[fj< Compiler Options>5f il HE H1 45 5E o
()  mEBHCTRE.
KT UL LT M gm e E T i e ik, S HE 3 8 wMEFERIEENTRE.

FEG PRI 2 J5 AT DL R i 58 RGO IS E 4, 2 IR BEAT RN, LI s A% 2. 2 ik
T2 6] 5 2P 225 K oK 73 o

il (A FE, B E)
CC78K0SA-c9024Aprime.cA-aA-gx3
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5 W G

5.2 ZmiFEIRHM AR
FE N RPBI G PRI, PLSEHE AR RIS 1 3 L5 AP 7 i B A LR3I

K51, GG KILESR

No| G| P |NP|D|U|-A|]E]|]X]| - |-SA :ﬁj
-R X x
_Q X X
-G x x
-K A X X
D 0 x
U 0 x
-SA x x
-LW A A A A X
-LL A A A A X
LT A A A A X
-LF A A A A X
LI x | A
1
T
[x¥RiE KA B
WA 7 M IR I, AR 3 L7 ) (RS I TG 8
[APRIE A E]
KT 7 1 TR B 2, ST B o (3 BT
[O FRie AL E]

IRV 1) BRI STUMI S L7 1) AR I, i 4 AN B UG
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5 W G

i 1 C>cc78k0s —c9024 -e sample.c -no -g
G IR

B 2 C>cc78k0s —c9024 -e sample.c -p -k
H1F-P TR 2, -K BT

5l 3 C>cc78k0s —c9024 -e sample.c -utest -dtest=1
[KI 2 -D B2 de S AR B 1, T BA-U 5ok, -D ik,

FEln-O A1-NO 21, B N = RERT DUIIFELE AL R, S5 48 A sk BA 64

5l 4 C>cc78k0s —c9024 -e sample.c -0 -no
BI0-NO MU B fitsE,  FITLA-O i ITEAL, -NO IEMLSE .

FERR 5-1 SRR AL Se 1 AT IR I I, JF AN HABIE IR SEm o (ERE, WRARSE T Bhik i,
YOI RO SE TUE AL FEBDIE AT PM+rCHRE . A THE PM+r IR, 15 4% N REA KR AE o (1 [
B %L
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3 5 g PEIAII

5.3 4miFEID

X5 PEAN A G B I I

XA RER T el N dn 24T )5 3 CC78K0S. 4 T1E PM+71)5%) CC78K0S, FHEIREmS, 18
WM, IfAE<Compiler Options>Xf WHE P I5 & C WA i I (12 37 .

JaBl A AR

C>cc78k0s -c9024 prime.c -g

Jagl A PM+IE

B 5-1. griIET X iEHE

Compiler Options
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5 W G

(1) BERBBH(-C)

-C WA R U]

#eAdE  -C BRI
NN (S

[ZhAE]
-C WU G PR E T HAR B4

[~ F]
V25 AT DR X AT C S PRAS BT R 1 E AR B EAT A P, IF 0 L7 EARARAS

(3]
FI-C 3BT + FHN AR 46 R B H B B 26 SCAFROAR IS i A5 6L
i ] CC78KOS I, A 2 46 S0 it 42 S BE % SCAFE BIN H kb el DEV H k.

[HER]
-C IR REM AT, (L, WISRAE C SO An IR, B4 iy 447 o 5 T 1T LU 22 0

#pragma  pc (#2EM)

WIRAE C S M A AT L E T AN BEeE, W dr 4T i e M a6 BAT R s 2
AL PM+IN, JFA— 5 SR G PR 0K B B AL UM E U AE QU TR i A T .

75 HPAFM  U16654CA1VOUM



5 W G

WA R U]

EmAATHIEE. HARk & EpPD789024.,

C>cc78k0s -c9024 prime.c

75 C PEREFHBEAT U], IR Bl ks .

#pragma pc(9024)
#define TRUE 1
#define FALSE 0
#define SIZE 200

char mark[SIZE+1];

main() {

inti, prime, k, count;

M

It e A7 R T LA I bR e % B

C>cc78k0s prime.c
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5 W G

-C

WA R U]

& C PSR AT PR TR, IR 3ha 14 .

C T
#pragma pc(9024)
#define TRUE 1
#define FALSE 0
#define SIZE 200
char mark[SIZE+1];
main() {
inti, prime, Kk, count;
GRS
C>cc78k0s -c9014 prime.c
A RATHAT G, MR MPAT R AT,

78K/0S Series C Compiler VX.xx XX XXX XXXX]
Copyright (C) NEC Electronics Corporation XxxX,XXXx

SAMPLE\PRIME.C(1) :
sample\prime.c(18):
sample\prime.c(20):
sample\prime.c(26):
sample\prime.c(37):
sample\prime.c(44):

Target chip : uPD789014
Device file : Vx.xx

Compilation complete,

W832 Duplicated chip specifier
W745 Expected function pro % type
W?745 Expected function pro £ type
W622 No return value

W622 No return value

W622 No return value

0 error(s) and 6 warning(s) found.

fir AT PR E 1 H bR Bl BAT R R AL e 4

77

HFA U16654CA1VOUM




5 W G

(2)  BEESSCaIBRY (-O/-NO)

-O/-NO H AR R SO 2 1 B

ik -O [t Scfh 4]
-NO
BOAMERE -0 [ A4 rel]

[2h8E]
-O SRR E far t HARELAE SO BRAh, IR RESR E At SO H % sl i i SO R4
-NO IR AE AN FARBEAE SO

(A A ]
AREEAE AR SO % SRR H sl i SOrE 44, 7T DUREE -0 JE 0T
AR PRI H AR SUR S PR, AT A SE-NO MR, ATl b i 1D

[#3E]

AR G PR B, -0 MR L BOksE,  FARBLPF LI 3SR JCk

-0 JEIHOE I, W R BATIRE WA AR, F AR SO 2 th 804 3 9K ) 28«
LISR-O I L5-NO 31— IR 0 3505 i P ST 2

[FE]

{F T PMHIN, BEARSAS S/ H 5%, T %iAE< Compiler Options >XHGHER)< Output >Fr%E T H )<
Object Module File >[X {5 ffj< Output Path >ZH & HE HLgE £ B 1 So ek B 3% .

M¥EE T AR, SO AR AT DL

1< Output >4725 T )< Output File >Z2H A HEHh 1% 5 S0 44 8y o F H 3%

[t 5]
FEREAVSEPIL, -NO AI-O HEARMEE

C>cc78k0s -c9024 prime.c -no -0
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5 W G

(3) TrfEsAHLdid (-R/I-NR, -RD/-NR, -RK/-NR, -RS/-NR, -RC/-NR)

-R/-NR A7t a5 57 B vt B

WRHIE R (AR (B BT G B0))
-NR
BB NR

[ZhRE]
-REIHRE T WK — AR ARIR B G2 T -
-NR LI R-R I -

[ F]
AR —AMRRIE AR B T T AL, SRR M T

[#R]
TS FI-R I S AL B, AR BRASTR E AN REE 2 . T, 2 BLSR P TA (A012).

AEESR ThE

B A3 BE— AL I = AT ERAE I (MSBY).

DIn] (n =1, 2,4) K— MM R/MNTESERE (BT HHCAARE) A3 NCE] saddr FA7as1X 1,
WRTH sreg 8,

KInl (n=1, 2, 4) {EgSEE0T, KRS0k 200 A 2R & (B 78S AshAE®) Ash/aics] saddr X,
Toik AT sreg .

SInf(n=1,2,4) ¥HEPDZHADDES saddr KT, TIRETEH sreg I,

C AN R T K 2 57 K P 45 R B 4G A M kL T 9 AT AT R SR R, B
S0} R R R R AT HT B R4

ER ATLMRE 2 MBI,
MR E-NR ORI, ARESER S LR .
KEFEERTY - g

B 3B — M IR AR A R UR AT (LSB).
D AT B H 343l 2] saddr X35

K ANEW AT AT T A 350 T E saddr X 5k

S Ao BAT A AR 18 A 24> B 3 saddr X35,

C ANBEXAT A0 5 K AR I 2 T 60 e 4

45 FE e

C>cc78k0s -c9024 -rds
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5 W G

-RD/-NR WAE 3 BC Ui 1

W -RDIn] (n =1, 2, 4)
-NR
BB -NR

[ZhiE]
-RD LI g4 1 AR T AN ERS AR R (B T W AR IR ) A4 2] saddr X 3.
-NR 3ET{#-RD LI TR -

[ A ]
L RAR TR SN AR B AN S AR R (B T W B AR B B4R E saddr X3, %5 -RD EHAE], X5
A sreg AT

[#3R]
FEM OO AT R SR n (K 5%

NIE  FoBmaeERR

1 TR, BT TAR

2 TR, BRSBTS, RN, oo, feit

4 CTRER, KRS AATRESY, CATSAA, BA, TSR, MR, feE, KA, ook
B Pradi (Wisgiiak, SR L)

1 sreg BEAT 7 B (A & B2 REE 1 SR /0 L 2 saddr X3, 1AV i€ T -RD &,
I A R R T T AR B 7 e 2 saddr XK
R E LT > FL 3 saddr XA TR sreg e (1 A EE TR AB
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5 W G

e i

P
=

-RK/-NR %

Kk -RK[N(n=1,2,4)
-NR
BIANUEE  -NR

[ZhE]
-RKEIUKE H B)3E b4 5 S HOm A A8 5 (5% 1 A A 3225 70 il 21 saddr X
-NR I 1i-RK LI

[RH]
FERASHELT, RAGE R BSHON A5 B (K TS B3R R) B3l RE] saddr XK, HfikzE-RK
BT, XA sreg ALK,

[#3R]
FEM OO AT R SR n (K 5%

NIE  FoBmaeERR

1 TR, BT TAR

2 TR, BRSPS, RN, oo, feit

4 CTRER, KRS AATRESY, CATS AR, BA, TSR, FUESR, fRE, KA, oo
g P (m gk, AL

H1 register SCHE 7 5 W] YA AN .

1 sreg BEAT 7 W] AR & BLAL RERS F S 70 LB saddr X3, IITANVE R 7€ T -RK IE5 .

M R IX AT 73 Wl ) saddr XK e £ S B F 3h A2, L sreg 75 WK o8 503 B0 H 2 A S I R
FERTERALPE

[EE]
AU ALE-SM BTk o R AR WERBCA F77E-SM B0, 182 2 8 15 7 5 HL-RK 2B T 20
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A5 G

-RS/-NR WAE 3 BC Ui 1

K HE  -RS[N) (n=1, 2, 4)
-NR
BN -NR

[ZhiE]
-RS EINRER [ B S H B E 4 BLE] saddr X35,
-NR E1i{d —RS &I TER%

A
AR BN S B A R A B TR saddr K8, IR E —RS BIIMIAT, X5 sreg H WX,
[#38]

R L AR BT AR n (F{E T 52

NIE AR R

1 TR, BT STAR

2 TR, BRSPS, RO, oo RO, feir

4 TR, ERPS TR, OATSAAL, RO, BAFSEA, FUA, fREHA, KA, Jeffe K
g PraAR R (Am gk, IR AL

1 sreg BEAT 4 B (AL i B2 RESE A D4 /) BC 2 saddr X3, TIAVE AR E T-RS £
M XA I /2 HC S saddr IR A ASAZ R sreg WA F 332 8 H i RRE ) 7 2ok ib
H,
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5 W G

(4) MAEH(-Q/-NQ)

-Q/-NQ A A
ek -QUILALIEAY] (U B G e R I, L RIA)
-NQ
BINUL  -QCILW
[ZhiE]

FE-Q JEI S T H SR DA T ok A st Rk H AR
-NQ LTI -Q HEIILAL.

[RZH]

D RAR LGS H AR AT B AR K, R E-Q IEI. MR CEIRE T -Q JEI, AR ZE[FI
TR, BT CLUESSHRE Z AR . BRI S & 5-2 A,

[#53R]

% 5-2 HHH-Q LI RE NS BLE LAY,

£5-2. MALKE(1/2)

i SSit] LR IR

AL BRAH -QCILW.
U(-QU L) B BT BT SUR TR R AR AT 5 P A ALK AL B, DL A R .
Cln(n=1,2) BT AR R OGRS g i S A PRI T RS ANSI-C R
(-QC k%) S, AENTEIEMZEA (char, short) TN SR, TR,

SRR T 0 DRI SRR . W n RN, 5B n =1,
L AR R
2 AEASILE R R A AT

J(-QJ ETH)

B IES .

X[nl(n=1 % 3)

ARIEARAT I MRS DL S Zok A Bh BB Ak 10t

(-QX I£I5) MG n AR FERA R FET, BRI, W n 20 KA n =2,
10 EEESE.  AAERE T-QCIW LT,
2 Bl IWAHTRE T-Q L.
3 AUER/MESE. HFRE T-QCILAW JEIT.
Q DI E T R
R I ZAF B T B AE RS, ¥ S AE AR ) L B saddr X,

83
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5 W G

-Q/-NQ AL

& 5-2. it FEAL(2/12)

e St QR I

W[n] (n=1 #| 5) 0 AR A BT R oA A B A RAD OF  m Pr A2 88 A IR (i, g ekl st
PR O3 2k SR A2 ik SN T IR, SR M3 XA #3500 «
SR, R QARIE IO AT A brdE, (BT ANSI-C brflZg TS8R rF, thikfy
BCEIATIRIT), PATSE RA IS LM . AR ANSI-C dritk, EUEREFRFEZRIN S
BT XA I H] LAGEE e o
MR n RN FREREAR RIEE L Bt Wl n AR, HEGAN n=1.
1 SRR N BT IR .
2 WARGE N R EHRAT U o B8 AR I TEAT 5 P A2 51 ] saddr 3 50] 5 Bt
AL EBE AL, AT LA v SR AL 75 A bk e SEELR LA - saddr 10 50 5%
b AT TR RUEAT 5 T AT B BT 5 J B B AT 5 B A A AR
o ATBLHE IS 2 2 TiA7 ik 2 saddr XAk AR IEARAL
4 AL NI RAT T o BOE R TEAT 5 A AR 5 | ] saddr 3 50 55 i
AR, AT BAIE R T SR AL 715 A b R SEBAC Ak . saddr 4 5%
MBI E TR ORI S LRI W RS SRl TRy W Ry TR I W RS i e

A,
5.l LLHIEEEE 4 D7 3] saddr X2 s LAy 2 .
V (-QV i) B—A 1 BNAR R 1 35 I8 5 A7 saddr [X 3.
Linf(n=1 % 4) FH P AE e i A
(-QL ) R n A A FRIEBEA R W VE SR, BARITR . i n 328 JWERA n=3.
1 EEA.

2: RAERCE B B2 SR A =T .
3. AERBLRECL I G A AT ARG A7 — IR AR B, DE/ML [5G .
AAEH 3WUEA L, W T TR S

E  fE CC78KOS i€ T —QC ZEIIN, # H RN 74T ¥ BN 2 e LR 75 AOR AL PE

0 & 127, 0x00 & Ox7F, 00 & 0177 FHFkM
128 % 255,0x80 & OxFF, 0200 % 0377 LfF 5728

0U % 255U e Xyt
O & \377 TR
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5 E GRIFIEIN

“QI-NQ Ak 1]

fHJE, 24-QU LTk e I, MN200'BIN377' 3 [l N A 7 701 B0 A E A5 PR R ok Ab B, ]
W {E Vel A +128 F]+255.
W05 ) I BB 9 T o

-0 & 128 FHM
=129 kSt

=

I B AR T A AR Y, R AT DU R v A R A SR AR U B .l AR e
QLI Bl M A T A S o 32 -QC LIBT3 BTSSR AT 5 e

() 4-QC2 LLIipifiaE
int i

i = (int)20 * 20; /* 400 */

Al LU SE 2 T LA AL

WIR-Q LLIRB AR A S B 2, AR 584255 ] T4 2 -QCILW IETR ) 15 L -

ARSI e 5 10 I 0 7 AN e B2 (R R A8 E R HERf R 38 1 CIRIE I, i E T BT . (B 24 € -QJ ik
-1 M ER-QCLW).

W R H BRSO R RSSO, 84 -QU SR ITURI-Q LIS £ JE AL

WIR-Q FI-NQ &I [F] I B g €, 5 F6 7 IR I 28

WA ZA-Q LT F N i, a8 2 11-Q LINA 3K

WR-QR F1-SM RN #4e €, &S ER, I H-QR EmikK.

[ F o]
PUAREAT 7L, i DABAT RHE WA 2 K745 (char) B4 /E 8455 (unsigned) Y,

C>cc78k0s -c9024 prime.c -qu

D RAE I I J5AIRE-QC MI-QRIEIT, -QC It & o, AN -QR IEIAT AL

C>cc78k0s -c9024 prime.c -qc -Qr

WERARARAE-QC M-QR LRI AR, AW R fir %o

C>cc78k0s -c9024 prime.c -gcr
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5 W G

(5) WG RHH UL (-G/-NG)

-G/-NG AR S g 1
g e -G[n] (n=1,2)
-NG
RV EH IR -G2
[ZhRE]

iR e PRt Es AT RE R ERSSAIIESNSE AN 82 5" e e
-NG EIAE-G LAY .

(A% A ]

AURBEATHEE -G R, FARB S PRh BTG 1047 5 R 505 B S, F b BRSO R SEebe A
VAN DRI, 0 3T A PR R R e B, 2 -G BT T DA AT 7 G 15 A 5 2 e A
B

[#3R]
P n AN IR A 2 A T el 22
nfig Difie
i BRIAA n=2.
1 LA B (LISDGS B$DGL JT 4k 1 B ) 2 H BrBE BRI o AT kA B A 21
TGRS

AP AZIE T, 0l DR 3 AR 5 VG AT
PR A S e, B ART RAAE T H BRSO A 5ERE Fs 1 k £5 6L
2 R AR BN ACE HARBEER SO R Gl ST

WIR-G AI-NG BT N Hedif g, foea #edin g LT 24 .
W SRBAT i AR BER SO iR BRSO, -G IR I

({55 FHT ¥ 4]
1E T -G 1L

C>cc78k0s -c9024 prime.c -g
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5 W G

(6) TFHAEEFIZR AR BLE(-P, -K)

-P THALFE AR SO G i 1
LNl -P [ i 3044
NN T (e )

[ZhE]

-P SRR E AL BEAN R SCAF I o Bedh, FRoE i i H Sk sllar th SCPF 2K WR-P BT g, AT T3l
K BB SCAFH  -

[RZH]
U SR ARARAE AT TIAL BRI R 2 e AR - B I A B TR At S, et o ) e AR B A7 2R S A
(ot SR 4L, A BHRE-P 2T

[#3R]
AURARAE T-P I, SO AN, AL B BRSP4 S AR B A LA ppl
AR AE T -P YL 20 T KA AR, U BRSO ) BT SR Hl

[EE]

B PM+E, EARH H R, FEE<Output>hr2s iU T [)<Create Preprocess List File>[X Id 1)
<Output Path>41AHE B 45 52 B i th H 5%

AR X AR, i SO A TR T DA .

7E<Output>#r25 L F ffI<Output File>ZH & HE P45 & SCpF 42 s H 5% .

[ A Y]
AL FZ R0 F sample.ppl #EEH

C>cc78k0s -c9024 prime.c -psample.ppl
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5 W G

-K AL EZ R SO GI i 1)

e ] -KIAEFEA ] (T B & % 70 L)
CONLY KFLN

[ZhfE]
-K IR I 58 TRAL BB 2 1 Ab I

A
B W BR B P T 22 LA R, MBI R AL B 91 48 S 7 B4R i A

[3#3]
NERAPBI T -K IR E KA BETY,

F25-3. —KIEIRALHR 2R

b ik
B & T FLN —#f
C T
D #define 9" Ji
F #if, #ifdef, and #ifndef [ 414 1%
I #include ¥ &
L #line Ab#
N AT FTAL

R AT LU R E 2 PR BIRAY

UEREATIR E-P BT, A A-K LTI
R ZA-KIETRIN Hedi 2, Beedi e (L IAT 2
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-K

TRAL AR SO G i 1]

[ F 5]

MITALBEFN ST prime.ppl FHANERVERE,  IMAAT 5 A1 AL PE.

C>cc78k0s -c9024 prime.c -p -kecn

51 prime.ppl.

/*
78K/0S Series C Compiler VX.XX Preprocess List
Date: XX XXX XXXX Page: 1

Command :-c9024 prime.c —p -kcn
In-file  : prime.c
PPL-file : prime.ppl

Para-file :
*/
1 : #define TRUE 1
2 : #define FALSE 0
3 : #define SIZE 200
4.
5: char mark[SIZE+1];
6:
7 : main()
8:{

M
/*
Target chip : uPD789024
Device file : VX.XX
*/
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5 W G

(7) PALEBH(-D, -U, -I)

-D

AL BE 15 ]

iR iipa D EA=E XA [ EAEEXA].
(M7 LA 52 2 TR )

NN SATHE C URE P BRI o 1R 55 A2

[Zh8E]
JH1-D BETHR & (1 N 2R C R 7 h#define A R RCR, #2200 .

[ F]

USRS TR R A TN AN, R I

[#3R]

FHIZS ' SMRHEAE XA, —RATLSERE AR5 X
(ERAD = B < AR R VR

S AR, R T L

UIAE-D AU IR T IR 044, BURSRE RO 45473

[ F .45

C>cc78k0s -c9024 prime.c -dTEST,TIME=10
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5 W G

-U UV GEERVE
e FRiipa U4 [ BAL.(TLEREZ N EA)
NN JH1-D SRR E (1% 58 XATRL

[Zh8E]

-U IR0 258 3, RURIF] C YL H#undef 1512800

[RZH]

FA0E TAZAEI, W -D JEIUE S 4 2 To

[#3R]

HES ) DRRREANE AL, — AT BLIE R AN 2 I -
ERARILS ¢ KR A RV I .

A -U RIS 2 52 S AUE C 28 HI-D 3 S 78 C YR RSO i #define i U SO 44 5%
G AR I R GU IR A ANRE T -U JE TR U -

U SRAE-D MI-U ST € TR E 44, G 4RE RIS R A4 A R

[ FH o]

E-D A-U BT AR A A o AR, TEXT Rk

C>cc78k0s

-c9024 prime.c -dTEST -uTEST
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-l A P45

SR D -1 B[, B (RTLA¥E € 2 Ji it 1)
LRI WS H i 1
R B INC78KO0S $5 5 (1 H 3%
C:\NECTools32\INC78KO0S i 2

[ZhE]
-1 BT D RE i TR T H sk B4R C YRR rh#include i fUfi e 6L 35 30

(A% ]
TIN5 H R AL S SOPRI i

[#3R]

ES ) DRaRANESCAZ, R B E 2 A H k.

FERAES ) KRR A SRV I .

DRV IR T 2 A HR, B AT EIORSRE, AL fk#include 457 5E K S0PF 2L E I K
AT

AU R

o PEUMHIE!

o H-l IR EMHE

o JHIEEARE INC78KOS fi5:E i H %
e C:)\NECTo0IS32\INC78K0S * 2

i 1. WRAES SR AE#include BRI Y "OOE ) FE R, ESEEESC H b k. Wi E s
PR <>%ae, LHRHTER.
2. XA ER T CCT8KO0S %% 2] C:\NECTools32 H s (Windows hiA) .

({5 P S
$ROE T - I

C>cc78k0s -c9024 prime.c -ib:, b:\sample

P FM U16654CALVOUM 92




5 W G

(8) CHRIFHHCHBIR B (-A, -SA)
-A TSRS ST A Bl 3 i 1]
T Atk -Alin S 44]
LN BT IS AR S L
iy th SO * asm (*1 FRHFH D)
[ThRE]
-A TR I gm0 . 54k, T LLFR R H SR S & .
%)
AR ) H e i VIR S S 4, T BL i e -A IR SEI .
Eji32]
T 5 SCA 4 B TR 4% AR A4 B T AR 38 N SR A R o
BRE T -A GBI, I AL SO A g, T U SCA 44 FRF AR BN SO 44 .asm”s
IR T -A BTN, AL IREN AR A AN, I g AR SR S B S AT IR BN A
WIAR-A BT —SA IR I B 58, ) 200 -SA 130 o
[FE]
£ PM+H AR S H 3%, 1] LLYE<<Output>>Fr%5 1 T << Create Assembler Source Module File
>>[X 3 (1] <<Output Path>>41&HE$a e Bk B, FikH“without C Source[-a]”.
SR E LB, il SO R
7E<<Output>> 4525 1K H<<Output File>>41-&HE 35 & 044 B i H 5k .
[ FH ]
BRI GRS sample.asm R S241 o
C>cc78k0s -c9024 prime.c -asample.asm
TSR URASTH SOt 24T B
C>cc78k0s -c9024 prime.c -aprn
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-SA TG AR ST B 3
ik -SA [fr k4]
LONINGL B G YRR - H
iy th SO * asm (*1 FRHFR D)
[ZhE]

-SA JEIUKE C YIS LGER L A B il RS o Sa b, 3 HRE T it F SR e il S
o

[RLH]
WERIC GRS A C YRR AR SO T 2, IR AE -SA LT

[#3R]
Bt SO 4 R 6 SO A4 8T LR S A SCAF AL R
PR T-SA GEIRN , R A SO B TN YR SO 44 BB AR B AN A 44 .asm”
MARE T -SA JEIUN, G RAK S s A4 BN, IR ERE i ) 2 AT K S A o
WER-A JETIN-SA L IR R I POk i, I 205 -SA ZETH .
AL S ) C IR A2 BEA BN S I G S vERE b, (HR WRRE T -LI L0,
W C YR 2 S I 2R

[EE]
BEE PM+H S i H 3%, 1T LLfE<<Output>>#r%% T [Fj<<Create Assembler Source Module File>>
X [f<<Output Path>>41 G HEH ik et H %, Hik$e“with C Source[without Include][-sa]"8i#
“with C Source[with Include][-sa -li]".
B E T, i SO s U
1E<<Output>>HrZE T R << Output File >>4 A HE P8 & SCIF 4 sl f i H 5%
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-SA TG PR SO G i 1

(43 F Jei ol
¥55E-SA LI

C>cc78k0s -c9024 prime.c -sa

prime.asm A 781 R

; 78K/0S Series C Compiler Vx.xx Assembler Source

Date:xx XXX XxXx Time:XX:XX:XX

; Command  : -c9024 prime.c -sa
;In-file  : prime.c

; Asm-file : prime.asm

; Para-file :

$PROCESSOR(9024)

$DEBUG

$NODEBUGA
$KANJICODE SJIS
$TOL_INFO3FH, 0130H, 02H, 00H

$DGS FIL_NAM, file, 033H, OFFFEH, O3FH, 067H, 01H, OOH
$DGS AUX_FIL, prime.c

$DGS MOD_NAM, prime, O0H, OFFFEH, 00H, 077H, OOH, OOH

EXTRN _@cprep
EXTRN _@RTARGO
EXTRN @@isrem
EXTRN _@cdisp
PUBLIC _mark
PUBLIC _main
PUBLIC _printf
PUBLIC _putchar

@@CODE CSEG
main:

??bf_main:

$DGL 1,13
push hl ;[INF] 1, 4
movw ax,#08H ;[INF] 3, 6
callt [_@cprep] ;IINF] 1, 8

;line 9: inti, prime, k, count;

;line 10 :

;line 11: count=0;

$DGL 0,4
Xor a,a i[INF] 2, 4
mov [hl],a; count ;[INF] 1, 6
mov [hl+1],a ;count ;[INF] 2, 6

;line 12 :
;line 13: for (i=0;i<=SIZE ; i++)
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-SA TG AR ST B 3
$DGL 0,6
mov [hl+6],a ;i ;[INF] 2, 6
mov [h+7],a ;i ;[INF] 2, 6
?L0003:
mov a,[hl+6] ;i ;[INF] 2, 6
xch a,x i[INF] 1, 4
mov a,[hl+7] ;i ;[INF] 2, 6
xor a,#080H ;128 ;[INF] 2, 4
cmpw ax,#080C8H ;-32568 ;[INF]3,6
bc $$+4 J[INF] 2, 6
bnz $?L0004 ;[INF] 2, 6
END

; *** Code Information ***
; $FILE C:\NECTo0ls32\SMP78K0S\CC78K0S\prime.c

$FUNC main(8)

; bc=(void)

:  CODE SIZE= 222 bytes, CLOCK_SIZE= 654 clocks, STACK_SIZE= 14 bytes

; $CALL printf(18)
bc=(pointer:ax, int:;[sp+2])

$CALL putchar(20)
; bc=(int:ax)

$CALL printf(25)
; bc=(pointer:ax, int:[sp+2])

; SFUNC printf(31)
; bc=(pointer s:ax, int i:[sp+2])
; CODE SIZE= 28 bytes, CLOCK_SIZE= 108 clocks, STACK_SIZE= 10 bytes

$FUNC putchar(41)
; bc=(char c:x)
; CODE SIZE= 14 bytes, CLOCK_SIZE= 58 clocks, STACK_SIZE= 8 bytes

; Target chip : uPD789024
; Device file : VX.xx

C WREI A ARSI o

HFA U16654CA1VOUM
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(9) SRFIRIARIRBY (-E, -SE)

-E BRI RS AT Ui W]
e ik -E [t S 44)
BRI UL BOARTR AR SO
A s S A *.ecc (1 FEREFES)
[Zh8E]

-E GBI E THAR RSO . BRAh, IR T H ke SR A

[RZF]
ML -E TR, R DS SR R A RSP (Kt H S A SR A

[#3R]
TR ST 44 B e # SCAE A0 A T AR N SCAE AL R
IRAE T-E ST, W A SCPE AL B, I R AR SO AL R A2 1 A\ SCIE 44 ecc”
MPRE T-E LI, WS A A, R R SOARRE B AT S
WERFEE T-WO LI, A i 5 5

[EE]
B PM+H AR H 3%, fE<<Output>>454& 71 T [F)<<Create Error List File>>[X i [fj<<Output
Path>>21 & HE H #5 w Brifr th H 3%, Hik$E“without C Source[-e]”.
MR LRI, S SO A .
1E<<Output>>+525 1 T [fj<<Output File>>Z & HE i85 & 4 s H 5% .
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HR SR SR ]

[ F 4]
fRIE T -E LI

C>cc78k0s -c9024 prime.c -e

HHRANL SN AW T .

prime.c(  18) : W745 Expected function prototype
prime.c(  20) : W745 Expected function prototype
prime.c(  26) : W622 No return value
prime.c(  37) : W622 No return value
prime.c(  44) : W622 No return value

Target chip : uPD789024
Device file : Vx.xx

Compilation complete, 0 error(s) and 5 warning(s) found.

HFA U16654CA1VOUM

98




555 T R

-SE e H1 2 SO g 1
ik R -SE [#ir et 44]
BRIA UL TCHERFN R SCAF A
ar H A *cer :*.C FRERPIRC a LS LTSS
*her :*H CHEENRSE
*er o R*.C R *H SCARAMEERR YR
[ZhBE]

-SE IETRE A C YRR BV R AR SO, MAME T LAFE e it H 5 slda th S F 44

[ A]

WA R IR SCAFAN C Y57 0 Sy, 45 2 -SE 2L,

[HiR]

TR ST 44 B Y SR A 8T AR 2 A SCAF A FR

MPRE T-SE WIS, W R S A G, MBS RIS A FoR A2 S AN S F 44 . cer”
MIRE T-SE RTINS, WROKE 4% 4w RN, A IR SR SO R it B 2 ROl A .

ANBEN B SO E H R ASCIEAL, RS SO ISR ALE R, A SRy her ) 2 71
R 2 A AT YRSl & . WERE S SUIFII ORI C, A SCIFRI Ny “cer” AR IR B2 SCATF
S B TR B . ORI IO, A SRR A er AR SRS o I RBATAE AT IR
WA CUWREF AP AERXFEILT, AL N T IR BRI RS

WIARARE T-WO ST, A A

(]

99

BLAE PM+H R H 3%, T << Output >>FR%5 T T )<< Create Error List File >>H )<<
Output Path >>Z1 & HE FLER B it H %, FHiE#“with C Source[-se]”.

BB T BRI, SO AL TR

7E<< Output >>#5%5 T T ffi<< Output File >># & HE 48 58 U 4 80 Hnt H 3% .
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-SE

RS QI UL

(43 F Ji ol
185 T -SE &3,

C>cc78k0s -c9024 prime.c -se

prime.cer 3 AFAFUWT .

/*
78K/0S Series C Compiler VX.XX Error List

Command :-c9024 prime.c -se
In-file  : prime.c

Err-file : prime.cer

Para-file :

*/

#defineTRUE 1
#defineFALSE O
#defineSIZE 200

char  mark[SIZE+1];
main()

M
prime=i+i+3;

printf("%6d",prime);
*** WARNING W745 Expected function prototype

count++;

Date: XX XXX XXXX Time: XX: XX:XX

if((count%8) == 0) putchar('\n");

*** \WARNING W745 Expected function prototype

for (k =i+ prime ; k <= SIZE ; k += prime)

M
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(10) X FIHFIZEI IR UH (-X)

-X A X5 AR S A6 1 B
M 2 ik -X [t SC44]
LONINGL B A8 X5 U SC A4
iy th S * xrf (1 FEREFD)
[ThEE]

X BERIR AL X G ARSI o Bedh, 38T DU € far i H skl SO 44 o A8 CHNRRSCA X
TREARWEL, ATLRER SR, 755058 A5 s A E .

[RZFA]
QR A G I AR SO, B BT S5 SRS (it H 3/t SCA 44 i i e -X
I

[#3R]

Bl SO 4 B e SO A4 8 T LR S D SCAF A4 R

ARE T -X LI, SR SR R, MR SRS A R AL IR AN ST 44 e
BRARAZE ™ HATIR(FL01, FR A024 Z AN 54 ), 5 WIRIEAT 9 P i, A2 ST AIRSTAHTAA
REBS BB o (FURAEIXPI S O T JCIR PR UE ST A AR (R IE A -

EE]
PE PM+R s H ok, FRELE<< Output >>#52% 71 T HI<< Create Cross Reference List
File[-x]>>H [)<< Output Path>>#1 A #E B 5 72 Fri 4 B 3%,
MR BRI, il S A .
7E.<< Output >>#53%5 71 F )<< Output File >4 5HE BLig & S04 Befin it H %

[ 1]
FRE T -X L5

C>cc78k0s -c9024 prime.c -x
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A G AR SR e

prime.xrf LA U

78K/0S Series C Compiler VX.XX Cross reference List

Command : -c9024 prime -X

In-file : prime.c

Xref-file : prime.xrf

Para-file:

ATTRIB MODIFY TYPE SYMBOL

EXTERN array mark

EXTERN func main

AUTO1 int i 9

15 15 16

AUTOL1 int prime 9

AUTO1 nt k 9

AUTO1 int count 9

EXTERN func printf

EXTERN func putchar

PARAM pointer s 29 36

PARAM int i 30

AUTOL int i 32

AUTOL1 pointer ss 33

PARAM char c 40

AUTOL1 char d 42
#define TRUE 1
#define FALSE 2
#define SIZE 3

Target chip : uPD789024
Device file : Vx.xx

DEFINE

13
17

17
21
11
28
39

35
35
36
43
43
14
22

Date: XX XXX XXXX Page: 1

REFERENCE
14 16
13 13
17

21

18 21
21 21
19 20
18 25
20

13 15

22

14

21
22
25

21

15

HFA U16654CA1VOUM
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(11) FIEMRBEEA (LW, -LL, -LT, -LF, -LI)

LW LIS S !

SR A LW [ EE]

BRI ] -LwW132 O RIS R, X E 80 NP AT)

[ZhfE]
-LW BB IAT LU AT SISO E AT I A AR

[RZH]
i 0E -LW SR I AT SR AR SO E AT I A R

[#hiR]
FH-LW &0 0] LR @ T A e Ve R, (REAUEES AT (CR, LF), BAxWT.
72 < WATREMFTENIN 745 4 < 132
WRBAREEREOR, WARATIEREOR AN 132 MR 26 G, AR R 2 Mt
80 M)
WHRF RSO R A VEATAT UL, FBA-LW EIUTEAL

[ 1)
PR -LW BTN, A2 X5 I8 H O SO 44 xrf

C>cc78k0s -c9024 prime.c -X
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-LL

B A% i

SR TRaN
Lo NI

-LL [47 %]

-LL66 (rf TSt Wk 65535 17)

[ZhfE]

-LL IR E T P SISO P e BUIAT 4

(R H]

WER T E SRSV R AR AT R, WS FRE-LL IE T

[HiiR]

T k-LL GBIy LLFE 2 (AT B0 Bl T

20 < BEUUREFIENMIATEL < 65535
WIRFEE T-LLO &I, WAL IR H L.
WERKRFREAITE, WA IUATES BN 66 TR RS 6, S Tdosish 65535

(B

RPN SAFBAAAVRAET U, IS A-LL SR

[ 1)

8 S P SO BT ECRE 5 4 20 47

C> cc78k0s

-c9024 prime.c -x -l120

HFA U16654CA1VOUM
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LT SN

ik R LT [P 50E]
LININ A -LT8

[ZhfE]
-LT SEIUE HAEIEAE SO i KPR FF(HT,  tab) SRS 8, ARSI SCAF i — s (1 (o
)RAE

[MH]
URAREASSCAE AP T -LW SR SR R S I AT T, A HT defdali o™ A b . BrbAn] AR E
LT JESTORE D 7 A8

[#53R]
-LT BEIRUT AR 2 () 2 35 5 P S an R
0< FREMFITEE <8
WIRIRRE T-LTO, AN RIEFF5IATAEL, I B tab 1049,
WIRFRHCRWBNE, WA tab TR TR BT SA T 8 Mok,
WER AR SCAFEA VR, TA-LT IR

[ F )
-LT 3Tk 205

C>cc78k0s -c9024 prime.c -p

BT HT b2 FBCR PO E N 1 (1),

C>cc78k0s -c9024 prime.c -p -ltl
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-LF HI A% B0
MR -LF
Lo NI 9
[ThEE]
F8 78 -LF I S RN PR SO AR RIS I BT 16 43 U1
(3R]
WERFN R SR A AEATT UL, HA-LF JEEAL .
(¥ R E ]
FaaE-LF S,
C>cc78k0s -c9024 prime.c -a -If
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LI LIS S !

SR A -LI
LoSIN i ¥

[ZhfE]
LI IUR AL 55 SR ) C YR P I BN Gt SO, Jerp C Ry LLARE TR U B

[#i3R]
WEREATIRE-SA JETH, W% LT 20 o

[ F Ya 5]
$65E-LI LT,

C>cc78k0s -c9024 prime.c -sa -li
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(12) ZHimH (W)

-W ot A U
SR TRaN -W [4544]
BRIA UL -W1
[ThEE]
FRE-W LI o 2 05 A5 S B &
[RZH]
IZIE A BE 8 Y & A 255 R BB G, A 4 HS s A ELAR I 4t (5 .
[#ER]
N TH 45 2255 RIS 2.
#5-4. BLEERER
AN 4 A T
1 i I R R
2 A H AN 1 A S
WIRARE T-E 8-SE I, H5A %5 (5 SRl i H BB R 51 3R S0k
20 0 ULIH AT EL [ 5 & FE R BRSO 2S5 B (Y- B(-SE IR IE 2 D
(8 74
W IR T 2 I 2 5] AR
C>cc78k0s -c9024 prime.c
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(13) PATREZREH (-V/I-NV)

-V/-NV PATIRZS Wos vl
S iipu -V
NV
LININ L -NV
[ZhAE]
SV OIETUE M TR PRI PAT RS 2R A .
-NV IR -V ZE TR
R A

PR XA LI AT DAAESAA TG B (K DI S 5208 2B (KA IR i 24l &

[#i3R]
i th e R rh OB B A AR D) REAL R o
U RV IETTUNI-NV B T ) I R BEE 5, T8 d5 i PRI SE T0A 2o

[ ]
-V R IESE -

C>cc78k0s -c9024 prime.c -v
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(14) AR (-F)

F SR

iR iipa -F X4
NN IR A SO AR A BE R i AT A

[ZhfE]
5 -F BT LA S 52 1 BAR SO E i N BEE 1 I B A SCE A

[RZH]
AT AT ICIEAR B AL B R A SO AR I, TR E-F GBI, USRI T 2 AR
LG PEL R B RN, EZHOCIE P R IO HLAR € -F 0

[#i3R]
SRR A RVHIRE -
SR T A I 75 BB AT IR
78 M B IR AT T LUTI R 20 B e I s S N\ SCAE A4 K
FEZ B CAF PR IR (AL I A SO AT R, A BRI IR N AT IN A 28
P REETKI IS 2 LAY A P 5 Jo 418 (KD E T 24
fE' R JE BT R T A AR .

[
A PMHI, S AEIUEE (R R AR

[ F Y5
S prime.pee IR 2

; parameter file
prime.c -c9024 -aprime.asm -e -X

prime.pcc 7E40 B AE A .

C> cc78k0s -fprime.pcc
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(15) WmSCA-QIE E SR B (-T)

T I B SR H S 1 B
SR TRaN -T B
Lo NI A AR E TMP FRE MIRSZs A H . WA TER T

Windows (ARG, MISCPF2 A i 2124 i sl 4 (10 4 1 H .
FUEIET UNIX IR SE, A4 8IS in /tmp .

[ZhE]
-T LI 52 QU I N SO SR B85 A1 H 3K

[MH]
O I SCAF L T LU -T 3 It

(3R]
BIAEAE S 52 H % P AT AEAT LT EUE I I SO, WUERSCAFRAT AR WAE R IR QIR S FL A o .
FEAFA A 14 B N SO 7 28 WA AR 22 18], IR B 2 () TCVET AL B4 I SCAF 2 i)
IR E H o, IF KA 1 N A SN IZAS SO o 0T 5 S SOPF D i, 2500 SCPF (A A 1
AT EELV) ) AT
UGREAE RIS, WG SO S BMIBR . Wn R A% N CTRL-C I, Za ¥, AR SOt 2 i mibR .

[ ]
THNATARE T TMP H AR i I SOPF R i A7 8

C>cc78k0s -c9024 prime.c -ttmp
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(16) #HBHPLEA(--/-2/-H)

—/-?/-H 5 W5t
T Rtk -, -?,-H
LNV G TN
[ThEE]
-y =2, FI-H IEIRRENS s onf NG T (a7 2 U0 0, B W i A ) £ BR U T4 1) B A5 B (A
AT ) -

o AT PM+PEE XN, B PM+ T FRES L), iE{E<Compiler Options>*f G HE H1 4%
N LA .

[RH]
S R TANE IE, AE C ik as iz AT n] LLS | HIX AN I

[#3R]
M-y -7, B-H EIBREETI, B e g IR AT A
it B IR AR WoR O IS SIS A 7, R LU MR PG . SRS R AT 2HR B, LR
BRIR AR AR AT, SRR N IR A

[ )
FR5E-H LI

C>cc78k0s -H
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(17) BT RV (-Z/-NZ)

-ZI-NZ T UL
Rtk SZ[EH) (R R E SR, LR e WD)
-NZ
LININ A -NZ
[ZhEE]

-Z WLIRAEMS T 7€ 2 T R Al JE ST R AL P,
-NZ JES#-Z IR .
RIMUARERL MG, 1o K A5+ A 1R (A012) .

(A

LU S Ui W 1) o A P RE R REIE I T 78K R8T g BR

[Hi3R]

"
*

113

SZ RIS

FR5-5. -ZEETR RT3 87 (1/2)

B ik

g BRIAFEE T-NZ 2551,

P I )5 EEAT AR T EROA N R

c SCVFHRCEERE 1 /s

i TERE T B0 H AU 2R IR R SIS 4ifid
E® VERE T A D R BB EUC i
N R A S HAD .

B TIPS HN R A BEAT B

S, E, Al N ABEFIN R E .
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-Z/-NZ BRI K RE 1501
% 5-5. -Z SLIR KR PET (2/2)
B it
B W
A ANSI FrAEZ SR BN R ARVER . AR ANSIFRE A o6 804152
BARMUL, 2BAT FHIES
A A A EAS TR A DGR
callt, noauto, norec, sreg, bit, boolean, #asm, #endasm
ZFBRT A (3 AT BRERRIR) A AL
es e X% __STDC_ _ A 1.
P R L VA B T T I
(W787 3B AL 15 1)
WRIEET -W2 %I, -QC, -ZP, -ZC, -ZI Fl-ZL EIiakh Fasd,
(W029 *-QC’ JEIA [ #4H)
(W031 *-ZP’ JETA ] FAH)
(W032 *-ZC' A ] # Hif)
(W036 *-ZI' AL HE)
(W037 *-ZL' JEIA I # 4H)
WASRE T -W2 T, XSRS #pragma ) N AE .
(W849 #pragma i&AJAN | F )
WRIEE T W2 IR, £FxF_asm AN G L AH T A,
(W850 Asm it fij AN n] £ 4)
WMERIEE T -W2 I, %FAi#asm Fl#endasm BN A E R,
(FBO1 AsE MHatl, 4%
M[n] FEFF B el DAT 9 e 3] .
(n=1,2) | s 2ik 6 MERISH, 83 9 N TRESH.
FEVFAE I SR PR BE IR E A bR BOR BME, B RO 5 B S5 R A4 L R T LAE 28
A n B RA R _@KREGxx T Tk /BB . Wk n g 20, WERL n {24 1.
1. H7E leaf BN ¥ _@KREGxx HAEI X,
2: H_@KREGXxPATIRAHIKIZ, IS HI HEE R/ E _ @KREGXX.
D T R OE R 2 i 8 R I B R AL B
[E) 4R € T-QLA WS/ AR 5, ARG U VE-QL3 IE TR BEAT Ab B
R A BRI pascal B E B4 .
[ KRR 45T e X5 __FROM_INT_TO_CHAR__ IMfEh 1.
L B AR YIE AL, gaikasE X% __FROM_LONG_TO_INT__ MfEN 1.
[ FA FE451]

T8 T-ZC Fl-ZP #10,

C>cc78k0s -c9024 prime.c -zpc
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mailto:_@KREGxx

5 W G

(18) KR LAHEREER(-Y)

-Y IR e SRR AR

Py a0 -Y
BRI UL HAERHERERE

[ThRE]
-Y RIS T HRIR B SO SR AR H ok e WAL ISR, WIS R IEH B AT,
EHEREBEEIT.
(1) <.\dev> (cc78k0s.exe {5 1%)
(2) CC78KOS [IJH sz
(3) H4miH
(4) HEiAF L PATH 558 15

[RZH]
DR B % SO B ARAE IR R BAR, 10 A S E RS IR AR, A R IXAMEIOR SR E B2

[EE]
fdH PM+IN, 4305 & SO I Bl <Project Setup>X)iEHE F1f#]“Device Name:"Itf, shikE 7 —4
Bt Bk, Y IXANG 1 1 B TN BT % B 5 A e XA I T

[ v ]
g T-Y LI

C>cc78k0s -c9024 -ya:\tmp\dev
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5 W G

(19) BAHERUH (-SM)

-SM i AR

S i3 -SM [n] (n = 1 %] 16)

=

NN WA (n=0)

[ZhfE]
FEGHPEIN 15 5E-SM JEIT. 24-SM LI, % HFRgiO s SR, RORTRE-SM et Wiz H
BB Ay A o
—BEOUR, VRS XA LR, T HARAT I LU i R SR SR Rk, T RAG A
HARCE IS mh AT I
FAAE-SM LT, FT LUIRPR I 25 B o DR AE RS B IFANT AL saddr Xk CELn, v ik es 44
T AE AL B, norec BTSN A ZACE, BATINZIFERSEEE) HATSEAA R K RAFIR
(B TAE, e E AR R A 2 AT
T2 leaf A EARILT, WL E A A .

[RZH]
U AR HAR AT, AP TR S5 SR, $i7 2 -SM IR TTHE M AR DIk A A

[#iR]
JRA I A S B AR R I A A 28 e B, RO BB SO B B8 4 B B A X
leaf HIZCHS BRI EUS ORI H 3078 543 B 2 saddr X NAR T FEFFH FJHhE, 220042 R IR0 R A7
fifio BRUAIXANX Sl i A AL 1K) leaf s ERIL=E, T AIXAS saddr DRIBERR A 36 A X 4k
N {ER 7RI XS 23 ) K/
Mn=0 Zin BAAKE, BEaIHKE.
G ieas o MIW%: _ _STATIC_ _MODEL A KA N 1.
sreg/_ _sreq BT LUK E LR EISHOR B AL & . XSG sregl_ _sreg I R £ S HOR
H ARG EC S saddr X, JEAEWE LR ERAE .
8 7 -RK IETHAR -0 28 0L 1) i 32 0 A 3 AR & (B T s b (AL &) 70 I 31 saddr K&, 9F
RS S RFALARAE
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5 W G

-SM i AU
[ERE]

HI TS50 B SRR i, 8 IH R B0 S H0 A 3) A B e iR . i ek S0 A
Gy, R AR R A REC B A Ce v R, B R R, R g
BRI 2 ZHOM [ B AL B )

p SRAE H T P Y R 8 AP T I 55 4 75 AR P (i T e B i el B T RO B 0 B IS
AN B A2 ] BRI .

A BT 55 bR B P R R SR XIS, FETEVAAE ] X P AT OR A7 R [P A

[ 1)

C>cc78k0s -c9024 test.c -sml6
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56 F C guidasi e

CC78KO0S &= N7 3T -
o H bR s 14
o AR H A
o T AL FR 51 2 S A
A X B BRI
R AR A

6.1 AnEEEC
FOARBLER SO 2 — R 5 C YR P2 145 R 10 — 2l 50 fF
WERFRE T B 4y HIET(-G),  H SRRSO R A5 I e

6.2 JLGmIFAE R
TEGRITRLRSC 2 C IERE P 1 45 R I ASCII IR FIZR . S H AR C YRR AT B RV 1 5
PRRE P BRI
WA C YREF LRI 20 S I B SRS X B B IR R SR SR T (-SA) -
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>

C i i i HH SO

&8
(o]
i
R

[ i A ]

: 78KI0S #FI C gwifdt V()x.xx IL4wds LT
; Hl: (2)xxxxx A
(3)xxxxx

; T : (4)-c9024 prime.c -sa
; In-file : (B)prime.c

; Asm-file : (6)prime.asm

; Para-file :  (7)

$PROCESSOR((8)9024)
(9) $DEBUG
(10) SNODEBUGA
(11) $KANJICODE SJIS
(12) $TOL_INF  03FH, 0130H, 02H, 00H

(13) $DGS FIL_NAM, file, 033H, OFFFEH, 03FH, 067H, O1H, OOH
(14) EXTRN . _@cprep

; line  (15)1 : (16)#define TRUE 1
; line  (15)2 : (16)#define FALSE O
; line  (15)3 : (16)#define SIZE 200

(14)_main:
(A7)$bGL 1,13
(14) push hi ; (21)[INF] 1, 4

(14) movw  ax,#08H ; (21)[INF] 3, 6
(14) callt EL@cprep] ; (21)[INF] 1, 8

(18)??bf_main:

; (22) *** Code Information ***

; (23) $FILE C: \NECTo0Is32\Smp78k0s\CC78K0S\prime.c

;5 (24) $FUNC main(8)

; (25) bc=(void)

; (26) CODE SIZE= 222 bytes, CLOCK_SIZE= 654 clocks, STACK_SIZE= 14 bytes

;5 (27) $CALL printf(18)

; (28) bc=(pointer: ax, int: [sp+2])
; (27) $CALL putchar(20)

; (28) bc=(int: ax)

; (27) $CALL printf(25)

: (28) bc=(pointer: ax, int: [sp+2])

; (24) $FUNC printf(31)
; (25) bc=(pointer s: ax, inti: [sp+2])
: (26) CODE SIZE= 28 bytes, CLOCK_SIZE= 108 clocks, STACK_SIZE= 10 bytes

; (24) $FUNC putchar(41)
; (25) bc=(char c: x)
; (26) CODE SIZE= 14 bytes, CLOCK_SIZE= 58 clocks, STACK_SIZE= 8 bytes

; Target chip: (19)uPD789024
; Device file:  (20)Vx.xx
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36 W C g iasdin i SCcf

(3 R ER] (1/2)

G5 il G5 (M
@ ERAS 4 (k) |Baaihxyz
@ (HM 11 (M) |[RGH (BorksX5“DD Mmm YYYY?)
(3) [ 8 (MIEKE)  |RGMT (kg UA“HH: MM: SS”)
4) [T — {E“CC78KOS" Z Ja il eir 4T N2, 80 RN T AT
15 5 ha . S F A5 5 () . — AR AT ER
IR AR — N AT R R
(5) CUESHSME | BAERZGARVIN | hiee SO 4. RSO 2%, 5 e I BRIA SO
F4FR SRR (R4 BE.Ce 80 I AN T 471 15 FITTF
MR . BB AT ().
(6) TG VR BB | BRAERG RV | SR SO o RSO B A, AR SR A (B
ST A4 RR T &) BN .asm”. 80 FJS A R —1711 15 51T 4R
ke H—FHH A5 ().
7 ST — Wt 28O H k. 80 FIE RN AT AT 15 FITF 4%
7 e H—HH A 5()e —NEL RS (T E R R AT
M= AR RR
(8) ot WNME 6 (TAF) | IEXANTAF R E-C 0T, WA KRB & SR SCRY .
9) RS Eih ORME 8 (T4R) | At el Hinth A A $DEBUG Ei$SNODEBUG.
(10) | W AE B 9 (& KJ%) firti NODEBUGA #ifil. #irtt W $NODEBUGA.
Gl
(11) | WFEH BOKAE 15 (AIAF) | S DT gnhsay . v i) 2 $KANJICODE SJIS,
= $KANJICODE EUC, & $KANJICODE NONE.
(12) | TRMER 7 (M KpE) | W TRMGER, Ay, MiER, e, (HRM
$TOL_INF JTR).
(13) | frofEE — B SR (5 RITGEEEASDGS). AT T IHiA%L
P4 B IR A2 X AME R B E T-G1 st A
ST I IR R
(14) | IC4wIRRT — i E TRV G U P P R AR e 1R 45 R
@as) | 179 4 ([ e K ) fnth C UERE PRI IAT 5, VLA R AR -T2k
o, HA A HERHE 2.
(16) | CUREF — FN CURFEPIA . 80 4UJ5 N BT AT 15 FIJT46%
e H—FH A 5().
@ | IreEE — PSRBT S AN (FEUSDGL ) « HAaHeE Tl

Kol i B ITUN A2 AN S BT E T-G1 IETh
N X TR
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36 W C g iasdin i SCcf

[ H IR AR (2/2)
Y i H)5E 5y
(18) P9 (e B A | KMl 34 (T4 | S RER S EE (HRLL? 2 FFmD
ii X R [ AR HA¥ee T RS I U A 2% X ME
(19) G VR A% P | SR 15 (W) | BRI A AER AT EIET-C e, SAEYRFR)Y SO R
M H A& 5o
%
(20) W 2% A R 6 (J4E K %) RN &SI RA S
/N
(21) Ko, I — S AR AT A AR RN RIHAT I TR (fF B LA [INF]FFLR).
(22) EAEESS — BB Bk
(E24R)
(23) ERACEDS — e A AT R AR I H AR SRS (5 B LA SFILE JFUR).
@'&LTD)
(24) PR B — B R ER, H RIS R RITS (5 B LL$SFUNC FFR).
CGE X EHD
(25) HREE R GR — i R BIR ME AP S RIS U5 B (BT A7 aS iR
[BME, RECE
ST HIZED
(26) REER G — AR AD, PUTHIRAISE T H ) e B HEAR i (o
SCRRELIR
AN, R, HE
)
(27) ERACEDS — i RS AR B HAT S, H RS R (5 B BL$SCALL
Q) TFE) -
(28) REE R G — S AE RO I IR PE TS SR R (A7 FIHE
FHBRELTTIR AT ED
FHE, %0
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>

C i i i HH SO

&8
(o]
{1
R

6.3 B RFIR A

BER B SO LA g 1 P R A B T A R A R 515 R

R E AL I, AT LR C IR I IR SR SO Tl B 2 C YR P MR RISk, %
17 C R SRS SCAF AT LU C USRS P B A

6.3.1 XF CEFHERYIRCMH

[ A% 3
/*
78K/0S Series C Compiler V (1) x.xx Error List Date: (2) xxxxx Time: (3) XXXxx
Command :  (4) -c9024 prime.c -se
C-file : (5) prime.c
Err-file :  (6) prime.cer
Para-file : (7)
*/
(8)#define TRUE 1
(8)#define FALSE O
(8)#define SIZE 200

(8) char mark[SIZE +1];

(8) main()
(68X
(8) inti, prime, k, count;
(8) cont=0;
***ERROR (9) F711 (10) A& X‘cont’ ; function ‘main’
(8) for i=0;i<=SIZE ; i++)
(8) mark[i] = TRUE;
(8) for (i=0;i<= SIZE ; i++) {
(8) if (mark(i]) {

prime =i+i+3;

printf ("%6d", prime);
*WARNING (9)W745 (10) W1 s B E .

M

/*
(11) Target chip: uPD789024
(12) Device file:  Vx.xx
Compilation complete, (13) 1 error(s) and (14) 5 warning(s) found.
*/
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36 W C g iasdin i SCcf

[0 H 750 E i 8]
45 i H5 ek

(1) i A= 4 ([ 52 K %) ks U X yz”

(2) H 11 (fil 5 K ) R HW (B DD Mmm YYYY™)

(3) i) 1] 8 ([ K ) RGNTE] (BatE“HH: MM: SS”)

(4) AT — 7E“CCT78KO0S" 2 JaHir i 21T 2, 80 FJEIMN AN T —1T]
1 13 FUFFanst . B A5 (). — AN EE
R AT ] — N2 L T R o

(5) C YRR ST 4 FRHRAE R G SCVR I Tl R 02 SO 4% o A RSO PER R e 2, A PR ER A ST

T2 K ) I 4D H*.C". 80 FIJEHIN AN T —1THI 13 B ah%mH

I 5 ().

(6) RV RSO ERE RS AV A R T 4 .

(PROTIRRE) s ame T, SIS (R4 i

J2.cer’s 80 FIE MM AL 13 HIFTLAII T —4THiH .

(7) SHCOFESR T S HOCE H 3,80 FIR I AN T —1TH) 15 5UTT AT
SE—FE A5 (). — AN ER S AR e R AR A
GIEEZ(E T

(8) C — XM CIEFEFILS, 80 ¥ 2 Ja I AW E T —1T.

(9) REEgYS 4 (B KE) I “#nnn” X U A R g S . I RA AR, WAL E
G CET ., GHREEL, WA AR W "nnn" (iR YR T)
o h 3 AL RERIE (TG T Z )

(10) RPN — UL 9 % ARG E. 80 BXEHINABASR | —4T

(11) G P Ay B B0 BiEOR(E 15 (B R) |HbR R & Em TPl ik mi-C 5, e T s

b B 4 .

(12)  [R&CHRA 6 (e KE) SR AN S RA S .

(13) AR IR 4 (8 2 K E) AN RS 10 BEEIE,  TREEE .

(14) Al A5 B 4 ([ 2 K ) A — AN A S 10 BEHIE, RS H .
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36 W C g iasdin i SCcf

6.3.2 AAHRAF BHHIRFIRIMF
[ i 5]

(1) PRIME.C((2) 18) :
(1) prime.c((2) 20) :
(1) prime.c((2) 26) :
(1) prime.c((2) 37) :
(1) prime.c((2) 44) :

Compilation complete,

Hists A« (7) uPD789024
WA 2 (8) VXXX

(3) W745
(3) W745
(3) W622
(3) W622
(3) W622

(5) 0 error(s) and (6) 5 warning(s) found.

(4) Expected function prototype
(4) Expected function prototype
(4) No return value
(4) No return value
(4) No return value

ELEE)
4 i 7% Fek
(1) | CURFB | BERGAVAN | RSO AR, RN T AR, S MRS
SO R T KA JEAD KO
@ |15 5 () WA 10 IR, TR,
@) | HRERgS | 4 () Fl “nnn® SRl ORI RS S . LR RAR, R
FRLE ., WA, SRR R W, inn® (6
SO ) Bk 3 BRI B,
@) | At _ e L T
G) | HHRRH 4 (52 1H) Wt — AR 10 IR, .
6) | 4 (7 () St ARG 10 T SRR
@) | GEERIE | A 15 (8 | FRRRATER AT P RI-C fhE, SRR
bRk % ) s
®) | Bk crHlA | 6 (il RN B AR A
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46 C G

6.4 TALIEFIR 4

AL A E—Fh ASCI BEGSCF:, ANELEE C AR P AR RS AL .

¥R T KGRI H N R D AL B A I, TRALER A F SCAE AR AT C JRFE P B SCAEAH )
36T -KD LI, fi Ay A #define T REBIR
[ H 4% ()

U 58 5 A 80

/*
78K/0S Series C gnikss V (1) x.xx TikbPEZ1) 3R Date: (2) xxxxx Page: (3) xxx

Command : (4) -c9024 prime.c -p -lw80
In-file : (5) prime.c

PPL-file :  (6) prime.ppl

Para-file : ()

*/

(8)1 : (9)#define TRUE 1
(8)2 : (9)#define FALSE 0
(8)3 : (9)#define SIZE 200

®4: (9
(8)5 : (9) char mark[SIZE+1];
86 : (9

/*

(10) Target chip: uPD789024
(11) Device file:  Vx.xx

*
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36 W C g iasdin i SCcf

[ 4 750 352 B
%' VL 515 %
Q) | A 4 ([ E K ) Wik xyz"
@ | HM 11 (e ) G HW (Bks DD Mmm YYYY”)
(3) | UK 4 (I 5z K %) i —ANADN I 10 BERIE, AR
(4) | AT — TE“CC78KOS" Z JafintliAir 24T N2, 80 SN AN T 4T
113 FU I iRt S AU S (). — AR AT
RFEHRIRATH ] — N2 PR R .
(5) | C BRIt | BAERG RVER | RS RSO G, S RIERIA SO
F4FR FIEL (IS HCTe 80 FIEHIN AT —ATHI 13 SITT 6%
e
(6) | TUARBEZIERSC | BRAERG AV | SRR SO . WRSCHR A g, IS BRI SR
4 T B (PREAD Atppl”s 80 FIJEHIAEM T —1TH 13 51IJTR
Bt
(7 | ZECCH R — Wt 2B H k. 80 AR AN T —ATH) 13 FIJT4h %
o SB—FHIH A T()e —ALL R TR BRI
M= A2 AR R
@) | 'y 5 ([ e K ) i — AN 10 BERIE,  F AR
9) | CURF — KA C IR . I 80 1T K E A AT F—17T 9 41
IR/ TR
(10) | ZWiESRMHIE | B 15 (A7) | HARRETEM AT LIi-C 45 5€ , ST S0
& 5 o
(11) | BASCHRA | 6 (e KE) STRER AN B ST I RRAS

HFA U16654CA1VOUM

126




26 3 C Ymid oy i et

6.5 X5 HFIRIHF
AR S AAEFR R SR L W]y 5 S I oAz . [l i G S L AR 8,
JEYENAT S o S IXEE A T A .

[ 43K
UL THI 96 ) 4 80 I

Command
In-file
Xref-file
Para-file
Inc-file

(9) EXTERN (10)
(9) EXTERN (10)
(9) AUTO1  (10)

(9) AUTOL  (10)
(9) AUTO1 (10)
(9) AUTOL  (10)

/*
(15) Target chip:
(16) Device file:
*/

78K/0S Series C Compiler V (1) x.xx Cross reference List

(4) -c9024 prime.c -x -lw80

(5) prime.c
(6) prime.xrf
(7

[n] (8)

ATTRIB MODIFYTYPE

(112) array
(12) func
(11) int

(11) int
(11) int
(11) int

uPD789024

VX.XX

SYMBOL DEFINE

(12) mark (13)5
(12) main  (13) 7
12)i (13)9

(12) prime (13) 9
(12) k (13)9
(12) count (13)9

Date: (2) xxxxx Page: (3) xxx

(14) 14

(14) 13
(14) 15
(14) 17
(14) 17
(14) 21
(14) 11

REFERENCE

(14)16

(14) 13
(14) 15
(14) 17
(14) 18
(14) 21
(14) 19

(14) 22

(14) 13
(14) 15
(14) 21
(14) 21
(14) 21
(14) 20

(14) 14
(14) 16

(14) 21
(14) 22
(14) 25
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36 W C g iasdin i SCcf

[ e 750 ) 5 B

(1/2)

G

VL]

##% 3

1)

FERAS

TN W 74

@)

11 ([ K %)

RGHM (B 5“DD Mmm YYYY?)

®)

4 (] K )

Bt — AR 10 MERIEL JREEAME.

(4)

1E“CC78K0S" 2 Jainh fr 24T N 2%, 80 FI G N A T —A4T
1) 13 HFF i . S—FlEH R a5(¢). — ML= A
FRFEGHRFFEH — A2 A /R R .

©)

C PRI IF
ELyiN

BAERG AV

TR

e SO AL . WERSCIFR A RS, A I BRIN SR
(P ) A.CTe 80 SN T 4T 13 51T
fts o

(6)

G E
RS

BAERG AV
TR

AR ST AL o WUERSCIFRAL 2, AR IBRIASCAFSR
B GERD txif’s 80 BJE A AN T AT 13 FITT4G
LT

@)

SRS H

S HOC H k. 80 SIS TN AT —1THI 13 ZITT4R%
Ho H—FEHN > 5G)e —DUAERA 7T SR AT AT
M A TAERTR

®)

(e Eis

BAERG AV
TR

i AE C WRE P HIRE ISR N 1 DTS 5 8T
RSP SCTS o EL 80 AT KN AAE AT
13 HUTT ARk o BeA B & SO AN R AT A

9)

%

‘_l,\
il
H
FE

6 (Il 1K)

BT E

HhiAs B ] EXTERN 753, AN A48 B ] EXSTC %R,
WA INSTC o, FIZ)AE R AUTONN %05, 7747
BB REGnn o GXH nn Fonvall, g5 M 1 F
WHEM), AME typedef FHIH EXTYP 78, Wil typedef
A INTYP %78, #5250 LABEL £, 4RIt

AFREH TAG F£or, WA MEMBER £oRr, 3R
PARAM %75,

(10)

1 Wi il
1t

6 C([HEKED)

AT ErE (a5 AR CONST %7K,
volatile 28 8 ] VLT £7R, callt % CALLT FE75, callf
PRHUA CALLF 718, noauto B NOAUTO %7K, norec
PR NOREC #7i, sreg-bit 454l SREG %R, #ijk
ThRE P A A e FH RWSFR 7Rk, MERE sfr 488 H ROSFR
FoR, MEE sfr AR WOSFR %ox, Tl VECT
LKoR.

(11)

7 ([ RED

SORFFS R, RRALFE PR, R A KA
FB.  DEWHFRMR LR T, HA R IR A 252
A, YUK RE . K XURSFE(long double). BR. 34, 45
By gER. BRA . M. Lefr. TPl RI#define %2 ¢ L.
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36 W C g iasdin i SCcf

[HH I EA] (2/2)
TS 1t Bl Y5 #3
(12) | 58 15 ([ KJE) WRFF S 2B T 15 MR HHEA—1T, IS 4
s« RS 4 16 NP HBE Tk
FE, IR N F—471) 23 ), 13 TR 14 WA~
—47T 39 FHH .
(13) | e Ty 7 ([ E K E) e SIS HEZ AT S, BoRs sl
506G AR wE .
(14) | FE5IHITY 7 (Ee K S HA S SCHEZ AT S, BT
756 ). A& SCEEL, WRFTA N BB TS,
FIRNBENT AT 47 B TR H
(15) | AR Hix I KAH 15 (ATAR) | HFR B &AAEM ATl EN-C 8¢, sAEIRE R 3CoF
W FEE
(16) | WASLIERRA 6 (Jix K %) WIREI N R SR A S
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BT E CHBESRNMERITIE

7.1 FRERAE (EXIT RSERH
MY PELE RN, CCT78KOS [ e RGUIR Mg PRt FE g™ F A RS, 1E 8 EXIT RE.
EXIT R&W
AEHEHR: 0
e 0
OEERTR: 1
Rk 2
WA PM+, CC78KO0S iz T Tn AT IEZ, WA FHHEAC BRSO o RS — 2D 38 md A E R
[ FH 514

cc78k0s -c9024 %1

IF ERRORLEVEL 1 GOTO ERR
cc78k0s —-c9024 %2

IF ERRORLEVEL 1 GOTO ERR
GOTO EXIT

‘ERR

echo Some error found.

EXIT

(Ui ]
WR G PER] 1%J5 K C PREFAIN B T — AW EAT IR, WABT LB, 7 AR B R Ie gk 8eab H .
EERN IR T EXIT AREIRBIRE 1, v DU AT, TC T GREAE LS 11 2% 7873 1) C ALY .
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7 C GniEAs AR ik

7.2 BITTRIAE (AERARR)

B4R R AT AT TR SO A5
INC78KO0S: HRBE IR
TMP: R I SO 12

LANG78K: PP R2EM (ai@id-ZE, -ZS, Bi-ZN $EIsEE)
(euc: EUC 4afd, sjis: AL JIS 18, none: JC 2 F15i)
-LIB78KO0S: HREEN R

[ SE4] C4AEH] DOS s i)

:AUTOEXEC.BAT

PATH C:\nectools32\bin;c:\bat;c:\cc78k0s;c:\tool
VERIFY ON

BREAK ON

SET INC78K0S=c:\nectools32\inc78k0s

SET LIB78K0S=c:\nectools32\lib78k0s

SET TMP=c:\tmp

SET LANG78K=sjis

[¥iEA]

3% c:\nectools32\bin, c:\bat, c:\cc78k0s, c:\tool [ 5% 45 5 i 38 2 v AT S04

o)\ c:\nectools32\inc78k0s H 5 N9 &40, 3

7E Windows R4, WUREARE, 18R C\NECTooIs32\INC78KO0S H % (f# CC78K0S #i %
H:/E C:\NECTools32 #)

ofEEHLI M c:\nectools32\lib78k0s 22 FE Lk

# Windows R4, WnREAT#E, ¥ C\NECTooIs32\LIB78K0S H % (f{#t CC78KO0S # 2%
7 C:\NECTools32 1)

ol SCAFAETBCAE eMmp BT,

o F%3) IIS AL AL FH AT ARG AH )

&)
P PM+I AL AR
7.3 Wi F
IR MRS T AT S01%, WA 28 (CTRL-C) 24T Wi iF . 1 45 E break on’, #4iAF
RGO IR BME R oy A BN TR GG, WHR R E break off, R M HA BoRi A & mEE RSk
BN PME . AR5 A FT TF I B SCEEFI i SO e

WIERARTE ZAE PM+E LT (MAKE), BEF[Run]ZEE R “Stop build”, &ﬁfﬁ‘TEﬁLﬂ"J-}i}“ﬁ%ﬂo
MAE PM+HEESTIN, A & HEAA A TC R
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%8 E BIBIE

N T AT CREF, T 2 — MR RBE REA )RR CEREO ) ROM 4L #£(ROMization) .
AL ISR B IR -

N T PATRI G G IR, AU RE QI — A R sl fifE . CC78K0S Hfit 1 )a s BilFe iy H Ar 3T At
FCrP R AR RE PP AT A% 5 (9 AR BEAN S Sh BRSSO GLGRIRRER ), R AT LMEUR sl RE AU SO F K
RRMRMRG TR KRS BRI B AR SRER B R, ST LRV — T AT IR . BT
AR TR BAT I REHEAT H3E B R T DL B

ARFERGE T EBIREII A A AE S Irik.
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8.1 45t
%) BB FE ) SO AT U w2 s B P A1) SRC\CC78K0S H %+

L BIN

—— INC78K0S

—— LIB78K0S
—— SMP78K0S
—— SRC\CC78K0S

BAT

- WEABGIREAR IR H %

SRC

HLP: LIB

SRC\CC78K0S HxH AT R

LIB H B4 R shBIFR IR H bR SO S J5 (RIS e o 6 H AR SO ) EARMTEAT A A 78K0S £ 41 H b
W& AR AR . WARATERFAMEIE, W LOERE R GRAR B SUORG) B b 0. W HITT
CC78K0S #£4itf) mkstup.bat (mkstup.sh), XA HFRCAFATLLES,

SCFN AN, 2.6.4 FESCHE.
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8.1.1 BAT HEAE
XA H % LA BE SO AN BEAE PM+F R .

HA DGR (EIRUR SR I A3 I L AL P
BAT H = (K184 3CH(d9026. 78K) AN IR IT A1, K 1 BB S5 s A1 1 i st A BESCAFIN AR AT
PRI, SR T A I L e W R B2 ST

#* 8-1 BAT HENHE

fLAb B R4 B

mkstup.bat Ja SR ARV G S Ak 2 S A

reprom.bat FSKEEH rom.asm = [t b B S0 14

repgetc.bat FHRTE BT getchar.asm AL # S0 #E

repputc.bat JISK ¥ putchar.asm (Kt ab 2 SC A

repputcs.bat FKEH_putchar.asm [k AL BE A

repselo.bat FH KB setjimp.asm Fil longjmp.asm FIiLAEL SC A4
(TRAT T G 0 5 90 X 42

repselon.bat K5 H setimp.asm 1 longjmp.asm (K3t b B Sz 14
CRRA7 P P2 LB [ ) 2

R 1. ROMuization BIFEFEREH, T LAFE £ Bl Ak B SCA 8
2. fRIF T RIS T X R setjmp AT longjmp Ch KREGxx{# P4 saddr X1, 225, DLAARME
TSI B X Sk setjmp #1 longjmp (RARTEZFAEES) ZRABAIEE.
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8.1.2 SRC HEHE
SRC H U A IR YR ROM BIFERIFREE RS GE00). RN RS ERIERE T

DAFESL, W LISHXANERE S S, I BAT H 3 i MBS T g, it B @ B i 75 1)
H kRS
% 8-2 SRC HEWNE

JA B BIREERE P S A4 Wi W
cstart.asm * A BNBIRR R IEAR P SO (f FH BRIV )
cstartn.asm Ja SRR IR FE P 30 (R A8 F BR i )
rom.asm ROMization {1l F2 135 SC 1
_putchar.asm _putchar Ifig
putchar.asm putchar Hfig
getchar.asm getchar 6
longjmp.asm longjmp g
setjmp.asm setjmp Z g
def.inc RS e tD S STNLE
macro.inc AN PR 2 5 X
stdio.inc 4y EOF Ml LF %8 £ 54

e SR n BRSIBIREA L SRR AR BE o IR AR I A ] SO 4470 n A BT RE
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8.2 #bALH A4 B

8.2.1 ERuJA IR I HEAL B S

BAT H %) mkstup.bat (UNIX H(#) mkstup.sh) 2k 6% 5 Sh IR K H Ar S0k

RA78KOS I 4 P2 554 B9 2 28 %) mkstup.bat (mkstup.sh)sie it & 6 75 5. BRI, 0 Rk 468 2 k12,
T B AR RIS AT

DU PEAN AR R I AN SO A L U5 i

[nfAI & ]
7E 402 mkstup.bat (mkstup.sh)f src\cc78k0s\bat H s AT U T 247

mkstup BRI

E WS SRR .

[ F SE 4]
e SR ¥ /3 30 1R A 14 H b B #6 2 4P D 789024, .

mkstup 9024

mkstup.bat (mkstup.sh)#tALFESCHEAEAETE LIB HxF, eSS K8 SBIFE B As S0, LIB H Al
N SR BAT HAE R —2 H

T BEE RS B ARSTAE I S Sh IR S i 3 — AN H 5%

11 LIB UL H AR SCAF I FR 0T

LR —m —— sOs.rel
sO0sl.rel
sOss.rel
sOssl.rel
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8.3 B3z

8.3.1 HEIFIRMR
JABBIREIE N THATH P 9511 C JEREFMAERIMERS TAE . W& PRy, LA
AR, eSO T ASE R B AR

(1) Thek
TSIk, D& ARSI ROMization F1 C YL 1 T A BEFE M &K L BEREHE 48047 .
ROMization: 7& C JEFEFH & LIMAMNHEAR R #ERER sreg 28 & WYHHEA B AAILE ROM Hi,
SRT, ROM HAR R EILIATS; HAEYE ROM HRFFISEAAL . ik, EAF] ROM H FIHIE L6 25 5 il
3| RAM F1 L1217 . XA FEN fif ROMization. MFE/F# 5 N ROM J&, 7] LA E AL BE 28K 8 H AT .
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(2) &
% 8-3 on T 5 EEFIREA S RS A TR B B Ol

* 8-3 Azl REMA

IEEEEE

IR BE.
(i hwinit i
ﬁ)ﬁiz

|  ROMization |

IEEEEEE

| Jii b7 |

& X ROMization H 44 FH 11
FR%:

e 1. WA R ARVEE, e ST AR AR B . TR S R R S 4 S TR N n” (K S Ak
BN 5EEEE G, SCIER AR RN N SCEAS 75 LA B ARV 1A
2. hdwinit B 2 H 7 J5 BTSN 3% (sre) HILALET A 4. Bl Al hdwinit %L, #)
BRI TR A BN CRIER S AR v BLE E s B se 0. A P ASBIEE hdwinit R4, BEAS
AT AT Ab H 5t L iR ]

cstart.asm Al cstartn.asm (N2 LT 564 .
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2 8-4 JR/R T cstart.asm Fl cstartn.asm [ AR 2 AL

%% 8-4 cstart.asm Fl cstartn.asm ¥ [X 5l

JA BRI SE T ff P Ab 2R
cstart.asm =
cstartn.asm &

(3) Bzl
%% 8-5 545 T CCT8KOS Jy Ji sh Bl REH ML 1) FI AR ST 44 7K o

*® 8-5 YRS SCAFAT H ARSI LE AL
SCAFRRY P FlbRSCpt

JA B cstart*.asm %! sOs*.rel 2

ROM {4 rom.asm AL

F L% R MAREE, AR Rien. WRER T, ST .
2. % WIRMEH] T RRER T A v AN e O, R B
WA R T A EASES, WFEZm s,
rom.asm 3¢ LT HR%E, HK$7n ROMization il F iR £ &2 1 45 i btk . rom.asm 19 H B & 1E
e
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5

8w Bl

H#

8.3.2 HHIBEFHIYLI (cstart.asm)

AT cstart.asm A1 rom.asm A5 4 i 11 i B A S BRI o R S BT RE O FE FAL BE L B)AR P B

ROMization 4b# . )5 3l = 06 BORN 5 Ab #1243
v A cstart INRFEAERTHN_@, BIASACh_@cstart.

(1) Thsb#g
cstart.asm T { AL FELE<1>F|<6>T i (AR ).

[cstart.asm FHAbEE]

NAME @cstart
$INCLUDE (def.inc) <I>AL 73
$INCLUDE (macro.inc)
<2>[EY) R
<B>F5E X
BRKSW EQU 1 :brk,sbrk,calloc,free,malloc,realloc function use
EXITSW  EQU 1 ;exit,atexit function use
$_IF (_STATIC)
RANDSW EQU 0 ;rand,srand function use
DIVSW EQU 0 ;div function use
LDIVSW EQU 0 Idiv function use
FLOATSW EQU 0 ;floating point variable use
$ELSE
RANDSW EQU 1 :rand,srand function use
DIVSW EQU 1 ;div function use
LDIVSW  EQU 1 Idiv function use
FLOATSW EQU 1 ;floating poin variable use
$ENDIF
STRTOKSW EQU 1 ;strtok function use

PUBLIC __(@cstart, _@cend

$_IF(BRKSW)
PUBLIC _@BRKADR, _@MEMTOP, _@MEMBTM
M
$ENDIF
<4>HERR S AT BT s R A5 A 5 | FH 75 Bl
EXTRN _main,_@STBEG,_hdwinit
$_IF(EXITSW)
EXTRN _exit
$ENDIF
<5> ROMization &b HARZE AN 5] H 75 B

HFA U16654CA1VOUM
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o 8 & Bl

EXTRN _?R_INIT, ?R_INIS, ?DATA, ?DATS
<6> 7 bRHE PR A P 1X ik
@@DATA DSEG
$_IFEXITSW)
_@FNCTBL: DS 2*32
_@FNCENT: DS 2
M
_@MEMTOP: DS 32
_ @VEMBTM:
$ENDIF
<I>f & kot
def.inc - FRPGRI U B

macro.inc — BEAS I A R 1 2 5 o

<2> )
WA R AR E I, W EQU I Xk 0, 2 {7 B A FH (W FE AL BT 75 25 1), A
FH BT 5 0 2 1)t [F) R 2 A B o BRI B0 2 A A P Cln SR S Sh 9 R o T 5 R AR 3, AR HEAT XA )

<3555 3
5 A PR BT 6 015

<A>HEM T T BI755- 4085 1 A

FHFHEI XA S (_C@STBEG) MBS HAH. _@STBEG A A& MM X 5k 1 #
A Hhk+1,

FEEPAE PR ER S ERGET (-S) WA AZhAE K _@STBEG LA i/, Rk, 24P
SPRE-S BRI, KRBT, feeHR T RIS TR . IR A R A, B RAM
Xk (FIRflE—ANEEG A 30 dink directive file), W LB AR X I8 58 (7 BIT(THE Ty o D6 TA47
fitr ARy, AOE S H AR BRI T

R AN ER A A SR o R A SO —ANSUAR SO, AT DA H P A T g e e P e

TR THEM AT, W5 RAT8KOS LA E R ER /7 FM(UL6656E)).
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[fEEh¥5 E-sSTACK HIBIF]

B Ik78k0s.dr GEHEEAA ). BT ROM Al RAM [#73 FC#k 38 ik 51 F AR BES Hh 1077 4 2 ke it
AT BN, BTUANTE 2445 2 ROM FI RAM [ 43AL, BRI B AR o i B4 4 2 1 smp78k0s\cc78k0s
F % i 1k78K0s.dr 3C1F.

T ik KA

y

memory SDR: (OFE20h, 00098h)

memory STACK: (xxxxh, xxxh) «—  EIXHIEE MR N, R —d
HEHAREIURTE 2 1k78Kk0s. dr.
(g -d1k78k0s. dr)

merge @@INIS: =SDR
merge @@DATS: =SDR
merge @@BITS: =SDR

<5> ROMization 4t HUFRZS 48T H 75 8]
ROMization A& 2R AT IKIFR -5 7E J5 Ab 138 7 8 X

<6> 4y Rt P O B DX
SRR AE 2 A FH T 1R DX A T PR B
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(2) VIt BEE
cstart.asm HHILHN I EAE<T>F]<9> T N LA

[cstart.asm F IR E]

<7> EAinERE
@@VECTO00 CSEG AT 0
DW _@cstart
@LCODE CSEG
_@cstart:
<8> SP (MEtkFatr) ik E
MOVW AX# @STBEG ;SP <- HER stk
MOVW SP,AX
CALL ! hdwinit <9> FEAHIAA AL R EGR
$ENDIF
M
$_IF(BRKSW OR EXITSW OR RANDSW OR FLOATSW)
XOR AA
$ENDIF
M
<T>EA N EERE

L) R B E N o BEE A SR R 4 i i

@@VECTO00 CSEG AT 0000H
DW _(@cstart

<8>HEHIREN(SP) R &
¥ _@STBEG fENHEMLTRE .
_@STBEG Ml il 7 A2 b A HEAR I T 4 R 48 e 15 5 2B i i (-S) Hah b K.

<O>REFAT a6 A R K0 T
M A ORI AN B % (SRE) I, QU Hdwinit e85, it QXA R %, WIaR i
FACA T REIL S 7 H AR
WAL A QU2 hdwinit B AT AR BEE E F R [E] o
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5

8w Bl

&
i

(3) ROMization At ¥
N H4i& cstart.asm H ) ROMization.

[ROMization Ab#E)

*kkkkkkkk

;ROM Bohn 42

ST AT 5 A B
MOVW HL,# @R_INIT
MOVW DE,# @INIT

LINITL:
MOVW  AX,HL
CMPW  AX# ?R_INIT
BZ  S$LINIT2
MOV  A|[HL]
MOV  [DEJA
INCW  HL
INCW DE
BR $LINITL
LINIT2:

MOVW  HL#_@DATA
LB YIME R A A
LDATAL:
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£ ROMization 1, fiif7#£ ROM HIAMNBARYIMHEA sreg AL RAIIREAH L HIE] RAM 1o 3 K&
AR PUFRAL () F) (), 7wl R:

@N)
char c=1; (a) HVIMEMIFN AL 5
int i (b) BATHME A A ™
_ _sregint  si=0; (c) FAVIMEN sreg A& 5
_ _sregchar  sc; (d) BATHIME sreg AZHE®
main ()
{
M
}

E RAVHERI SN A S REATYMER sreg RRITH LS, XVK RAM HEGE.

Kl 8-1 Bon T () VIMERISMEAE & (1) ROMization 4b P f4 .
T () MWHMERH SERIMAE ROM T H@@R_INIT Bt. ROMization AbFEA4iX L5(f & HI %] RAM HhfH)
@@INIT Bt (8 (o) bRt 5t AH R,

{@@R_INIT F I FRZEMARARZS M X @R_INIT 1 _2R_INIT. @@INIT B4 FREEFI R AR5 5
ESH _@INIT #l_2INIT,

Apg (b) Ml (d) LHEH, RAM XN B HEGEZ (IR 8-7 #MEAE RAM X (41K B i
). % 8-6 fIk 8-7 Br TR (a) fl (d) JUEM ROM B4 FRF RAM BE4FR, LKA BERHIME
M ARARE
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& 8-1 ROMization #b3 i 74

@@R_INIT (B42) @@INIT
_@R_INIT: _@INIT:
(EHR2)
_)
AP B (@) WIME M =4l
A7k X 3k
_?R_INIT: _2INIT:
(KFR%ZE)
% 8-6 WIMEHAE ROM H [ [X 1
A e Bt R HhREE
HHMERINBAZE (a) @@R_INIT _@R_INIT _?2R_INIT
HHMEN sreg 25 & (c) @@R_INIS _@R_INIS _?R_INIS
% 8-7 WMEAE RAM F X4 (A HIH B brHbib)
A Fr R Bt HhREE AR
HHHEMAINBZ 8 () @@INIT _@INIT _2INIT
TCHMHE M RAR 1 (b) @@DATA _@DATA _?DATA
HYMER sreg 4 H (c) @@INIS _@INIS _?INIS
TCHIME) sreg 25 (d) @@DATS _@DATS _?DATS
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(4) BE)EHREN G b
cstart.asm )i 2l 3= B EUR 5 Ab R ) i IE

(/A 3h £ B HOR 5 b 2]

CALL | main :main(); <10> JHBhER
$_IF(EXITSW)

MOVW  AX#0

CALL ! exit ;exit(0); <11> JH3) EXIT B4
$ENDIF

BR $$

’_@cend:

;<12> %} ROMization 4t

@@R_INIT CSEG A5 FH () BRI bR 2 AT 38 S

_@R_INIT:

@@R_INIS CSEG UNITP
_@R_INIS:

@@INIT DSEG

_@INIT:

@@DATA  DSEG
_@DATA:

@@INIS DSEG SADDRP
_@INIS:

@@DATS DSEG SADDRP
@DATS:

@@CALT CSEG CALLTO
@@CNST CSEG
@@BITS BSEG

END

<10>/88) FE R
FRREHE A o

<11>3 8 EXIT B3¢
WA, WA EXIT B

<12>3%} ROMization 4bE 48 1 (K1 BFIRRAEEAT 58 S

FEXT () # (d) HAEETE ROMization L2 1) BeFIbR2E (I 8.3.2 (3) ROMization &3,
BAR/R TR EYME AL, FRSTR R B B & ik
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1% ROMization 4bHESCAF rom.asm #8. rom.asm AT E AL SCAFEE A

NAME @rom
PUBLIC _?R_INIT,_?R_INIS
PUBLIC _?INIT,_?DATA,_ ?INIS, ?DATS
@@R_INIT CSEG :<1> 52 X ROMization AbF rp A F (R hR4S
_?R_INIT:
@@R_INIS CSEG UNITP
_?R_INIS:
@@INIT DSEG
_?INIT:
@@DATA DSEG
_?DATA:
@@INIS DSEG SADDRP
_?INIS:
@@DATS DSEG SADDRP
_?DATS:
END

<1>5E Y. ROMization 4bF A F k5%
5E X T 7E ROMization b#irh (a) #| (d) FraLaM s (I 8.3.2 (3) ROMization &3, X
UERREEARTR T A AN AR B AE I B W A ik
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8.3.3 BB HITE
A LA CC78KOS $24E ) JE SRR 3E 4746 e LIl A2 B4 H bR R SRR 75 3K o AXTERE A G5 X S 5
KI5

(1) BHEFFIFER
TR T B 45 R R R P S IR A O S AT UL . B XU, T src\ec78k0s\bat H 3% R 1)
mkstup.bat (mkstup.sh)xH & SRR T3 (estart~.asm) (%1 PR HIFF5) LS

T I R B T TS
R T % 8-8 T A AR B, 78 BhFIRE (cstart.asm) HrIX 8 g Htt I (1) B A3 75548 ) LIRS o
R, TR T EXIT %, _@FNCTBL fl _@FNCENT ANBEMIEE CE Mk T EXIT
PR, DK SEEAE S A T DI R D o T I R 1038 vl DA A 8 P 1) 2 e 00 B 545

% 8-8 Ty AT AN AT

TR PER RS

brk _ermo

sbrk _@MEMTOP

strtol _@MEMBTM

strtoul _@BRKADR

malloc

calloc

realloc

free

exit _@FNCTBL
_@FNCENT

rand _@SEED

srand

div _@DIVR

Idiv _@LDIVR

strtok _@TOKPTR

atof _errno

strtod

7 RIBAT I
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A7t 5 pR R h A A DX
DR 52 SCT A fid e R RO P DR RN A 9o 5
(12) WRARAR D A7t s R B DR B 72 7, ek sh R 0 4G BE A T sl
_@MEMTOP: DS 72
_@MEMBTM:
_@MEMTOP -
AT A o o KR B
T 72 AT IR
_@MEMBTM —

AR SR E XIS K, TEAE RAM Y, FESERRIN 2 R A ik
PRIE, 5 e ), SO SO A SO AR S %, R TR . RHER A SO B O
S (2) Eard 3t

)RR RPN

_@MEMTOP: DS 72 | » #ch 40
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(2) E#Zar& Xt

AT R e B R A 2 SO MR B BARI B AR R A, FH-D iEWORER € — AN IE S, A
ASCPFRE R R RS GRS IR J7 1:40E 2% RAT8KO0S L4 E P8 EF M
(U16656E)).

-CC78KO0S 7 I £ i HI 3 /3 45 37 BN -0k 3 (saddr [X45%) SR Ab 38R IHI R a8 48 i 5 o 002 M 3 AR 7Y
f¥) FED8H | FEFFH [1) 40 75, 448& T -SM[NJIETEE A F AN, saddr K134 XIS [FEFOH
FEFFH]{E A 23 F X A8

(A
(@) BATIZI Cruntime) [ Z44[FEF8H 2] FEFFH]
(b) norec M¥L ) B AL BB S H([FEESH F| FEF7H]
(c) feE—qr KL 1) %5 17 4% A2 fE[FED8H %] FEET7H]
(d) FRAEFEATS (X4 (b) F1 (e MI—&5)

AR AME I bRAEE, X (d) AL

(FRARIAD)

(a) X IR[FEFOH to FEFFH]
TR Al R 4 SCPE(IK78KO0s.dr) B 38 RAM 28 [0 KNI o MER A7 2 23 I KNI, AN 5 5
AN R T B o 4D AR AT il o KN 375 2 D) LA o U 45 1 P 7 L S 155 100

<Ik78k0s.dr>
T ik AN
memory RAM: (OFBOOh,  00320h) — ¥t A/ NI BOR.
memory SDR: (OFE20h,  00098h) CArRify 2o AT LME A )

merge @@INIS: =SDR
merge @@DATS:=SDR  [—> & BRINTE B &
merge @@BITS: =SDR

W SRR A B ATAE AL, T BN INE I (Merge) EA). 40 FAEH T 16 el dm 3 28 Y X B 42 Bk 1) B8
B, XABATLAMSTEAL (MUES CC78K0S ES A A FM(U16655E) 5 11 ),
0 G BT BB S IANRE N B AT N BRI N (R A 2 8], D)5 e 2R A0 1 ) A7 i s 5 WA E )
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FOE HIRER

9.1 4HiRfERMK

R BT .

WA (1799) - HRER

i

prime.c(8) : F712 Declaration syntax

prime.c(8) : F301 Syntax error

prime.c(8) : F701 External definition syntax
prime.c(19) : W745 Expected function prototype

{HE, PNEpESR F101, F103 Fl F104 & 4# R o5 s 2.

[xxx.c <yyy> zzz] F101 Internal error
[xxx.c <yyy> zzz] F103 Intermediate file error
[xxx.c <yyy> zzz] F104 lllegal use of register

xxx.c: XL, yyy: 115, zzz: {512
9.2 HRfFEERR
Y ] BRI ME B R0 R

(1) AATHRE R

(2) PIERES R AT i AN R E B

(3) FHHEHIR(E B

(4) MCEITCREIRG B

(5) HeitR{E B

(6) FikzUiRME R

(7) WEAETRGG R

(8) 7 WIml R e SUAK TR E B

(9) WULFEFRAHIRME B

(10) FEFSC{ 1O FLgAT FARHRE RGN EN AT B

HFA U16654CA1VOUM
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9.3 HiRFRIIE

FEAEERR G ROV AT, T 2B IR 5 A AT I T ARG 5 Ui TR A B2, i
WY T G P s RZ A 1R AR AR B
B SR W R

A/F/Wnnn

FH L
FERR AR S 2 5, Sk ds L RMs EAC P H BRSO R iR AR RS AN 2
B o
F: mEA R
FERE AT R 205 BRI > Bl N, [N PR AL B Sx QR BEEAT o ANefan i H AR RSP
FI G i e PR S A
W L
FER RS S 2 5, AL BEAR ST o EIRR A I SO IR W
nnn (3-f7 %)
From 001 Error message for a command line
From 101 Error message for an internal error or memory
From 201 Error message for a character
From 301 Error message for a configuration element
From 401 Error message for conversion
From 501 Error message for an expression
From 601 Error message for a statement
From 701 Error message for a declaration or a function definition
From 801 Error message for a preprocessing directive
From 901 Error message for fatal file I/O or running on an illegal operating system

TR MR LFHERELE, XHELSMARERERT. ERERORM. BRARRERS
FriE B C Guidas RARTE S ATE.
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(1) TR RER<SGiS M 001 FiE> (1/3)
A001 B Missing input file
J5 A B NS B R E
Xt o fii il “Please enter ‘cc78k0s--’ if you want help message™{5 &..
-, -2, BR-H IEIORY B SCAE, RIS RS SO .
A002 {52 Too many input files
J7 K 88 T 2 M ABE T4 .
X 5K Hi i “Please enter ‘cc78k0s--' if you want help message™(s & .
-, -2, Bk-H IO YS B B SCAE, R ER IS4
A003 5 15 Unrecognized string
Ji A FEAE H. A AT R E B GANIE RS IE R U (K1 10
A004 (EPSS lllegal file name
Ji A FESR R SCA A AT T AN IEF A Al
A005 {5 & llegal file specification
J5 K] F5E T AN ARERI ST 4.
A006 5 File not found
J7 K FEE AN AL
A007 5 15 Input file specification overlapped file name
Ji A B A B RS .
A008 (EPSS File specification conflicted file name
J5 A FEI /O U A .
A009 15 B Unable to make file file name
J5 K] PR 4 58 F g R SO Q2 A7 AE, JF BOR Ry, PrbiAaesi .
A010 (== Directory not found
J7 K i R SCAE 44 R R IR KB Bk H S ANFFAE
A011 5 15 lllegal path
Ji A TEBR RS HOBL BRI fr e T AR R4
A012 (EPSS Missing parameter ‘option’
J5 A EADTHNSHRAA W E.
g+ i “Please enter ‘cc78k0s--' if you want help message™{% & »
M-, -2, B-H TRV 3Bk, RRHERAIEf S5
A013 {58 Parameter not needed ‘option’
J5 K] 8T AL ERIEINS .
X 5K Hii“Please enter ‘cc78k0s--' if you want help message™(s & .
-, -2, Bk-H BBV B B SCAE, R ETI 2
A014 5 i Out of range ‘option’
Ji A XIETHE € S HEE T T R VFIE .
paK HiHi“Please enter ‘cc78k0s--' if you want help message™{& & .
-, -2, B-H EIOR S B B SCpE, R R 25U .
A015 (EPSS Parameter is too long
Ji A FEIETNS RO P A A8 H R T R EIE
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(1)

AT AT AT S <5 A 001 JH4f> (2/3)

A016 (=95 lllegal parameter ‘option’
JE A (RIS P BRI .
pap HiHi“Please enter ‘cc78k0s--' if you want help message™{s & .
fHEH--, -2, Bi-H LIRS R BRI SCAF, RSN IR 1 T
A017 fFR Too many parameters
J5 A IS B T B
A018 5B Option is not recognized ‘option’
JE A figoE T —ANAIET L.
pap HiHi“Please enter ‘cc78k0s--' if you want help message™{& & .
fHEH--, -2, Bi-H LIRS R BB SCAF, RSN IR 1 T
A019 fFR Parameter file nested
JE A TESHA R E T -F i,
X 5 AR HOAP TR & SHOCE, WILHATIBIE, LBRSHCIMRE.
A020 f5 5 Parameter file read error
JE A AT BRI
A021 fFR Memory allocation failed
J A R N
wo22 | 55 Same category option specified — ignored ‘option’
JE A [ & T 2 A AR R P 5 ) 1B T
it R HRE R TUR AT, IFAREE AT AL B
wo23 | 55 Incompatible chip name
JE A P A AT AR R IR B 4% JERURIERE 7 vh i s (K i 4 AT P 5e
it DA AT 4R I B R A A 1
A024 55 lllegal chip specifier on command line
Ji A TR AT PR E I B AL A ERAIY .
w029 | 55 ‘-QC’ option is not portable
J5 A -QC ETATFA ANSI ARHERITE (OCT-QC M4y, iS58 5 & MikiE;N).
wo3l | 5 ‘-ZP’ option is not portable
JE A -ZP SEIRART 4 ANSI ARUERLIE (G F-ZP 41y, HiESA%E 5 = 4Ri%Em).
wo32 | fFR *-ZC’ option is not portable
J5 A -ZC IETATTE ANSI BRSO 1-ZC AT, HUEZIHE 5 % HiFEm).
A033 f5 5 Same category option specified ‘option’
JE A [ 8 T 2 A AR IR P S ) 1B T
o} #iili“Please enter ‘cc78k0s--' if you want help message™fs ..
R -, -7 B —H IOk i F B SO, I AT EE .
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(1) i ATRIRTE B<%5 )\ 001 JT4A> (3/3)
wo3e | 55 ‘-ZI' option is not portable
JEL A SZI IR & ANSI FRyERITE O6F T--Z1 4175, WiES 0% 5 & Hi%EIR).
wo37 | 5l ‘-ZL’ option is not portable
Ji 1A -ZL IR FE & ANSI ARHERIECHT-ZL 417, HOH2 038 5 8 MiFED).
wo3g | 5 -ZI" option specified - regarded as -QC’
JR A DK 46 € -2 1 L AR ARG L A E P AP RO AL PR, I LU B e ARG 1 35-QC 3 2L
wo39 | 5K ‘-SM’ option specified - regarded as -ZL’
JE A KGR E T R HRETI-SM, T LAEAC R R Y P R b B - ZL S50 3 BT 2K
wo40 | fFR ‘-RK’ option required -SM’ - ignored ‘-RK’
JE K HATRE THAHEILI-SM i, A BRI ET-RK 44 H 3 -RK LI 20 .
wo41 | f5H ‘-SM’ option specified - ignored -QR’
JR A KR E T A BRIET-SM, 777 A8 L AE T-QR i 2% .
wo4s | 51 ‘-SM’ option specified - ignored *-ZR’
Js K] PN T # AL TR-SM,  pasca p6 B M L TH-ZR 4 20 .
wos2 | 55 '-ZD' option specified - regarded as '-QL3'
JR A o8 TR 145 R (-ZD) BRI, PRI-QLA BETRHE 1 1E-QL3 M TG A b B AR UE AR R e itk
Ti(-QL).
woss | f5 '-ZM' option required '-SM' - ignored -ZM'
JE A HAYRE TSR AL I-SM I, SRS RS IIED(-ZM) A XA 3. -ZM LEIg 20 .

P FM U16654CALVOUM 156




(2) AHHRMNFHERMEB<®mSA 101 Fih>
F101 (= Internal error
JR K PO AR R A
X 5 IR BARS F .
F102 (=Fs! Too many errors
JE A PRI EOR L T 30,
i SE PRIk SEHEAT, (RS SRR AR AN . SERTRORT IR P RE S SR 2 IR R T LA e iH IS e il
KA R
F103 7R Intermediate file error
JE A BN ST 3R
X 5k TR R PR R
F104 515 llegal use of register
J5 A AR 35 A7 4 B D7 AN IE
F105 55 Register overflow : simplify expression
JE X FiEAE THR, SEEATRETEAE T,
XoF 5 x| A 1R 0 A ARk s AT AL
A106 15 & Stack overflow ‘overflow cause’
JR K MR o T BE AR O R A
X 5 IR B S R
F108 (P! Compiler limit : too much automatic data in function
JE A h BB R F B AR S S IX G T 64 KB 1B
xR AR, AT XIS 64 KB,
F109 f5 5 Compiler limit : too much parameter of function
JE X BT SO IC IX BGE IE T 64 KB A BR .
XF 5 WO BRI, AEHPT S XA 64 KB.
F110 f5 5 Compiler limit : too much code defined in file
JR A A SCAT R AR 23 B X 0 T 64 KB R BRI
F111 f5 5 Compiler limit : too much global data defined in file
Js K] h AR ) A JR AR B AR I I X R 1 T 64 KB R B
F113 (=F5) Compiler limit: too many local labels
JR K TE— A RREPE U A AR S B o T Ak BB
X PRECAR ST R, O AR )
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() FRAHREE<GTM 201 Fih>
F201 (= Unknown character ‘hexadecimal number’
JR A FATHRE 58 P93 B 10 - R TE 245 A o
F202 55 Unexpected EOF
Js K] SO IELERRAE I, SCIESE R
w203 | f5H Trigraph encountered
JR A HIL T =T 7513 T oK)
xR WRARE T-ZA I, T =R ARG A g .
(4) WMETERHRAMEE<HmSMN 301 FiE> (1/3)
F301 fFR Syntax error
JR A AR R .
xR TER A AR AN BB R AR
F303 f5 5 Expected identifier
JELA goto i) EERR AT
Xt IEHffiiR goto 1 A AL HI IR AT o
w304 | f5R Identifier truncate to ‘identifier
JR K FEEIARRFT R, ARIRRT (RIS FRIZL" D IR 8H B T 250 76f.
X 5 TSR AR A
F305 (=Fs! Compiler limit : too many identifiers with block scope
J5 A FE— AP Z I PTE R E /T
F306 Is! llegal index , indirection not allowed
JR A HERIBAPEH RG], BRI R 5.
F307 B8 Call of non-function ‘variable name’
Js K] A A AR
F308 55 Improper use of a typedef name
S A typedef & LKA BT 5 EAN L
w309 | fFRE Unused ‘variable name’
JE A PEYHSCAT A WY PR A R A I
W310 (P! ‘Variable name’ is assigned a value which is never used
JR K 2 A AR IR BTG FO b, ZE At T AR AT L.
F311 f5 5 Number syntax
JE A wRERIE AR,
F312 (5! llegal octal digit
JE K E[SERIPACE Tk
F313 55 llegal hexadecimal digit
JR A A 7SI
F314 f5 5 Too big constant
Js K] WRERORH N T RORTEH, oA IR,
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(4)

Ao B LR G <5 M 301 FFis> (2/3)

F315 fFR Too small constant
J A W ANGER IR .
F316 515 Too many character constants
J5 A TR R T PN
F317 55 Empty character constant
Ji A FRERECONT .
F318 (=F5) No terminated string literal
JE A PP B I e DX F ] 5
F319 f5 5 Changing string literal
J A FRHR RS,
w320 | fFR No null terminator in string literal
J A FRFER SR RS null 745
F321 {5 5 Compiler limit : too many characters in string literal
JE A TR B SO AT 8 H B T 509 4.
F322 55 Ellipsis requires three periods
Ji A RPN, ARG S THE=A R
F323 (=95 Missing ‘delimiter’
JR A G PFFAIEA o
F324 55 Too many }'s
JE A LAY WA IERICN .
F325 fFR No terminated comment
JE A TR IR B AT A ke 1
F326 f5 5 lllegal binary digit
J A PR BRI
F327 fFR Hex constants must have at least one hex digit
J A FEF SRR R R IE X 2D T E AN IS
w328 | 55 Unrecognized character escape sequence ‘character’
JR A B SUF S5 Joi BRI .
F329 55 Compiler limit : too many comment nesting
Ji A TREIRE I UG T 255 J2= 1B
w330 | 5 ‘-ZI' option specified — int & short are treated as char in this file
JE A ZI WEIRAEIEE . SCIEFR I int A1 short 87 44 char SRIUBEAT AL B,
w33l | 55 “-ZL’ option specified — long is treated as int in this file
J A WEFREM-ZL T, SO Long 2B B 18 int REDRIAT A HE .
W332 fFR Non-supported keyword found — ignored ‘function attributes’ in this file
J A RIS B o A SO 1 o B A 205
w333 | 5 “-SM’ option specified — ignored ‘function attributes’ keyword in this file
JR A fioE T ABEUET-SM, ARSI 1 ek HUE b 2
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(4) BETREREE<MS I 301 Fis> (3/3)
F334 (=95 ‘-SM’ option specified — float & double keywords are not allowed
J5 A KR e T EABAIET-SM, ARVl Float #1 double JeH#-.
w33s | f5H ‘-SM’ option specified - long constant is treated as int constant
JE A HoRE T AL T-SM, long # B4 4 1F int R A .
w339 | FR '__temp' required '-SM -ZM' - ignored '_ _temp' in this file
J A A F B IE I (-SMYRIF S BIRP JE HWIEI(-ZM) Eufe i, IR T_ _temp A AL
.
AR temp SEE T 20K
w340 | 51 Unreferenced label 'label name'
JE A B2 BRI He 5 i
(5) HBUERGER<HTM 401 FFih>
w401 | fFR Conversion may lose significant digits
JE K Long BB HL int B, TR B T RE S B0k
F402 55 Incompatible type conversion
JR K FEMEE A h A A T AR I 2R R e e
F403 55 lllegal indirection
JE K FERUFRL AP T * BB
F404 (=95 Incompatible structure type conversion
JR A XIS R AR IR B R A 22 AT PRIL BN
F405 | 155 lllegal lvalue
JR K AL ZeE
F406 (=Fs! Cannot modify a const object ‘variable name’
J A const J& MR RS .
F407 (=95 Cannot write for read / only sfr ‘SFR name’
J A SR e A PR Sfr S A KU
F408 55 Cannot read for write/only sfr ‘SFR name’
JE A SR MMES JR P00 sfr i CE .
F409 (=Fs! llegal SFR access ‘sfr name’
JE K XF sfr BEATAEIEERAE, HOaAN sfe oA s, Bn sfr S NAREE
w410 | f5H lllegal pointer conversion
JR K TEETFFARFEET Y H AR AT e e
w411 | f5E lllegal pointer combination
JE K TEARIRIZE R R 4 E, TR T ARIZEAL.
W412 (=95 lllegal pointer combination in conditional expression
J A TEAA R B A AT AN R AL K FiR 5T 415
F413 f5 5 lllegal structure pointer combination
JE A TR SR R RR T BR S AL, SR & 2 R0 A R R 8 2.
F414 (P! Expected pointer
J5 A i —ANRE .
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(6) FTAARFIREB<wS M 501 Fig> (1/3)
F501 B Expression syntax
J K] RO EF T MEEH R,
F502 (=95 Compiler limit : too many parentheses
JR K FEZRIEA ST kB 32 J2.
W503 fH R Possible use of ‘variable name’ before definition
JR A TEAR SR WA T i
ws04 | 5 Possibly incorrect assignment
JE K AR A if, while I do 35 P (¥ == B8 S AT A0S 54T
w505 | 15 E Operator ‘operator’ has no effect
JE A R, BT X AR R R R
F507 (=95 Expected integral index
JR K RN R 51 H e iRk .
W508 fFR Too many actual arguments
JR A A B8 U I 48 52 1R 2 B0 R T s e N S EE YR PR € I S 808 R
w509 | 5 Too few actual arguments
JE K A BRI I i 5 R 2 5080 /N T s e N S EE MBI R 48 & I S 808
ws10 | f5R Pointer mismatch in function ‘function name’
JE A 4B IS BRI R HOE SN SR AR P s 2 I S HCR AT
W511 (=95 Different argument types in function ‘function name’
JR K BRI HI I 28 I S HCR R S HO B DIRANET, 8l P eR B0E SONHE E IS HEBUATT
F512 fH R Cannot call function in norec function
JE A £ norec PR R T BB 4E norec BRI T RRBUR BAR IR
F513 f5 5 lllegal structure / union member ‘member name’
JE K | FH 00 5 R AR 10 3 AN 3008 I [ 5 S 5%
F514 5 B Expected structure / union pointer
JE A TE > B HAF TR AATE — M 1R S5 A s L AR FREr,  ARIXANRIE L — N R s LR i
B4R .
XF 5 DRt BLLE — B SERF 2 i 1028 3 45 1) G5 A A L R A T
F515 5 B Expected structure / union name
JE K TR MR A IS — A B I E R A R, AR IXASFRIE 2 — AN 17 G54 (Al S ) A 1)
Eita
XF 5 DR B — B SERF 2 i 1023 3 S5 A A el I L IR A TR 22 7K
F516 7R Zero sized structure ‘structure name’
JE K SRR RN E 0,
F517 f5 5 lllegal structure operation
JE A AT BRI T TCVE SRR AR
F518 (=95 lllegal structure / union comparison
JR K AN G R AR I AR TCTE AT FEER
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(6) FTEAHEHRMEE<HmS M 501 Fih> (2/3)

F519 f5 5 lllegal bit field operation

JE SRR AR LA .
F520 (=Fs! llegal use of pointer

JR A TRHSCRFMBRERT A NS L BT WRE S BUEAT 5 (YRR T A5 (->).
F521 | 58 lllegal use of floating

JR A T HA AR AR TR A I (O BR VR 1
W522 (P! Ambiguous operators need parentheses

JE TERA A IR S M B0 TS A LA E MR B AR AT . R R BAER RIS £
F523 515 llegal bit, boolean type operation

J A AT T LA AT R AR R AR AR A
F524 55 ‘& requires Ivalue

JE A R B BB R
F525 (=95 &’ requires Ivalue

JR A ‘& PRAERE R T ZE 1 7 3k AR 1 ek .
F526 fH ‘& on register variable

JE A BEFFAEAS AL I Mk TE V3R E
F527 fFR ‘&’ on bit, boolean ignored

JR A T 7 Bt il B bit B9 B AT /R ST AR R (1 bk JoVE SR
w528 | (51 ‘&' is not allowed array / function, ignored

JE A SARAETTANRE N T B4 44 i e B 44
F529 7R Sizeof returns zero

JE Sizeof Kk MIHAL L 0.
F530 (=95 lllegal sizeof operand

J A Sizeof ik 2 MIRVELB SRR IRFFER AL 4 .
F531 (=P Disallowed conversion

JR S| RS Y da e

X5 KA ARE R .

L T ESR S B W T W ERIRIVE I, S IR AR R

F532 (=F5) Pointer on left, needs integral right : ‘operator’

JE A RN ZE B E B TR B, SRR R E S e L
F533 =¥ Invalid left-or-right operand : ‘operator’

JE VI Y (B C VR (e R NN
F534 (= Divide check

JR A HEFFF %I HAF MR AL % .
F535 f5 5 Invalid pointer addition

JE PIAFREFANGEAR N o
F536 (P! Must be integral value addition

JRA S R mT LARCRIRET A .
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(6) RIAAMEREB<MSM 501 746> (3/3)
F537 f5 5 lllegal pointer subtraction
R PSRBT (ol SRk A i D6 20U A7 A ] (19 28 28
F538 fFR lllegal conditional operator
J5L Bl FATIB I RGBS E A o
F539 f5 5 Expected constant expression
JE Al B R ARIE A
w540 | fFR Constant out of range in comparison
JR A FH SR AN H B3 4y Rk s AR I T FoAh 4 RIS A 28 0 e el
F541 515 Function argument has void type
JEL A BRI S H B 2 void 2,
W543 55 Undeclared parameter in noauto or norec function prototype
JR A ZS R HELAE noauto X norec pR AL SRS AR IR v
F544 (=95 lllegal type for parameter in noauto or norec function prototype
JEL Bl 7E noauto B, norec p &K J5U R B rh s e 1 S MR A R ARVEIN .
F546 f5 5 Too few actual argument for inline function ‘function name’
JE Al W (nline) e ERITI, sEOHH e € S EH DT N2 S EEHE .
F549 fFR -SM’ option specified - recursive function is not allowed
J5L Bl KA T H SRR T-SM, T LAAS Fe VR4 FH 3 U5 R 40
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(7) BEAERER<HSMN 601 FFih>
F602 515 Compiler limit : too many characters in logical source line
JR A TEPRRR P I — AN HRAT v LI AP i d T 2048,
F603 55 Compiler limit : too many labels
Ji A PREEMEH T 33 4
F604 fFR Case not in switch
JEL Bl Case WA H IR B AN IEHf o
F605 {5 5 Duplicate case ‘label name’
J A FE—A> switch WA YL T AN LR [RIFE (# case B85
F606 fFR Non constant case expression
J A TE case WA IR E T HEECE B 2 AMIER .
F607 f5 5 Compiler limit : too many case labels
JE A # switch 4] HF HHBLI case FRic B H #d T 257 4.
F608 55 Default not in switch
Ji A default 1y H AL B AN IEH
F609 fFR More than one ‘default
J5 A 7 swich i f)th L £ A~ default #54).
F610 55 Compiler limit : block nest level too deep
JE A B L T 45 2.
F611 fFR Inappropriate ‘else’
J5L Bl If F else t5A)AULAL
w613 | 55 Loop entered at top of switch
J5 A 1 switch ¥ #) 2 J5 B ERAT while, do Zk# for 4.
weis | fFR Statement not reached
J A S AT K HAT A H
F617 fFR Do statement must have ‘while’
JR A do WA fE— g I While 1 fyskxd V.
F620 55 Break / continue error
J5URI break #1 continue i&A) BN B AN IEH.
F621 R Void function ‘function name’ cannot return value
JE A R void [ R AT B — MR [ .
we22 | 7R No return value
JE A T IR [l —ANE 1) bR 5 AT IR BTl 1
X 5k R BEAE IR ], VR0 return WEA) . WTHRACH LB BREOR EIUE, H R EoE b void 287
F623 (=95 No effective code and data, cannot create output file
JR A PRI A AR RIS TERL, i SO okt
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(8) FHUAFIREUE X AR E R <5 M 701 FFEh> (1/5)
F701 f5 5 External definition syntax
JE A BRSO BB E o
F702 fFR Too many callt functions
JE A I callt MR K2, HZ 0 LUE X 32 A callt i3
Pt b callt bR £ A W HCRE
F703 55 Function has illegal storage class
Ji A PREEAR E AR S AR o
F704 (=95 Function returns illegal type
JE A BRI M TR A R ARVE Y .
F705 {5 5 Too many parameters in noauto or norec function
JR A noauto Ik norec IS HKZ .
o 5 WS HHH
F706 R Parameter list error
J5 A SR RAT R
F707 55 Not parameter ‘character string’
JE A TERRHUE SCN S IR ZHOR I
w708 | 5 Already declared symbol ‘variable name’
J5L Bl A “AR AR F7 5 DA By,
F710 {5 5 llegal storage class
J A H BN 25 AE 3 F5 WA E bR AN, At R AR S 8 AT R AN
F711 (=Fs! Undeclared ‘variable name’; function ‘function name’
J A A8 0 A 1 R EAT FE
F712 =hs! Declaration syntax
J5 A PR AIANTT A IR .
F713 B Redefined ‘variable name’
JE A & ST HAN AL R 2 A8 o
X 5 At g AT — IR
w714 | f5H Too many register variables
JE A TR R IIRZ .
i o W AR R B . 2T T I A A, B0E A C iFEEEE S M (UL16655E) TS 11 &,
F715 (=Fs! Too many sreg variables
Ji AL sreg BHFIRZ .
F716 (5! Not allowed automatic data in noauto function
JEL A 1 noauto M TR B AR R
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(8) FEHAEEEXRERER <45 M 701 Frif> (2/5)
F717 515 Too many automatic data in noauto or norec function
J A #£ noauto 5 norec B A KE HEILE .,
X /> noauto X norec MHH AENARINEE. BT AVIE AR, SO5ER C HIFREER
(U16655E)F- M1 11 &,
F718 (=Fs! Too many bit, boolean type variables
JR A P AR A IR B AR K
xR WA AR S, AR AURI__boolean BUF R (WHCE . T AVFIEHECE, HOEEN C MIERESR
(U16655E) F- it 158 11 &.
F719 f5 5 llegal use of type
JE A (U EIRPRINEATEA Y
F720 (=Fs! lllegal void type for ‘identifier’
JR A FRRAE T void AT H .
w721 | 5B llegal type for register declaration
JE A T AEAS I B R T AR,
9 FAER TS B NG, b B R AR SR IET
F723 (=95 lllegal type for parameter in noauto or norec function
JR A #£ noauto 2 norec PR KIS A AN .
F724 (=S Structure redefinition
JE A SESUT AN AL [ R] 44 S5 R A
w725 | fFR lllegal zero sized structure member
JR A FHRAZ TR R AR R 53 1) DX G 5 AR
pH A RS RS R, RS E R R A, T -QC2 IETA I s AR Y, I HS s Y
IR TEVERAIE . AEIXAMBLL T, 1E-QC AL E-QCL kI, -QC ZEIIUA & JEBRIN ML I L —.
F726 7R Function cannot be structure / union member
JE A PR ECANBEAE Dby 5 K R s R [ 1 5%
F727 15 B Unknown size structure / union ‘name’
JR A SRR L RMR K RN R E X
F728 f5 5 Compiler limit : too many structure / union members
JE A SRR R A v R A B T 256
F729 (=Fs! Compiler limit : structure / union nesting
JE K itk RR IR E = ST 15,
F730 (=¥ Bit field outside of structure
JE A ALK P TR S5 R AR B
F731 f5 5 lllegal bit field type
Js K] TERLIFET b 8 T A R A O
F732 (=95 Too long bit field size
JR A P38 W] bR e A AR BT T 282 SR I A A i
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(8) FEHAEEEXRERGER <45 M 701 Frif> (3/5)
F733 515 Negative bit field size
JR A A 17 U e (A R A
F734 55 lllegal enumeration
Ji A BB P AR TF A 1500
F735 (=F5) llegal enumeration constant
JE A LB .
F736 f5 5 Compiler limit : too many enumeration constants
JE B MO B T 255.
F737 fFR Undeclared structure / union / enum tag
J A FEAKFHIRRL (tag) o
F738 f5 5 Compiler limit : too many pointer modifying
JR A FEFRERE S, (RS AT (B 12 4.
F739 55 Expected constant
Ji A TEH TR I RS T AR
F740 (=95 Negative subscript
JR A B 2B RN R E R BUfE
F741 55 Unknown size array ‘array name’
JE A KR I 75 5 /N AAE Lo
o 5K Fe e AL RN
F742 (=95 Compiler limit : too many array modifying
JR A AWM A UL T 12 4,
F743 f5 5 Array element type cannot be function
Ji A PRECE AL AN R
w744 | f5H Zero sized array ‘array name’
JE A ESCMELH Y, o ¥ 0,
w745 | f5E Expected function prototype
J A PR R AR A R W
F747 (P! Function prototype mismatch
JE A BRI Y (R 7 AT R
X5k KT o 4 1K) 2 BRI [PHEL ) 28 A S TR VLI
w748 | 55 A function is declared as a parameter
JE A TERE W s B AE S 4L
w749 | fFR Unused parameter ‘parameter name’
J A SR .
F750 55 Initializer syntax
J A WA TF A BRI o
F751 (P! lllegal initialization
J A AR VR MBI (AL T 28R ASIL )
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(8) FHIMREE XM RER <45 M 701 Frh> (4/5)

W752 (25 Undeclared initializer name ‘name’
BRI WA FR AL W] o
F753 (=5 Cannot initialize static with automatic
JR A AR AN R A A 3R s TR AR .
F756 {55 Too many initializers ‘array name’
JE Al CIIEUNE V=€ - e N P 3 6
F757 5 B Too many structure initializers
BRI W I 2 TSR 7 T o 1 e D B
F758 (=F5N Cannot initialize a function ‘function name’
Ji Bl % B BIGVE 5E A IR AL o
F759 {55 Compiler limit : initializers too deeply nested
J5 A TN 1 7038 BB ek PR
W760 (=5 Double and long double are treated as IEEE 754 single format
JR A RURS P8 R TURS FE 4% 8 IEEE 754 (K02, MR BORE BERG Ok AL
w761 {55 Cannot declare sreg with const or function
J A AN BERE B R O W]k sreg Y.
ETRZ sreg 75 1k 2%
W762 (=F5N Overlapped memory area ‘variable name 1' and ‘variable name 2’
JR A At L RAS A 2 DX I sk bk 23 i 150 B B S AT
W763 7R Cannot declare const with bit, boolean
J5 A AR MIATT R 8 AL AR A P WA T B A .
N W P WA R
W764 (=F5N ‘Variable name’ initialized and declared extern-ignored extern
JE Bl 58 SCAAMBAR TR AR, TR IR SO EIHRAN B 15| AR B 1R 0 5 S
% e extern j W 2% .
F765 515 Undefined static function ‘function name’
JR A IR T —MEEREL ST ERA BRI E S, B R E0E LT HIA AN .
F766 5 & lllegal type for automatic data in noauto or norec function
J5 A noauto 5, norec %Y B AR EIRINK.
F770 5 2 Parameters are not allowed for interrupt function
JR Pk R B el S U
F771 [EPE Interrupt function must be void type
Ji P r I R B 2 void SR
F772 (EPE Callt / noauto / norec / __pascal are not allowed for interrupt function
JR A v 7 R S AN BE 9 75 B callt, noauto, norec, BY _ pascal 257,
F773 (EPE Cannot call interrupt function
Ji A rP IR R B e AR
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(8) FHIMERYE XM RER <45 M 701 Frh> (5/5)

F774 (EPSS Interrupt function can’t use with the other kind interrupts
Ji K] H T R BN BEAE H ARSI [ v W IR 55 el B AT
F780 fF R Zero width for bit field ‘member name’
J5 A BB W o P A ) 0, IXA R Y 44 TG R E
F781 5 15 -SM’ option specified - variable parameters are not allowed
J A b FaE TS HED-SM, ARV 24,
F782 5 15 -SM’ option specified — structure & union parameter is not allowed
J A A de e T S B I-SM, AN SV 45 K AR RIS IR R A E S5
F783 {5 2 ‘-SM’ option specified — structure & union return value is not allowed
JE A K46 5E T ERASEBRTN-SM, AN SEVEAE F S AR ) A Ay i B4R
F784 {5 8 ‘-SM’ option specified - too many parameters of function
JE A P da e T SRR T-SM, s8I SHE R T 3 NS 6 71,
F785 {5 2 ‘-SM’ option specified - expected function prototype
JE A KA E T # AR IN-SM, R4k 21 ok B R R 1
W786 55 ‘-SM’ option specified - undeclared parameter in function prototype
JR Al KR4 T WS B I-SM, S8 ok 205 280 A B v R A B
w787 | 55 Bit field type is char
JR A TR E I LA
W792 {EPES Undeclared parameter in __pascal function definition or prototype
JR Al __pascal BHUE XEUs R B AT IS EE . LR S8, BAUE UR void 28,
W793 (EPSS Variable parameters are not allowed for __pascal function - ignored _ _pascal
JR A XF__pascal BB REY TR E AR RS __pascal JCHE 2N .
F799 (EPSS Cannot allocate ‘variable name’ out of ‘address range’
J5L Il AR A Sy T 4 bk I T FE e R Y
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(9) Tkt REIRER <45 M 801 FFih> (1/4)
F801 fFR Undefined control
J5 A PL # JFURIIAT 5 AN RER R0 A G
F802 55 llegal preprocess directive
A R TIAL BE A 4 o
K Hr A AL EE a4 (U #pragma) & 155 7E Sk SCHRTT,  H ELA AR A .
F803 5 B Unexpected non-whitespace before preprocess directive
JE A FETRAL B 4 2 AT 25 b 2 AN TR I
w804 55 Unexpected characters following ‘preprocess directive’ directive - newline expected
JR A b A2 J5, TEF—A7H JCvE R A A By & A 745
F805 (=F5) Misplaced else or elif
J A #if, #ifdef, F#ifndef S#else Fi#elif [IESHARHIZT o
F806 f5 5 Misplaced endif
JE A #if, #ifdef, F1 #ifndef S#endif MBI ASHHAT
F807 (=Fs! Compiler limit:too many conditional inclusion nesting
J5L Bl S AR PRI R 2 ok 255,
F810 55 Cannot find include file ‘file name’
R ARG
X 5k EFR AR S O A2, BRI  INCT8KOS 1 -i IETRIRE — Mk 1e.
F811 (=95 Too long file name ‘file name’
JEL Al AR K
F812 55 Include directive syntax
JE Al #include 87 (1) SO 4 BT B IERA AL S 70 "< >55 5
F813 (=Fs! Compiler limit : too many include nesting
J5L Bl A5 AR E R R 8.
F814 55 lllegal macro name
JE A L4
F815 f5 5 Compiler limit: too many macro nesting
JR A FIIRE R 200,
wsie | fFR Redefined macro name ‘macro name’
J5 A FRAFRAEE L.
w17 | 5 Redefined system macro name ‘macro name’
JR A RE AR TE o
F818 (P! Redeclared parameter in macro ‘macro name’
J5 A 58 NS P A )R AR TR
w819 B! Mismatch number of parameter ‘macro name’
JE Al 5 I 2R Fi#define v 42 LIS HEER AT .
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(9) TS KRGS <45 M 801 FFHh> (2/4)
F821 515 llegal macro parameter ‘macro name’
J5 A TR O 2 2 e SO, A5 () i R A R ARV .
F822 55 Missing ) ‘macro name’
Ji A TERR AU N 28 L, frstdefine S8 1 [F]— AT TR B B AR BRI A 36 5)
F823 (=F5) Too long macro expansion ‘macro name’
JEL Bl R JEFF AT IR 92 B ZHOR K.
wgz4 | fFR Identifier truncate to ‘macro name’
JE A BAFERK
ey RAARRPAREL R o
wgzs | 5 Macro recursion ‘macro name’
JE A #define & LI A FR 2 IH 1 o
F826 f5 5 Compiler limit : too many macro defines
JE A %€ MR 10,000,
F827 fFR Compiler limit : too many macro parameters
J5L Bl AN SR 2 2 31 1.
F828 {5 5 Not allowed #undef for system macro name
J A ARG R4 i#undef H7 0 (10
W829 fFR Unrecognized pragma ‘character string’
JR AL #pragma Jii [ 55 Hf VR R
o 5 AT OB R IEA 1
e #pragma PR E TAIERIMNX B, 2 Bl
F830 f5 5 No chip specifier : #pragma pc ()
Ji A WA A UL AT .
F831 (=95 llegal chip specifier : #pragma pc (device type)
J5 A AL A LI AT o
wsg32 | 5 Duplicated chip specifier
JE A ZAAAIR 1A YA AT
F833 fFR Expected #asm
J5L Bl wH #asm.
F834 f5 5 Expected #endasm
JR A % fi#endasm.
W835 fFR Too many characters in assembler source line
J A TEgmUERE T P R AT KK
wsg3e | 55 Expected assembler source
J5 A # #asm I #endasm Z [ EAT I G FE T .
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(9) TS HEIRER <45 M 801 FFHE> (3/4)
w37 | 5 Output assembler source file, not object file
JE A CRP T — #asm sl _asm f). fHiCgmifey 3ot miAsih s
X 5 i€ -a oli-sa IO K #asm F__asm WA B H BRSO, AR50 K asm SCARREATIC S
F838 (=Fs! Duplicated pragma VECT or INTERRUPT ‘character string’
J K 4 Z A [l fts#pragma VECT 74 i di#tpragma INTERRUPT 24 H 1
F839 5 B Unrecognized pragma VECT or INTERRUPT ‘character string’
JR K AT M#pragma VECT A 4F H '8 INTERRUPT A4 5.
ws4o | 5 Undefined interrupt function ‘function name’ -ignored NOBANK or LEAFWORK specified
J A h— ARS8 S P IRk B 8 T AR H R
GRS NOBANK iHl5, LEAFWORK 3 W4 2 .
F842 5 B Unrecognized pragma SECTION ‘character string’
JE A H—ANTIER A [Fi#pragma SECTION #4557,
F843 (P! Unspecified start address of ‘section name’
J A TE#tpragma 5> AT JG A 48 2 IE MR A bl o
F845 (=95 Cannot allocate ‘section name’ out of ‘address range’
J5 A 08 X PTG TR € I A o
ws4e | 5 Rechanged section name ‘section name’
J A S8 ST MR 4, (FRE BEIH 30 0 A1 s
mPEAT BSHREN T AR, JF HAB I FE gk sk 1T
F847 B Different NOBANK or LEAFWORK specified on same interrupt function ‘function name’
J A AR f¥) NOBANK 1 ] 5 LEAFWORK i W14 35 1 2 [fl A P 7 B 4
w49 | 5 #pragma statement is not portable
JR A #pragma & A AFF G ANSI ARHERIE .
wsgs0 | 55 Asm statement is not portable
Ji A ASM EAJAFFE ANSIARERE .
wsgsl | 5 Data aligned in ‘area name’
A B DX sl 454 A 2 SR SR I o XA Bk A B Bl 4 R AR A
wgs2 | fFR Module name truncate to ‘module name’
JEL Bl i B B A KK
PR B BARRL 7R o
F853 f5 5 Unrecognized pragma NAME ‘module name’
Ji A BEH AT TCIE N
wsgse | 15K Rechanged module name ‘module name’
JEL Al i€ T2 MR .
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(9) TFALHALSHHIREE <45 M 801 FFif> (4/4)

wss7 | fFR Section name truncate to ‘section name’
JE A FREMTi 4 (section name) K.
P AR R ARy 8 AR DA,

F866 fFR #pragma section found after C body. cannot include file containing #pragma section and without C

body at the line
J A £ C R Mdid 5 #pragma 160 . W8 1k S0P AN RE X fr #pragma i AU C FEP R (7%
AR S A S

F867 {5 5 #pragma section found after C body. cannot specify #include after #pragma section in this file
JR A 7t C FIp ik G fi#pragma ). T2, #include iEAJAREH L,

F868 s #include found after C body. cannot specify #pragma section after #include directive
J A 7t C v 4A4iiid 5 F#include 4. T2, #pragma G ANREH I,

wsge9 | 55 ‘section name’ section cannot change after C body
JR A BT AL C PR FARSA .

wsg7o | 5 Data aligned before ‘variable name’ in ‘section name’
R TR AR BRI B FR AT, Se AT E X 55 .

w871 fFR Data aligned after ‘variable name’ in ‘section name’
J5L Bl TEAR R B T AR LG, HFPATEIE .

F899 {5 5 Character string specified by #error is output
J A 578 T #error T4 5.

173 JAPFAE U16654CALVOUM




(10) BUawHI3CHF 110 FIEATIEVERAE R AR RIE B <M 901 FFif> (1/2)

A901 EPs File 1/0 error

JE A FESCATHR N RE T 4™ 2R P B 1O ik

X WSS PR SO S E T XA, I A, B ] EMS B XMS fEfif s
A902 515 Cannot open ‘file name’

JE A SCAFTCEAT T

X o B AT I A A IR AR . I NIRRT DM —Y SN0k YR 2. 28 5.3 (18) ®&L

B (7 AR PR AR AR

A903 fFR Cannot open overlay file ‘file name’

JE K B i S TCVET T
A904 (=95 Cannot open temp

J A BN PRI I S TEVEAT IT
A905 7R Cannot create ‘file name’

Js K] PR T AN SR T R
A906 (=95 Cannot create temp

JR A FEA L IR ST A2 T AN B A R

xR KA THEAR R TMP.
A907 7R No available data block

Js K] I SO, DR A SN S SO AL (A Rt R
A908 (=95 o0 available directory space

JE A I I SCA v, TRk SRl 3 AT AL I H X
A909 55 R/O : read / only disk

JE A B SCAR TG, DR A SR B 45 0 S e L2
A910 fFR R/O file : read / only , file opened read / only mode

JR A BT LR, S R S AR

1. AL T IR SO B2 A 42 T3R8 as b, JF R R git.
2. M ATBEI PSS, N SOPE DU SR AT T

A911 {5 5 Reading unwritten data, no available directory space
S| TR R 25774 1O ik

1. 7£ EOF Z Jafi N4k4:.
2. WG SO TR B, RN IR g R R H R X .

A912 (=Fs! Write error on temp

JE X FEH I I SO 7 A2 T — AN A iR

xF 5 F R B RE P RAEOE TR (AR HRMIRE) M5, TEH RS
A913 55 Requires MS-DOS V2.11 or greater

JE A Bl RGASE MS-DOS (2.1 A< B3 BT (K ARAS) o
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(10) FAriISCA: 110 FBAT L RIE R G REHRE B<4i 5 M 901 FFih>  (2/2)
A914 515 Insufficient memory in hostmachine
JE A KWL, e iash.
X5k 0 FA At s ) )T X3
W915 (=Fs! Asm statement found. skip to jump optimize this function ‘function name’
J5 A Kl El#asm Pl asm B BIEA) . XA R EBCH AT UL . AT WB3T XK.
F922 5 B Heap overflow : please retry compile without -QJ
JR K FERERARARIS P AR AP A A . BUN-QI TR T Widn %,
A923 55 llegal device file format
J5 A U T IS 3 e S0
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M3 A BEBIRRF
Al C FHEREFPHEHCCHF

#define TRUE 1
#define FALSE 0
#define SIZE 200

char mark[SIZE+1];

main()
{
int i, prime, k, count;
count = 0;
for (i=0;i<=SIZE ; i++)
mark[i] = TRUE;
for (i=0;i<=SIZE ;i++) {
if (mark[i]) {
prime =i+i+3;
printf("%6d",prime);
count++;
if((count%8) == 0)  putchar(\n";
for (k =i+ prime ; k <= SIZE ; k += prime)
mark[k] = FALSE;
}
}
printf("\n%d primes found.",count);
}
printf(s,i)
char *s;
inti;
{ . .
int J;
char *ss;
=i
SS=s;
}
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Bifsk A FEBIRE?

putchar(c)

charc;

{
char d;
d=c;

A2 BUTHIRE

C>cc78K0S —c9024 prime.c -a -p -X -e -ng

78K/0S Series C Compiler VX.xX  [XX XXX XXXX]
Copyright (C) NEC Electronics Corporation XXxx,XXXX

sample\prime.c(18) : W745 Expected function prototype
sample\prime.c(20) : W745 Expected function prototype
sample\prime.c(26) : W622 No return value
sample\prime.c(37) : W622 No return value
sample\prime.c(44) : W622 No return value

Target chip : uPD789024
Device file : Vx.xx

Compilation complete, 0 error(s) and 5 warning(s) found.
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A3 HHFIER

(1) CHRERFESRSCH

; 78K/0S Series C Compiler Vx.xx Assembler Source

Date:xx XXX XXXX Time:XxX:XX:XX

; Command  :-c9024 prime.c -a -p -x -e -ng
: In-file : prime.c

; Asm-file . prime.asm

: Para-file

$PROCESSOR(9024)

$NODEBUG

$NODEBUGA

$KANJICODE SJIS
$TOL_INF  03FH, 0130H, 02H, 0O0H

EXTRN _@cprep
EXTRN _@RTARGO
EXTRN @ @isrem
EXTRN _@cdisp
PUBLIC _mark
PUBLIC _main
PUBLIC _printf
PUBLIC _putchar

@@CNST CSEG

LO011: DB '%6d'
DB 00OH

LO017: DB OAH
DB '%d primes found.'
DB OOH

@@DATA DSEG
_mark: DS (201)

;line 5
;line 8
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@@CODE CSEG

__main:
push hi [INF]11, 4
movw  ax,#08H ;[INF] 3, 6
callt[_@cprep] ;[INF] 1, 8
:line 11
xor a,a i[INF] 2, 4
mov[hl],a ; count i[INF]1 1,6
mov[hl+1],a ; count ;[INF] 2, 6
;line 13
mov [hl+6],a i ;[INF] 2, 6
mov[hl+7],a i ;[INF] 2, 6
LO003:
mova,[hl+6] ;i ;[INF] 2, 6
xch a,x i[INF] 1, 4
mova,[hl+7] i ;[INF] 2, 6
xor a,#080H ; 128 ;[INF] 2, 4
cmpw  ax,#080C8H ; -32568 ;[INF] 3, 6
bc $$+4 ;[INF] 2, 6
bnz $L0004 J[INF] 2, 6
; line 14
xor a,#080H ; 128 ;[INF] 2, 4
addw  ax,# _mark ;[INF] 3, 6
movw  de,ax i[INF]1 1, 4
mov a,#01H i i[INF] 3, 6
mov[de],a [INF] 1,6
mova,[hl+6] ;i i[INF] 2, 6
xch a,x i[INF] 1, 4
mov a,[hl+7] i ;[INF] 2, 6
incw ax [INF]11, 4
mov[hl+7],a D ;[INF] 2, 6
xch a,x i[INF] 1, 4
mov [hl+6],a s ;[INF] 2, 6
br $L0003 [INF] 2, 6
L0004
;line 15
xor a,a ;[INF] 2, 4
mov [hl+6],a pi ;[INF] 2, 6
mov [hl+7],a s ;[INF] 2, 6
179 I U16654CALVOUM




Bifsk A FEBIRE?

LO0O06:

mov a,[hl+6] i
xch a,x
mova,[hl+7] pi
xor a,#080H ; 128

cmpw  ax,#080C8H ; -32568

bc $$+7
bz $$+5
br L0007

;line 16
xor a,#080H ; 128
addw  ax,# mark
movw  de,ax
mov a,[de]
cmpa,#00H ; 0
bz $L0015

:line 17
mova,[hl+6] D
rolc a,1
xch a,x
mova,[hl+7] i
rolc a,1
addw  ax,#03H ; 3

mov [hl+5],a ; prime

xch a,x

mov [hl+4],a ; prime

; line 18
xch a,x
push ax
movw  ax,#L0011
call !_printf
pop ax

:line 19

mov a,[hl] ; count

xch a,x
mova,[hl+1] ; count
incw ax

mov[hl+1],a ; count

xch a,x
mov [hl],a

; count

[INF] 2, 6
[INF] 1, 4
[INF] 2, 6
[INF] 2, 4
[INF] 3, 6
[INF] 2, 6
[INF] 2, 6
[INF] 3, 6

[INF] 2, 4
[INF] 3, 6
[INF] 1, 4

INF] 1, 6

[INF] 2, 4

[INF] 2, 6

[INF] 2, 6
INF] 1, 2
[INF] 1, 4
[INF] 2, 6
INF] 1, 2
[INF] 3, 6
[INF] 2, 6
[INF] 1, 4
[INF] 2, 6

[INF] 1, 4
[INF] 1, 4
[[INF] 3, 6
[INF] 3, 6
INF] 1, 6

;[INF] 1, 6
;[INF] 1, 4
;[INF] 2, 6
J[INF] 1, 4
;[INF] 2, 6
;IINF] 1, 4
;[INF] 1, 6
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: line 20
xch a,x J[INF] 1, 4
movw _@RTARGO,ax ;[INF] 2, 8
movw  ax,#08H ; 8 ;[INF] 3, 6
call '@@isrem i[INF] 3,6
or ax i[INF] 2, 4
bnz $L0012 J[INF] 2, 6
movw  ax,#0AH ;10 ;[INF] 3, 6
call !_putchar i[INF] 3, 6
LO012:
;line 21
mov a,[hl+6] i ;[INF] 2, 6
add a,[hl+4] ; prime i[INF] 2, 6
xch a,x i[INF] 1, 4
mova,[hl+7] i ;[INF] 2, 6
addc  a,[hl+5] ; prime ;[INF] 2, 6
mov [hl+3],a ik ;[INF] 2, 6
xch a,x i[INF]1 1, 4
mov [hl+2],a tk ;[INF] 2, 6
L0014:
mov a,[hl+2] K i[INF] 2, 6
xch a,x i[INF] 1, 4
mov a,[hl+3] ik ;[INF] 2, 6
xor a,#080H ; 128 ;[INF] 2, 4
cmpw  ax,#080C8H ; -32568 ;[INF] 3, 6
bc $$+4 J[INF] 2, 6
bnz $L0015 ;[INF] 2, 6
; line 22
xor a,#080H ;128 ;[INF] 2, 4
addw  ax,# _mark ;[INF] 3, 6
movw  de,ax i[INF] 1, 4
Xor a,a ;[INF] 2, 4
mov|[de],a ;[INF] 1, 6
mov a,[hl+2] tk i[INF]1 2, 6
add a,[hl+4] ; prime i[INF] 2, 6
xch a,x i[INF] 1, 4
mov a,[hl+3] ik ;[INF] 2, 6
addc  a,[hl+5] ; prime ;[INF] 2, 6
mov [hl+3],a 1k ;[INF] 2, 6
xch a,x i[INF] 1, 4
mov[hl+2],a K ;[INF] 2, 6
br $L0014 i[INF] 2, 6
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LOO015:

; line 24
mov a,[hl+6] pi ;[INF] 2, 6
xch a,x i[INF] 1, 4
mova,[hl+7] ;i i[INF]1 2, 6
incw ax [INF]1 1, 4
mov[hl+7],a i ;[INF] 2, 6
xch a,x J[INF] 1, 4
mov [hl+6],a D ;[INF] 2, 6
br L0006 ;[INF] 3, 6

LO0O7:

:line 25
mova,[hl] ; count ;[INF] 1, 6
xch a,x i[INF] 1, 4
mova,[hl+1] ; count ;[INF] 2, 6
push ax [INF] 1, 4
movw  ax,#L0017 ;[INF] 3, 6
call ! printf ;[INF] 3, 6
pop ax ;[INF] 1, 6

; line 26
movw  ax,#08H ;[INF] 3, 6
callt[_@cdisp] ;[INF] 1, 8
pop hl i[INF] 1, 6
ret i[INF] 1,6

:line 31

_printf:
push hi i[INF]1, 4
push  ax J[INF] 1, 4
movw  ax,#04H ;[INF] 3, 6
callt[_@cprep] ;[INF] 1, 8

; line 35
mova,[hl+10]; i ;[INF] 2, 6
mov[hl+2],a P ;[INF] 2, 6
xch a,x i[INF] 1, 4
mova,[hl+11] ;i ;[INF] 2, 6
mov [hl+3],a P ;[INF] 2, 6
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:line 36

mova,[hl+4] ;s
mov[hl],a ; SS
xch a,x

mova,[hl+5] ;s
mov[hl+1],a ;' SS

:line 37

pop ax
pop ax
pop ax
pop hl
ret

; line 41

_putchar:

push hi

push ax
movw  ax,#02H
callt[_@cprep]

:line 43

mova,[hl+2] e
mov[hl+1],a ; d

:line 44

pop ax
pop ax
pop hl
ret
END

; *** Code Information ***

[INF] 2, 6

[INF] 1, 6
[INF] 1, 4
[INF] 2, 6

[INF] 2, 6

INF] 1, 6
INF] 1, 6
INF] 1, 6
[INF] 1, 6
[INF] 1, 6

[INF] 1, 4
[INF] 1, 4
[INF] 3, 6
INF] 1, 8

;[INF] 2, 6
;[INF] 2, 6

INF] 1, 6
INF] 1, 6
INF] 1, 6
INF] 1, 6

; SFILE C:\NECTools32\sample\prime.c

; $SFUNC main(8)

bc=(void)

CODE SIZE= 222 bytes, CLOCK_SIZE= 654 clocks, STACK_SIZE= 14 bytes
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; SCALL printf(18)

i bc=(pointer:ax, int:;[sp+2])

; $CALL putchar(20)

; bc=(int:ax)

; $CALL printf(25)

;  bc=(pointer:ax, int:;[sp+2])

; $FUNC printf(31)

;  bc=(pointer s:ax, int i:[sp+2])

; CODE SIZE= 28 bytes, CLOCK_SIZE= 108 clocks, STACK_SIZE= 10 bytes
; $FUNC putchar(41)

; bc=(char c:x)

;  CODE SIZE= 14 bytes, CLOCK_SIZE= 58 clocks, STACK_SIZE= 8 bytes

; Target chip : uPD789024
: Device file : Vx.xx
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(2) PRAHFIRCH

/*
78K/0S Series C Compiler Vx.xx Preprocess List
Date:xx XXX XXxX Page: 1
Command :-c9024 prime.c -a -p -x -€ -ng
In-file : prime.c
PPL-file : prime.ppl
Para-file
*/
1: #define TRUE 1
2 : #define FALSE 0
3 : #define SIZE 200
4:
5:char mark[SIZE+1];
6:
7 : main()
8:{
9: int i, prime, k, count;
10:
11: count = 0;
12:
13: for (i=0;i<=SIZE ;it+)
14 : mark[i] = TRUE;
15: for (i=0;i<=SIZE ;i++){
16: if (mark]i]) {
17: prime=i+i+3;
18: printf("%6d",prime);
19: count++;
20 if((count%8) == 0) putchar(\n");
21: for (k=1i+ prime ; k <= SIZE ; k += prime)
22 mark[k] = FALSE;
23: }
24 .
25: printf("\n%d primes found.",count);
26}
27 .
28 : printf(s,i)
29 : char *s;
30 :inti;
31:{
32: int j;
33: char *ss;
34
35: j=i;
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36 : SS =;
37:}

38:

39 : putchar(c)

40 : charc;

41 :{

42 char d;
43 . d=c;
44 :}

/*
Target chip : uPD789024
Device file : VX.xx

*/
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() RXFIRFIRIH

78K/0S Series C Compiler VX.XX Cross reference List Date: XX XXX XXXX Page: 1

Command  :-c9024 prime -x
In-file  : prime.c
Xref-file : prime.xrf

Para-file :
ATTRIB MODIFY TYPE SYMBOL DEFINE REFERENCE
EXTERN array mark 5 14 16 22
EXTERN func main 7
AUTO1 int i 9 13 13 13 14 15
15 16 17 17
21

AUTO1 int prime 9 17 18 21 21
AUTO1 int k 9 21 21 21 22
AUTO1 int count 9 11 19 20 25
EXTERN func  printf 28 18 25
EXTERN func  putchar 39 20
PARAM pointer s 29 36
PARAM int i 30 35
AUTO1 int j 32 35
AUTO1 pointer ss 33 36
PARAM char c 40 43
AUTO1 char d 42 43

#define TRUE 1 14

#define FALSE 2 22

#define SIZE 3 5 13 15 21

Target chip : uPD789024
Device file : Vx.xx

15
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(4) HBRIIRIMH

PRIME.C(
PRIME.C(
PRIME.C(
PRIME.C(
PRIME.C(

18):
20):
26) :
37):
44) .

W745 Expected function prototype
W745 Expected function prototype
W622 No return value
W622 No return value
W622 No return value

Target chip : uPD789024
Device file : VX.XX

Compilation complete, 0 error(s) and 5 warning(s) found.
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Bk B EEBEMIIR

TR

R TR AT HE R E ]

() HHEEIAAVHEE Z N BHABIT T 2SN, &5 MeES e R0 .

(b) T AE-C ZE IS KRB TEAARE 2N . AR BRI, 2 — b ki . A fie-C ik
T, ERORTE C YRR PR S rh iy A#tpragma pe(RAY) . FEGw FEIUIR], U SRR SR S I TRORT C Y8
PR A BRI IUAN A, R B TR G o RTINS 2 A — N A5 R

(c) AR LI AEE, P LB I LI B -

[T EHARBIE R H IR

X T AR SCAE, I Rk 0 A 2R 1) SCA T

[RT4ERE B RE RS

IR ORI ARG, A A A BORIR B AN AT 44 o IR & SO R 8 BUAS A B
e A th i 74T . EHEPTAREOUN, SHnahds . Bae M SR e 844

[WRICAF 4 KR IR

£ CC78KOS ', BREICAA AT (304D BN IERR A . Bk, (RIS —
LEfR .

(@) KT HBIKE, AERERZEAVITEHE NS T AEE — N ERL Y R4, ALY A2
[ )RR . M PM+I, HR(), R RREA LAY 4, IR .c R C IR R
N

(b) SCHFEA L FGSEA MR RE ARV ERHFAR, BT HEEES), 450)MES(). MZFEENZ
TE TR () 0T LABEAE R SO 4 8 AR 00 B . A PM+, 38 RS04 sl B 45 44 400 AN g
TS (D, WA WA ERNERAELS, Bl o7,

(©) MFF T AR IS E IS Mg 4T

(d) 7ESCHRERNT, WRAG AL 8 MEFMEMSTH:, RS,

(e) WM ID78K0OS-NS 5 SM78K0S, CAFIEALRIFR LR/ NG i@ 3 z), KESFRHA 3
Z), B0 3| 9), TXIZ (), ()

CRTEE&XHFREREMR]

FERLE SO SCR B (BR T BRI, SRJGHE C IR T R ITIZ ST AN T REf
SRS SO IUE S AR R R R rp s B S e, LA B 1 e ST B 5E
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B B IR IUIE

e R

[ VAR B A R R T

M C YRR AE T #asm el __asm R TE S, RRBULBSCI A R R R T T,
IRJEEERL . AR B LA AR A DO B, VI G s T SR R AT e R A T AN L A
I, Bln, A RNC g S AT R .

(a) 77 ZAr#asm Y (Tr#asm Flgendasm & AJZAIRFSS>) FI__asm EA)HE TSI, T 8 F4F
AN 77 R IR LL2L@ TR (i, 2L@01, ?2L@sym, %) o 4RI, IXEEFF5 REEAEH T oA
(f) (PUBLIC 1)) . fr#asm HerpoRl__asm ifif)hANGEE SCBE. WS SURRF5 AT il 8 745 LA
WIFLL2L@FF LRI AR, IR AL gt FErp 257728 AL14 S v kA5 o

(b) 75 C YR /Fttasm Srp (1A R AMTAZ R, WL C PP EA NI EESI M, $HASH EXTRN
FERH, R — AN R . B C A5, I ATE#asm S AT EXTRN 4.

(c) MR CPEREF U S#asm BRI asm i&f), F8E-A B—SA ga ik TORTT B ek, I+ H x4 r
TG IE R AT G o
E ] PM+IN, B SRR B FE E -A-SA TEIR,  BE 7R A IR 500 5 52 -AJ-SA LT,

(d) U PM+I, WIERFRE T -A BI-SA gtk i, FBAARR-O/-NO kmilif], #4535 RAT8KO0S.

(e) ffi F#pragma v & UL B A RRET, B RN ZERNYGFR P BEAR A4 AH ) o A5 DOV 4 b2 72 A e i v 1
1% A106.

[18 R 4w 4 E-QC2 I ik ]

i AE CC78KOS i T-QC2 ki, Al T i B nl KR Je BT .

-128 #| +127 char 271
128 #| 255 unsigned char 2§74
0U #| 255U unsigned char 357
KT 256 int 5%
3| -129 int &
\0" B \377 char 252

R 5-QCR MY, AR RIS LA IO TR, TR T BT S B T
TR, AR A AT R B VST 4 BT 5 R AT

ISR SRRt AR AR SR T BLIE IR S5 R, S - QA (B ) e T
I e L B T
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B B IR IUIE

TR

) ¥EE-QC2 i i

inti;

i = 2020 [*BAE
i = (int)20*20 1*400%/

#FIE ORI, HHRE-QUILIIN, BT A AT B I AT S AT AL B YU fE \2007 B (377

(AT EIC g 7]

V1.50 JiR f] CC78K0S Fl V1.30 Ji B 58 B WA (K 4w AT e e & 18 H
BTS2 K o4, Frilfii RA78K0S V1.30 LART (A o] g 2> S 4R

66 1A 2% I 9 A T 0

YA AB I IS ST () B S e W 2% e =2 () S R AR Ny, AT B4 T e SO0 FH B AN IE R, X
YT BT 3 . 3 B TR A I8 2 0 v LU G X s 4
{FH PM+I, RIEEAE R 4% 5155 b | CC78KO0S.,

10

[BUE B E ) 3]

U E RS PR RS AR BN HARSCHEIN, SR T HAR A ROM B RAM X I85EH 2 41, 80 A el
B AEAT R IR, ] LB — AN SO, FE BRI A 6 i -D 2T

S TRNEE T E M SO AN B, HUE S RAT8KOS ICHABRESA P FM (UL6656E) , Hitstn
4 Ik78k0s.dr (7F SMP78K0S H#F) xxft.

i) ZHE N BATVIGE I MR AZ AN SE C YRR SIS it 4

1. fE CHEREFPIIT, HIX DB VLGNSR AL AR B TR

#pragma section @@DATA EXTDATA
M

HE B B AR 3 sh I RE SR N B 42 R BT M 4R 4k, ROMization B RIFEEZE R B HIFE PR
2. QIEE—ANERE 7 S0 .
<lk78k0s.dr>

memory EXTRAM : (OFO00h, 00200h)
merge EXTDATA := EXTRAM

ONEERE [ SO IR i L
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B B IR IUIE

TR

1 YERINAE-S B Bh A B WK A HER AT 5, HERR I I S 1 1) ST R A A 8 52 A A O P A [X 3
IR ME—MIHEHARR . QIR TR dr 40, ORI DXt BT /F RAM R IRHERR X (SFR

XELERAL) .
Bl) e E S 1k78k0s.dr R N
memory EXTRAM : (OFO00h, 00200h)

memory STK : (OFBOOH, 20H)
merge EXTDATA = EXTRAM

(fir 2A47)

> |k78k0s sOs.rel prime.rel -bcl0s.lib -SSTK -DIk78k0s.dr

2. 2 A OE A5 D BT E B AT e e i@ B AT 4R
“*** ERROR F206 Segment ‘xxx’ can't allocate to memory-ignored.”

[RA]
H T B SR il s DR [ AN TERAF TR A2 B

[REXe]

XL BRRE I AL =28
1 R AR BIRE BT 2 (Z1.map 3CF).
2. (RS R A B A BOR/ANIOHERS L, B0 17 SCAHhoeg B B 73 B 45 1)
3.0 ) SCAFSRAE-D ZETI14E4%

R, PUAAE R 1 b R AR R I BERIUANR], ARA B Beas 1] i 5 it A LR ik

(1) R B g e A e B s 2
BSOS b G ) map SCAFRAS B B 2 () K
(2) WAXABOZ I Q)
Fer DI G 51 3 SO A A 3 BE I B [ K/ (prn)

11

[ H va_start ZEHFREREM]

7t stdarg.h i XK va_start 28/ E R A E R (BB — NS R = A D
FaE T8 —A2405, (I va_starttop
FEE THE A KLUERISHG, #H va_start .
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B B IR IUIE

Y5 TSI
12 [ 4 BRI fE B A7 2 (SFR) B Hutik B i3 B 2530
Gt F Hhhk k51 H 16-067 SFR, 1) 8- St &= B AR,  Frllitifdi i SFR Ak 1,
13 A shBIREFIEE]
(@) I RGN SNGIFRRNE, MUARZERI AT AT AR 7 0 SR FF— 3. (cc78k0s.exe Bk cc78kO0s).
(b) XT3 HE0F AU B B L 2 sprintf, vprintf AT vsprintf, WHE CL248 5 T 83030 £7%E, “%e”, “%E”, “%g”
TR %G I A e 45 J LU FR 8 RS BB VERf , TS A S 3Bt ) &y 2o RIMSEHE 28 N “% g™ %G ) e i 45
ER TR, THRSPAT %Pk,
T sscanf A1 scanf B3, I8 & Hea U B AT 0 %K, “%e”, “%E”, “%g”, E{“%G”, 7R A
AT, ARG RFE+0. WL SR, A0 M N LML R .
(BBl
14 [ H ID78K0S-NS VAR EEFHiE & HIH]
i M pascal BN, Next iy 4 PEAEFIL S EAEAR, 3R (Return) 4433 [ A T8 H 1) R 4
. MIRE T HmEEIETI-ZR 5, A RECERAE K pascal A, BRIk, KEAEEPAT Next /iy 4.
15 [ F SM78K0S ARIFREFHERFE ]
R H pascal BERT, AEHAT Next drd-. B, FEFHSKE. YIeEHiFiEn-ZR v, Fra s
#8AS Ny pascal E#. K, igE-ZR I, BHRAGEANEHIT Next dird .
16 [#4T ROMization]
ROMization 1 PN Z L FEECEPILHE, FIaniEe4E ROM ARG E FIAMT AR R, RIGAE RGBT IR E X
LE{E$E T3 RAM H, 7 CC78K0S1.50 JiAr, BRiA2s4E B ROMization AHICARS . (Rlil, FRZEdEm $AT
41 ROMization ¥ s FE 1R A7 L
T2 C dmitaste b shlfe, #Ea4Efa ROMization b2,
A B :
(1) MUAMEA CARHEEX IR SOS.REL
(2) MffiFH C ArvEEX IS SOSL.REL
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Bisk B VERCFISIR

TR VT
16 [ I S 48]
C:>LK78K0S SO0S.REL SAMPLE.REL -S -BCLOS.LIB -OSAMPLE.LMF
SAMPLE.REL: HI /' FEFF I B Arpbh e 1
S0S.REL: JA B FE
CLOS.LIB: BATHZIE, AnifERE
-S UMM S ((@STBEG, _@STEND) H 3h/E ik 1.
HE
W RAE T AR AT B B S BIRR
RIREER, [F CC78KO0S #RALMESTFEIE, FNEERTIREFHREENREETTRERFE.
ANEn CC78K0S FEHERINAF %,
24 F V2 5 PE(CLOSF.LIB)BY, 438 ROMization &3 & 3 BIFR & 8 SRR HE PERI R S R
Y4 ] S ERVE S sprintf,  sscanf, printf, scanf, vprintf, 1 vsprintf g5
#l) -BMYLIB.LIB -BCLOSF.LIB -BCLOS.LIB
Y4 AN S 3RV LUK sprintf, sscanf, printf, scanf, vprintf, F1 vsprintf g%
) -BMYLIB.LIB -BCLOS.LIB -BCLOSF.LIB
17 (A R HERR X IR AF 5 (-S)]
7E CC78KO0S A1, H P evk AR X AR B 25 A
H T ARAYAR X 25 0], AR T B e -S IR T
7E PM+H, UPESCPE S C IEREEI, -S IS BEhiE T .
18 [ROM ]
2 ROM ARSI, $55 H bR LU -R 55-U, #lUi—r, -uOFFH,
-R: ARYEHu b HES TN RE SO H %
SUBEFE: [ ROM X [H75 (IR 7R 45 2 (.
19 [ Bh U BE £ TR
76 PM+H, SR asigIii--, -2R1-H &4t Z2ng, ©ATH ke 0k fa] i fre .
7 Tool 3751 F AN HI< xxx Option >15 & X i HEH W ek 5 B il vl LU 2060 B 10 35 By SCRY
20 [-LL 375 {3 BH]
fEH PM+R, -LL ZEIEE 352 i i KEOR 32767, MR E AT KT 32767, HA-LL EFIH AL I
WA
21 [RTR S BHEKENEER]

=

1E ID78K0S-NS V1.01 fl SM78K0S V1.42 s ¥ RARA T, 75 AWK EALERBL 127 A~F

St

o
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B B IR IUIE

TR

[H PM+3EE]

(@) M eIz Hoct:
1 PM+HRE M P BRI S HOCATI, TRLL Y AR 303 PM+ A S HOC T M@ S HOfr
B, RN ILAL, BTEESE (build) B2 R A4 %
FEE BISCHE A A PMHOIEE I SO EE R 4 .
R FIRIE I (-C), WA SO R AR IR IR T (-y) FH YR SCAFER AN B H 5
JEAKT PG S 8OO TR IR R AT A AR
(b) <ICHuikLi> XHHE
AT E-C, -F FI-Y REIUFIE SO, 75 MRS AT A A <> %t — AN i
Mo T <Y G T 6 UG HE A F S8 R T A EA R IE, b B AR, EdTEsr (ouild)
I o7 A B R
(c) &SRR LR
i PM+il%E MAKE SCHERS, o3 B E & SO AB G R, SctBEn)an #if Sspt 200, Bt vl gede
05 T AL SR A A R R SCAE
WER AR ST B R AR IR, T A X S5 SO S A8 TE MO O R — R IE A P 5
)
#if 0
#include "headerl.h" /* Dependence relationship judged to exist */
#else / * | zero */
#include "header2.h"
#endif
/*
#include "header3.h"
*/
EMNB KRR AT, headerl.h #AE b A g i) . 41 headerl.h SCA74E, 84 headerl.h
25 IAE] PM+(K)” ProjectWindow” .
[FBH IR TC . HAE, XS (build) HFERH LW .
(d) TH TR
Lt 7E<Compiler Options>X1HHE T i <<Startup Routine>>#52% 1T 7 ff)[Using Startup Routine] /1
[Using Startup Routinelit#AE# L, {HI&& 1%~ <Compiler Options>Xf i H1 [ [OK] B [Apply]#%
fl, WaSERS LEMASEER.
[T 8] 4% 8 N TH AR & PM+1 & E
<1> #JFF<Compiler Options>%] 1 HE
<2> EPe<<Startup Routine>> &,
<3> i #[Using Startup Routine] ! [Using Fixed Area of Standard Library] (#8174,
<4> $ZF[OK] B [Apply] #&41 (3 FiX S os Sk H IEA B TC D«
(e) LHREAHICSCAFI B
Al LLA PM+[[Project]zi 88k TR & 4 17"Add Project-Related File" s =l i 4 2 36 2 J 1k 14047 7
T FIARAE A o
M<Compiler Options> X iHHE [f<<Startup Routine>>Fr%E TTH BT 4 36 5% J& ML 1) J5 8l 1 F2 R0 AR v 27
B
() AT 155 ([ D) FI SR SRR AN AT A4 R Tai A 3
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Bisk B VERCFISIR

G5 TSI

23 | [RTREERNERER]

IR A R B Y P WSO B B BRI A, i A5 (F301, F701)H 1%
1))
f(void) ; /* F301 : Syntax error */
[* F701 : External definition syntax */
[WBEA¥E] I ek R A R ik
1)
int f(void);

24 | [RTHRERRHOERSEN]

WA A PFE R, HAL T REOMNIMT A, B2 R T S A WZE, et — M AEY
IR IR o

1)
extreninti;  /*extern HIHEHR, ALSGEARIEHIX Y
[* comment */
void f (void) ;
[EOF] [* Error such as F712 */
(BT T

25 [RTF A E 4 ER IR

WA TAL R Ay &1, WA VR R B R e R —47, A TR B Ay & 2 ar ek Je s Hoh, b4
SR (F803, F814, F821, %)

1)

[* coml */ #pragma sfr /* F803 */
[* com?2 */ #define ONE 1 * F803 */
#define /* com3 */ TWO 2 [* F814 */
#ifdef /* com4 */ ANSI_C [* F814 */

[* com5 */ #endif
#define SUB(pl, /Fcom6* p2) p2=pl [*F821*%
(TG JVE] KR N BB R A B A 42 ) .

i)

#pragma sfr /* coml */

#define ONE 1 /* com2 */

#define TWO 2 [* com3 */

#ifdef ANSI_C [* com4 */

#endif /* com5 */

#define SUB( pl, p2) p2 =pl /¥ com6 */
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Bisk B VERCFISIR

Ikl R
26 [ Ff# M structure, union, Bk enum $FEARIE AT X ZEIH)
TS BR B B A I v R 20 5 U A F (structure, union, B enum)BHAERRIC, E A T 4 R(L), a7
o WAL N AR (2), AR,
(1) WARHERRC AL R BN SR IR, O LT MR SR EEL RR IR R, b
BV IR, 2%t W510 455 5.
1)
void func (int, struct st) ;
struct st {
char memb1;
char memb?2;
pst[]={
{1,a°},{2,b"}
b
void caller ( void ) {
func ( sizeof ('st) / sizeof (st[0] ), st); /* W510 Pointer mismatch */
}
(2) WHRFHEAMCH TSEFE U R FHEZRAS ], FE45 € structure, union, 2% enum 24, &
Wtk F737 HME R
1)
void funcl(int, struct st); /* F737 Undeclared structure/union/enum tag */
struct st func2 (int) ; [* F737 Undeclared structure/union/enum tag */
struct st {
char memb1;
char memb2;
b
[FRBi A EE]  TigesE X structure, union, B¢ enum (R4S AEARIC .
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TR

27

RT R SRSk R R ]

FATERASA R WA T LA RSSO AR A R AR I T AR AL

1))
void f (void ) ;
void f (void ) {
char *p, *p1, *p2 ;
char*ca[3] ={p, pl,p2}; /* HiLX(F750)*/
}
[(TBE ] AR R AR A o
i)
void f (void ) ;
void f (void ) {
char *ca[3] ;
char *p, *pl, *p2 ;
cal0] =p;ca[l] = pl;ca[2] =p2;
}

28

[SRTHMEE callt ER BRI TH]

WURAE R ECRAIIG A S T A0 callt B30, T Hit callt B E/EX B P AR, 8200 %7 42

CR AN TR AREI, o PR MR,
1)
callt extern void funca ( void ) ;
callt extern void funcb (void ) ;
callt extern void funcc (void ) ;

static void ( * constfunc []) () ={
funca , funcb , funcc

b

callf void func2 (void ) {
funcc () ;
funcb () ;
funca () ;

}

[FRBG i) K o S A0 o SO AR HR 43 T

HFA U16654CA1VOUM
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Bisk B VERCFISIR

TR

29

[ KT REORIEME SR IR R ]

R ECR A 2 AR, AEIR PR BE R R 7 T AN, RS IR S R b SR A T XA B
B, TR PR S5 45 5 45 201K A [ 2 R
D)
struct str {
charc;
inti;
long |l ;
}st;

struct str func () {
/* Interrupt occurrence */

}

void main () {
st=func (); /* Interrupt occurrence */
}
7 B IR SS I RR,  func B EE P IR SR P A, st il RESS BIR
[FBi 7] G

30

R TSR HE R IR
AR SR A Gk SERAREEAL, WIn Al FE iRk B 2 3 5 F750 H k.

1
struct Ss {

int di,d2;
i
union Au {
struct Ss t1;
Yu={{1,2}}; /*F750 Initalizer syntax */
(TG I7Es] L RA IR AT R E
)
struct Ss {
int di,d2;
b
union Au {
struct Ss t1;
tu={12};
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Bt C CC78KOS rIFRHIFZ

ATEVEANIR T CCT8KOS YRR, LA o] e G 1X LL R o

P I 5 00 A ik

XA AN extern AN R BTN A SR AR, B2, IEHERLF IR B2 A IEM .

FASINERA A Y extern fAZ R4, 0P REHA I R TRER .

WA R AR T typedef A4 X, Wik S8R T T s U5 75 W EEE 131 const / volatile 28 BT 175 B, typedef
IR REARL, 1 e S8 AR

DUBAARTEE KT, W AT REAT N EIL IE WA 1T.

A RER PHE R A SR R S, XESHOARES . AT IS EI AR R AR R, (Al AR,

ARF 5 BB AR IO AT 5 B AT AL B
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B3 C CCT8KOS [H B il %13

C.1 KT PRGN 4H AR Fpi%k

PR 1
XFERA AT extern AMBAS AT HIIA AN S A AL A 1k o AELE T g U AE 3 P R TR U AN IR

[#3R]

HTHIANSI C i 5 AR, WA I extern FISMNIAR REBEATWIAG AL 257 2 — M e, (HIZAE A
BIFARE AR G AR RE SO WG B PR A1 B AR 5 AT AP Ot 0T A

Gt T ) b P A TR A RO IER Y, EDR I R P b T A RN IE

[ 3R]
int i
void f(void) {
externint i=2;
}

[(Wp5 i)l &
DEAMRA] V1.00 & V1.50 (KA A
PR 2
g ANAE B RIEE B 7 1 (R 5 44 028 B 5 7 — A T A i

[#38]
FE MR — T DL N Re—ANARRRIAE B S0 W 1 7] 44 A LR e AE — 2 AR o

(1) PN Il extern AR BERIHRAT 75 B A i & 1A B A AH 7] R 44 5K
PN A R B IR, BT AR e 5 T 2t AREAC .

(=51 E 3]
void f(void) {
externint i;
i=1; /* lllegal code output */
}
static int  i;
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B3 C CCT8KOS [H B il %13

(2) J—ANERPN AN extern AR RIBRANA F ARSI EA MR AH, ERSERMAELT
extern BH Y 5.
B g6, kAR,

[SE4) TR
void f(void) {
externint i;
i=1; /* lllegal code output */
}
int i

(3) RPN FEI extern [FAL S AITEHRANA ] extern 75 W] AR AT E AR [ (R A4 FR , AFAMBAR 51047 B AL
THZAT, I HAER S I extern 2R RGN IEA —A> B B2 R B FIRE A4 TR
RIS AT HR AN AR S RILE DN 75 1 D extern IR A 05T, o ARARD

[SE61 B
inti=1;
void f(void) {
int i;
{ .
externint I
i=1; /* lllegal code output */
}
}

(4) AEBRNFEILL extern (ASEANLE Y — NN A extern (AR AT AR [ ) 4 5K .
MMER AR, ot AREAUE .

[ 3R]

void fl(void) {
externint i;
i=2;

}

void f2(void){
externint i
i=3;

}
[(FBh 7]
ERRA] V1.00 & V1.50 HFrE A
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B3 C CCT8KOS [H B il %13

PR 3

WA R IE A typedef fi 45 U, U R ILSR R T B 25U 75 B sl T 147 const / volatile 287
BT HE Y, typedef MEITARARILM, T Ha S8 MEHR.

[H3R]

WERATHII I T typedef i< SN, QRIS - o £ 5% 75 W] 535 1 41 const / volatile 287
BEUEFTHI A, typedef MIETTEARLM, M HaSE—MEHR.

[SEFIFER 1]
typedefint FTYPE();

FTYPE func;
int func(void);

[SEFI I 2]
typedefint VTYPE[2];
typedef int *VPTYPEJ3];

const VTYPE *a;
constint (*a)[2];
volatile VPTYPE Db[2];
volatile int *volatile b[2][3];

[(MpiE]
DEFMA]  V1.00 & V1.50 KA R4

PR 4

ZYRAARTE KL, WHEA N ERIER BT,

[#3R]

ZYRAIARTEE KL, WHEA N EEIER 81T,

[SEHI B 1]
char c[][3]={{1},2,3,4,5};

[SEBIEE 2]
char c[][2][3]={"ab","cd","ef"};

[ BB 73]
TE M2 YERALI LK

ERRA] V1.00 & V1.50 HFrE A

/* F713 Redefined 'func' */

/* F713 Redefined 'a’ */

/* F713 Redefined 'b' */

/* lllegal code */

[* Error (F756) */
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B3 C CCT8KOS [H B il %13

PR 5
A PR IR MR A Z AU R B, XS HARET I USRS HO A B R, (A
Bt AREAC .

[#3E]
P BBRIE I R A SRRSO L, XSEBHRET . 4TS RO A SRR, e
i AR

(£ F L]
char *c;
int  *i;
void (*f1(int *))(char *);
void (*f2(void))(char *);
void (*f3(int *))(void);

void main() {
(*f1(3i))(c); /* Correct description (W510) */
(*f23))(0); /* Incorrect description */
(*f2())(c); [* Correct description (W509) */
f2()(); /* Incorrect description (W509) */
*f3(1))(); /* Correct description (W509) */
(*f3()(0); /* Incorrect description */

}

W509 i W510 & IEfR % G o X T A& S I RR A i tH AT . (H2, HrARE2E
W
void (*f4())(int p) {

p++; /* Incorrect description */

}
ot — AT e AR IR, BRI R E R
(TR IMNE]
DERMA]  V1.00 E V1.50 MFTE A
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B3 C CCT8KOS [H B il %13

PR 6
AT B e 4 A JE A Ay A T AR B

[#38]
AT B e 4 A JC A Ay A T AR B

(BB IMiE] G
[EABA] V1.00 & V1.50 KIFTERA
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M3 D &3

#
FPrAgMA PC.evvrerireieiieiirieieeereeeeereserareresseerrrrrrrrerrr. 76
$
BDGL it 87
BDGS ... 87
*
fat= 11 1 ¢ PO UPPTRUPPTRNt 33
oo | PP PP PPPPPPPPPPPPPIRt 33
o o 33
a2 1 PSSP 33
_@BRKADR ...t 150
@DIVR . 150
C@FNCENT ...t 150
C@FNCTBL ...t 150
_@LDIVR ..ottt 150
_@MEMBTM ..t 150, 151
_@MEMTOP ...t 150, 151
@SEED ... 150
_@STBEG ... 142, 144
C@TOKPTR. ... 150
[ 1 Lo 150
_putchar.asm ........cccocceeiiiiie e 135, 136
A
A FEIT o 94
B o L RO 131, 154
Y NN ] 13
TEGREEIT oot 19
NI ] 191
IR AR e 65,121, 179
B
T T e 25,62
C
(O 1= 2 ST 18, 131

e .2 76
C PR REHLIA e, 17,177
CCTBKOS.EBXE ..cevvveiieeeeeeeeiee e e e et e e e et eeeeeees 33
CCTBKOS.IMSY ..eeeeuieiieeririeee ittt 33
CCT78KOSP.DLL...uvvvvvirriiiiiinieririnrinrerrrsrarerrrnrnrnn. 36
[ = N 65
<Compiler Options> XFHFHE ........oovovriiiriiernes 61
TEHIHEZRG] oo, 194
XD HFNZR S o 65, 128, 188
CStAM™ . aSM e 33, 150
(0151 7= L 0= 1] 1 £ TRt 145, 148, 150
(o) = 11 0 = 1< 1 0 136, 140
D

D BT e 91
L e SRR 23
E

B BRI e 98
ECC e 65
FRBIZE B oo 32
E R i 65
FESRZEZE oot 131
R | o 65, 98, 123
LU [ USRS 32
EX I R et 131
F

SF OB e 111
[y A 154
FRas o 131
G

G HETH o 23, 87
getchar.asm ... 135, 136
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Ml D &5l

H

ol H TETT oo 113
TR IE AL BRIE oot 144
RAWINIE BT 139, 144
HER oottt ettt e 65
|

L BT e s 93
INCT8KOS ...ttt eeeeeeeeeeeeeeeee s 32, 33,93, 132
AL SERE oo 65, 124, 132, 190
K

S TEIT et 88
L

LANGT8K vttt 32,132
SLF FEIH oo 107
L ETTT e 108
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